Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.3 to 7.5 on Windows: SAP Adaptive Server Enterprise
## Content

1. **About this Document** ................................................................. 10  
   1.1 Naming Conventions. ............................................................ 11  
   1.2 Constraints. ........................................................................... 12  
   1.3 Before You Start. ................................................................. 13  
   1.4 SAP Notes for the Installation. .................................................. 14  
   1.5 New Features. ....................................................................... 15  

2. **Installation Options Covered by this Guide** ........................................... 21  
   2.1 Standard System. ................................................................. 21  
   2.2 Distributed System. .............................................................. 22  
   2.3 High Availability System. ...................................................... 23  
   2.4 Additional Application Server Instance. ...................................... 23  
   2.5 SCS Instance with Integrated SAP Web Dispatcher ...................... 25  

3. **Planning** .................................................................................. 28  
   3.1 Planning Checklist. ............................................................... 28  
   3.2 Changed File System Structure and Profiles for SAP Systems Based on SAP NetWeaver 7.1 and Higher. ................................. 29  
   3.3 Installation Using a Stack Configuration File. ............................. 30  
   3.4 Hardware and Software Requirements. ...................................... 32  
      Running the Prerequisites Check in Standalone Mode (Optional). .......... 33  
      Requirements for the SAP System Hosts. .................................... 34  
   3.5 Planning User and Access Management. .................................... 41  
   3.6 Domain or Local Installation. .................................................. 42  
   3.7 Basic Installation Parameters. ................................................ 43  
      SAP System Parameters. ....................................................... 44  
      SAP System Database Parameters. ........................................ 54  
      Parameters for Additional Components to be Included in the SCS Instance (Optional). .................................................. 55  
   3.8 Setup of Database Layout. ...................................................... 56  
   3.9 SAP System Transport Host. ................................................ 57  

4. **Preparation** ............................................................................... 58  
   4.1 Preparation Checklist. ........................................................... 58  
   4.2 Disabling the Windows Server Firewall on Windows Server 2008 (R2) and Higher. ......................................................... 59  
   4.3 Performing Basic Windows Preparation Steps. ............................. 60  
   4.4 Required User Authorization for Running the Installer. ................. 61  
   4.5 Using Virtual Host Names. .................................................... 63  
   4.6 Preparing the SAP System Transport Host. ................................. 64
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.2</td>
<td>Implementation Considerations</td>
<td>126</td>
</tr>
<tr>
<td>7.3</td>
<td>Prerequisites</td>
<td>127</td>
</tr>
<tr>
<td>7.4</td>
<td>Installing the Replication Environment</td>
<td>128</td>
</tr>
<tr>
<td></td>
<td>Co-Located Replication Topology: Central Instance at the Primary Site</td>
<td>129</td>
</tr>
<tr>
<td></td>
<td>Co-Located Replication Topology: PAS on a Separate Server</td>
<td>130</td>
</tr>
<tr>
<td></td>
<td>Dislocated Replication Topology: Central Instance on a Separate Server</td>
<td>132</td>
</tr>
<tr>
<td></td>
<td>Materializing Databases</td>
<td>134</td>
</tr>
<tr>
<td>7.5</td>
<td>Starting and Stopping the DR Agent and the Replication Server</td>
<td>137</td>
</tr>
<tr>
<td>7.6</td>
<td>Removing the Replication Environment</td>
<td>138</td>
</tr>
<tr>
<td>7.7</td>
<td>Integration of the SAP Replication Server into an OS Cluster Environment</td>
<td>140</td>
</tr>
<tr>
<td>7.8</td>
<td>Defining Dependencies</td>
<td>140</td>
</tr>
<tr>
<td>7.9</td>
<td>Defining Node Failure Criteria</td>
<td>141</td>
</tr>
<tr>
<td>8</td>
<td>SAP ASE 16.0: Disaster Recovery Setup with SAP Replication Server</td>
<td>142</td>
</tr>
<tr>
<td>8.1</td>
<td>Disaster Recovery Setup with SAP Business Suite on SAP ASE 16.0</td>
<td>142</td>
</tr>
<tr>
<td>9</td>
<td>High Availability with Microsoft Failover Clustering</td>
<td>143</td>
</tr>
<tr>
<td>9.1</td>
<td>Checklist for a High-Availability System</td>
<td>145</td>
</tr>
<tr>
<td>9.2</td>
<td>Planning</td>
<td>147</td>
</tr>
<tr>
<td></td>
<td>System Configuration with Microsoft Failover Clustering</td>
<td>147</td>
</tr>
<tr>
<td></td>
<td>Distribution of SAP System Components to Disks for Failover Clustering</td>
<td>154</td>
</tr>
<tr>
<td></td>
<td>Directories in a Microsoft Failover Cluster Configuration</td>
<td>157</td>
</tr>
<tr>
<td></td>
<td>Hostnames in a Failover Cluster Configuration</td>
<td>158</td>
</tr>
<tr>
<td></td>
<td>Obtaining IP Addresses for a Microsoft Failover Cluster Configuration</td>
<td>160</td>
</tr>
<tr>
<td>9.3</td>
<td>Preparation</td>
<td>162</td>
</tr>
<tr>
<td>9.4</td>
<td>Installation</td>
<td>162</td>
</tr>
<tr>
<td></td>
<td>Configuring the First Cluster Node</td>
<td>163</td>
</tr>
<tr>
<td></td>
<td>Installing the Database Instance</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td>Configuring the Database on the Additional Node</td>
<td>165</td>
</tr>
<tr>
<td></td>
<td>Configuring the Additional Cluster Node</td>
<td>166</td>
</tr>
<tr>
<td></td>
<td>Installing the Primary Application Server Instance</td>
<td>167</td>
</tr>
<tr>
<td></td>
<td>Installing the Additional Application Server Instance</td>
<td>167</td>
</tr>
<tr>
<td>9.5</td>
<td>Post-Installation</td>
<td>169</td>
</tr>
<tr>
<td>9.6</td>
<td>Additional Information</td>
<td>169</td>
</tr>
<tr>
<td></td>
<td>Moving Cluster Groups, or Services and Applications, or Roles</td>
<td>170</td>
</tr>
<tr>
<td></td>
<td>Starting and Stopping the SAP System in a Microsoft Failover Cluster Configuration</td>
<td>171</td>
</tr>
<tr>
<td>10</td>
<td>Additional Information</td>
<td>174</td>
</tr>
<tr>
<td>10.1</td>
<td>Additional Information</td>
<td>174</td>
</tr>
<tr>
<td>10.2</td>
<td>SAP Directories</td>
<td>175</td>
</tr>
<tr>
<td>10.3</td>
<td>Checking and Changing the Paging File Settings on Windows Server 2012 (R2) and Higher</td>
<td>178</td>
</tr>
<tr>
<td>10.4</td>
<td>Performing a Domain Installation Without Being a Domain Administrator</td>
<td>180</td>
</tr>
</tbody>
</table>
Document History

**i Note**

Before you start reading, make sure you have the latest version of this installation guide, which is available at [https://support.sap.com/sitoolset](https://support.sap.com/sitoolset). System Provisioning > Install a System using Software Provisioning Manager > Installation Option of Software Provisioning Manager 1.0 SP <Current Number>.

The following table provides an overview on the most important document changes:

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2012-12-17</td>
<td>First version for Software Provisioning Manager 1.0</td>
</tr>
<tr>
<td>1.1 - 1.3</td>
<td>2013-04-02 - 2013-10-28</td>
<td>Updated Versions: SL Toolset 1.0 SPS 07 - SPS 09</td>
</tr>
<tr>
<td>1.4</td>
<td>2014-03-17</td>
<td>Instead of a separate installation guide for each UNIX-based operating system, we now deliver a single installation guide for all UNIX-based operating systems. Sections that are only relevant for one or more operating systems are highlighted accordingly.</td>
</tr>
<tr>
<td>1.5 - 2.1</td>
<td>2014-07-07 - 2016-06-06</td>
<td>Updated Versions: SL Toolset 1.0 SPS 11 - SPS 17</td>
</tr>
<tr>
<td>2.2</td>
<td>2016-10-07</td>
<td>Updated version for software provisioning manager 1.0 SP18 (SL Toolset 1.0 SP18): support for synchronous, near-synchronous and asynchronous replication for SAP Business Suite on SAP ASE 16.0. For more information, see Disaster Recovery Setup with SAP Business Suite on SAP ASE 16.0 [page 142].</td>
</tr>
<tr>
<td>2.3</td>
<td>2017-02-06</td>
<td>Updated version for software provisioning manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
</tbody>
</table>
| 2.4     | 2017-05-22 | Updated version for software provisioning manager 1.0 SP20 (SL Toolset 1.0 SP20)
  - New Features:
    - New SAPUI5-based graphical user interface (GUI) “SL Common GUI”, documented in: Prerequisites for Running the Installer, Running the Installer, Useful Information About the Installer |
Updated version for software provisioning manager 1.0 SP21 (SL Toolset 1.0 SP21)

- New Features:
  - Media Signature Check, documented in: New Features, Running the Installer, Preparing the Installation Media.
    This feature implies that section Creating Kernel Archives from an Existing SAP System has been deleted from this documentation because the related option in the installer had to be removed.
  - Download Media for a Maintenance Plan, documented in: New Features, Downloading Media for a Maintenance Plan
  - SAP Host Agent Upgrade, documented in: New Features, SAP System Parameters, Downloading SAP Kernel Archives (Archive-Based Installation)
  - Support of SSL, documented in: New Features, Enabling SSL encrypted data transfer.
Updated version for Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)

- **New Features:**
  - Signature check for installation archives, documented in: *New Features, Downloading SAP Kernel Archives (Archive-Based Installation) Archive-Based Installation for Diagnostics Agent, Downloading the SAP Kernel Archives Required for the Dual-Stack Split (Without Operating System and Database Migration), Downloading the SAP Kernel Archives Required for Operating System and Database Migration*
  - Installer Log Files Improvements, documented in: *New Features, Useful Information about the Installer, Troubleshooting with the Installer*
  - Enabling IPv6, documented in: *New Features, Prerequisites for Running the Installer*

- **New Features** section restructured: As of SP22, a dedicated subsection for each new SP has been created. New features below SP22 remain in a common table.

- The Java SDT GUI - which was in the SP21 version still available in parallel to the SL Common GUI - has been deprecated with SP22. As of SP22, SL Common GUI is the only available installer GUI:
  - The following sections which were explicitly related to Java SDT GUI were completely removed from this documentation: *Performing a Remote Installation Remote Processing of the Installer (Java SDT GUI only), Starting the Java SDT GUI Separately, Running the Installer in Accessibility Mode (general accessibility information was moved to Useful Information About the Installer)*.
  - The Java SDT GUI-specific information was removed from the common installer sections: *Running the Installer, Useful Information About the Installer, Interrupted Processing of the Installer, Troubleshooting with the Installer, Deleting an SAP System or Single Instances*

- New section *Using the Step State Editor (SAP Support Experts Only)* was added to section *Additional Information About the Installer*

- Option to install the SCS instance with an integrated SAP Web Dispatcher, documented in: *New Features, SCS Instance with Integrated SAP Web Dispatcher, Additional Parameters for an SAP Web Dispatcher Installation Integrated in the SCS Instance (Optional)*

**Note**
This feature was retroactively released on 2018-02-12.
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.7</td>
<td>2018-05-07</td>
<td>Updated version for Software Provisioning Manager 1.0 SP23 (SL Toolset 1.0 SP23)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>New Features:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ <strong>New Installer Option</strong> <em>Download Media for a Maintenance Plan</em>, documented in: <em>New Features, Downloading the Media for a Maintenance Planner Transaction</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Option to install the SCS instance with an integrated SAP Web Dispatcher, documented in: <em>New Features, SCS Instance with Integrated SAP Web Dispatcher, Additional Parameters for an SAP Web Dispatcher Installation Integrated in the SCS Instance (Optional)</em></td>
</tr>
<tr>
<td>2.8</td>
<td>2018-09-17</td>
<td>Updated version for Software Provisioning Manager 1.0 SP24 (SL Toolset 1.0 SP24)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>New Features</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ <strong>Only valid for ’High Availability‘: HA (Windows)</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>High-availability system on Microsoft Cluster: Option to install the SCS instance distributed to local disks and a file share instead of a shared disk, documented in: <em>High Availability with Microsoft Failover Clustering</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>End of ’High Availability‘: HA (Windows)</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ New Look and Feel of SL Common GUI with Software Provisioning Manager 1.0 SP24, Patch Level 05, documented in: <em>New Features, Prerequisites for Running the Installer</em></td>
</tr>
<tr>
<td>2.9</td>
<td>2019-01-21</td>
<td>Updated version for software provisioning manager 1.0 SP25 (SL Toolset 1.0 SP25)</td>
</tr>
</tbody>
</table>
1 About this Document

This installation guide describes how to install an SAP system based on the application server Java of SAP NetWeaver 7.4 to 7.5 using the installation tool Software Provisioning Manager 1.0 SP25 (“installer” for short), which is part of SL Toolset 1.0 SP25.

i Note

As an alternative to using Software Provisioning Manager, you can install your system with a completely automated end-to-end framework available using SAP Landscape Management. For more information, see SAP Note 1709155 and https://help.sap.com/lama.

This guide covers the SAP system products and releases listed in SAP Note 1554717.

For information about supported operating system and database platforms for the SAP product you want to install, see the Product Availability Matrix at http://support.sap.com/pam.

⚠️ Caution

Make sure you have read Before You Start [page 13] before you continue with this installation guide.

Naming Conventions [page 11]

This section lists the naming conventions that are currently apply for Software Provisioning Manager 1.0 (the “installer”) and terms used in this documentation.

Constraints [page 12]

This section lists the naming constraints that are currently valid for Software Provisioning Manager 1.0 (the “installer”) and this documentation.

Before You Start [page 13]

Make sure that you have read the release-specific “Master Guide” for your SAP Business Suite application, SAP NetWeaver application, or SAP Solution Manager system before you continue with this installation guide.

SAP Notes for the Installation [page 14]

This section lists the most important SAP Notes relevant for an installation using Software Provisioning Manager.

New Features [page 15]

This section provides an overview of the new features in Software Provisioning Manager 1.0 (the “installer” for short).
1.1 Naming Conventions

This section lists the naming conventions that are currently apply for Software Provisioning Manager 1.0 (the “installer”) and terms used in this documentation.

- Software Provisioning Manager 1.0 is the successor of the product- and release-specific delivery of provisioning tools, such as “SAPinst”. Before you perform an installation from scratch or a target system installation in the context of a system copy, we strongly recommend that you always download the latest version of the Software Provisioning Manager 1.0 which is part of the Software Logistics Toolset 1.0 (“SL Toolset” for short). For more information, see Preparing the Installation Media [page 67]. This way, you automatically get the latest version with the latest fixes of the tool and supported processes. For more information about Software Provisioning Manager 1.0 as well as products and releases supported by it, see SAP Note 1680045 and https://wiki.scn.sap.com/wiki/display/SL/Software+Provisioning+Manager+1.0.

- “SAPinst” has been renamed to “Software Provisioning Manager” (“installer” for short) in this documentation, but the terms “SAPinst” and “sapinst” are still used in:
  - The name of the technical framework of Software Provisioning Manager. For more information about the SAPinst Framework, see SAP Note 2393060.
  - Texts and screen elements in the Software Provisioning Manager GUI
  - Names of executables, for example sapinst.exe
  - Names of command line parameters, for example SAPINST_STACK_XML

- “usage type”, “technical usage”, and “product instance”
  As of Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12), the term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1970349. Note that there is no terminology change for older releases and all mentioned terms can be used as synonyms. As this guide is a generic document, the currently used terms remain but only “product instance” is used from now on when referring to SAP NetWeaver 7.3 EHP1 and higher. For more information, see New Features [page 15].

- “installer” refers to “Software Provisioning Manager”.

- “SAP system” refers to SAP system based on the application server of SAP NetWeaver 7.3 / 7.3 including Enhancement Package 1 / SAP NetWeaver 7.4 / SAP NetWeaver 7.5.

- “Java system” refers to SAP system based on the application server Java of SAP NetWeaver 7.3 / 7.3 including Enhancement Package 1 / SAP NetWeaver 7.4 / 7.4 SR1 / SAP NetWeaver 7.5.

- “Diagnostics Agent” refers to the SAP Solution Manager Diagnostics Agent which is the remote component of End-to-End Root Cause Analysis. It allows having a connection between SAP Solution Manager and managed systems, and then to collect information from the managed systems for reporting purposes.

- Operating System Names
  In this document, “Windows Server 2008 (R2) or Windows Server 2012 (R2)” – with (R2) written in parentheses – means that the information applies to both Windows Server 2008 and Windows Server 2008 R2, or Windows Server 2012 and Windows Server 2012 R2.

- Only valid for Microsoft Failover Clustering: As of Windows Server 2008 the cluster feature is called Failover Clustering. For practical reasons we are continuing to use the previous terminology Microsoft Cluster Service and abbreviation MSCS in some sections of this guide and the corresponding installation documentation of your release.

- Profiling for High Availability
1.2 Constraints

This section lists the naming constraints that are currently valid for Software Provisioning Manager 1.0 (the “installer”) and this documentation.

- The Dual Stack option, which integrates an AS ABAP and AS Java in a single system (common System ID <SAPSID>, common startup framework, common database), is no longer supported in SAP systems based on SAP NetWeaver 7.5. So if you want to install a new SAP NetWeaver 7.5 Process Integration (PI) system which is based on SAP NetWeaver 7.5, do not use the documentation Installation Guide - SAP Systems Based on the Application Server ABAP+Java of SAP NetWeaver on <OS>: <DB>. Instead, use the Installation Guide - SAP Systems Based on the Application Server ABAP of SAP NetWeaver on <OS>: <DB> to install the ABAP stack with its own <SAPSID> and the Installation Guide - SAP Systems Based on the Application Server Java of SAP NetWeaver on <OS>: <DB> to install the Java stack with its own <SAPSID>. For more information, see the implementation sequence in the Master Guide - SAP NetWeaver 7.5 at http://help.sap.com/netweaver<Release> Installation and Upgrade.

- Not all SAP NetWeaver releases or SAP Business Suite applications that are available in Software Provisioning Manager 1.0 and are described in this installation guide have already been released. Always check SAP Note 1680045 to ensure that the installation options you want to perform are already supported. For information about supported operating system and database platforms, see the Product Availability Matrix at http://support.sap.com/pam.

- Note that a complete system installation from scratch is not available for every product. For some products - such as SAP NetWeaver 7.4 - a complete new system installation from scratch is only provided for the highest support release. If there are one or more support releases, then a complete system installation is only available for the highest of these support releases. As for the lower support releases, only options for system copy and additional application server instances are provided.

- Your operating system platform must be 64-bit.

- The SAP Adaptive Server Enterprise Cluster Edition is not supported.

- Raw devices are not supported.
1.3 Before You Start

Make sure that you have read the release-specific “Master Guide” for your SAP Business Suite application, SAP NetWeaver application, or SAP Solution Manager system before you continue with this installation guide.

The “Master Guide” is the central document leading you through the overall implementation process for your SAP system installation. It contains crucial information about the overall implementation sequence, that is activities you have to perform before and after the installation process described in this installation guide.

You can find a printed version of this guide in your installation package or you can download the latest version from https://help.sap.com.

The following table lists the “Master Guide” of the SAP system application for which you can use this installation guide, along with the available quick link or path to the appropriate download location:

<table>
<thead>
<tr>
<th>Document</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Installation and Upgrade</td>
</tr>
<tr>
<td></td>
<td>72&lt;SP&gt;Installation and Upgrade</td>
</tr>
<tr>
<td></td>
<td>Installation and Upgrade</td>
</tr>
<tr>
<td>&lt;Including SAP Enhancement Package&lt;Number&gt; Powered by SAP NetWeaver</td>
<td>&lt;Release&gt;Installation and Upgrade</td>
</tr>
<tr>
<td>&lt;Including SAP Enhancement Package&lt;Number&gt;</td>
<td>&lt;Release&gt;Installation and Upgrade</td>
</tr>
<tr>
<td>&lt;Including SAP Enhancement Package&lt;Number&gt;</td>
<td>&lt;Release&gt;Installation and Upgrade</td>
</tr>
<tr>
<td></td>
<td>Installation and Upgrade</td>
</tr>
<tr>
<td></td>
<td>Installation and Upgrade</td>
</tr>
</tbody>
</table>
1.4  SAP Notes for the Installation

This section lists the most important SAP Notes relevant for an installation using Software Provisioning Manager.

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note, which you can find at https://support.sap.com/notes.

SAP Notes for the Installation

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1680045</td>
<td>Release Note for Software Provisioning Manager 1.0</td>
<td>Software Provisioning Manager 1.0 with installation and system copy for SAP NetWeaver-based systems</td>
</tr>
<tr>
<td>1710950</td>
<td>Inst. SAP Systems Based on SAP NetWeaver 7.1 and higher: Windows</td>
<td>Windows-specific information about the SAP system installation and corrections to this documentation</td>
</tr>
<tr>
<td>1748888</td>
<td>Inst. Systems Based on SAP NetWeaver 7.3 and higher: SAP ASE</td>
<td>Software Provisioning Manager 1.0: SAP NetWeaver 7.3 and higher</td>
</tr>
<tr>
<td>1554717</td>
<td>Planning Information for SAP on ASE</td>
<td>SAP release information for customers deploying SAP on ASE</td>
</tr>
<tr>
<td>1619967</td>
<td>SYB: DBA Cockpit Correction Collection SAP Basis 7.31</td>
<td>The implementation of SAP Note 1619967 directly after the installation is strongly recommended.</td>
</tr>
<tr>
<td>1882376</td>
<td>SYB: DBA Cockpit Correction Collection SAP Basis 7.4</td>
<td>The implementation of SAP Note 1882376 directly after the installation is strongly recommended.</td>
</tr>
<tr>
<td>2293673</td>
<td>SYB: DBA Cockpit Correction Collection SAP Basis 7.5</td>
<td>The implementation of SAP Note 2293673 directly after the installation is strongly recommended.</td>
</tr>
</tbody>
</table>
### SAP Note Number | Title | Description
--- | --- | ---
2380028 | SYB: DBA Cockpit Correction Collection SAP Basis 7.51 | The implementation of SAP Note 2380028 directly after the installation is strongly recommended.
1245200 | ICF Service Activation for Web Dynpro DBA Cockpit | The Web browser-based version of the DBA Cockpit does not start correctly.
1585981 | Backup Instructions for SAP on ASE | Information about backup and recovery
1650511 | High Availability Offerings with SAP ASE | Information about high availability cluster solutions for SAP ASE
1732161 | SAP Systems on Windows Server 2012 (R2) | Windows Server 2012 (R2)-specific information for the SAP system installation
737368 | Hardware requirements of Java Development Infrastructure | Information on the hardware requirements for Java Development Infrastructure, which depends on the size of your development team
73606 | Supported Languages and Code Pages | Information on possible languages and language combinations in SAP systems
1067221 | Composite SAP Note for heterogeneous installation | This SAP Note and its related SAP Notes describe the released operating system and database combinations for heterogeneous SAP systems landscapes.
2384179 | Planned support of Windows Server 2016 for SAP products | Support of Windows Server 2016 specific for SAP Products information for the SAP system information.
886535 | Downloading multispanning archives | Downloading multispanning archives

### 1.5 New Features

This section provides an overview of the new features in Software Provisioning Manager 1.0 (the “installer” for short).

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-availability system on Microsoft Cluster: Option to install the ASCS instance in a file share on a local disk.</td>
<td>As an alternative to the “classic” way to install the SCS instance on a shared disk, you can now choose to install the SCS instance in a file share on a local disk. For more information, see <a href="#">High Availability with Microsoft Failover Clustering</a>.</td>
<td>Software Provisioning Manager 1.0 SP24 (SL Toolset 1.0 SP24)</td>
</tr>
<tr>
<td>New Installer Option Download Software Packages for Maintenance Planner Transaction</td>
<td>If you perform an installation using a stack configuration file, you can now download media according to a Maintenance Plan. For more information, see <a href="#">Installation Using a Stack Configuration File</a>, <a href="#">Downloading Software Packages for a Maintenance Planner Transaction</a>, and <a href="https://blogs.sap.com/2018/06/01/software-provisioning-manager-new-option-for-standalone-download-service/">https://blogs.sap.com/2018/06/01/software-provisioning-manager-new-option-for-standalone-download-service/</a>.</td>
<td>Software Provisioning Manager 1.0 SP23 (SL Toolset 1.0 SP23)</td>
</tr>
<tr>
<td>Option to install an SCS instance with integrated SAP Web Dispatcher</td>
<td>You can now install an SAP Web Dispatcher in an SCS instance. You can choose this option while running the SCS instance installation. For more information, see <a href="#">SCS Instance with Integrated SAP Web Dispatcher</a>.</td>
<td>Software Provisioning Manager 1.0 SP23 (SL Toolset 1.0 SP23)</td>
</tr>
<tr>
<td>Installer Log Files Improvements</td>
<td>Installer log files are now available immediately after the installer has been started, that is <a href="#">before</a> a product has been selected on the Welcome screen. For more information, see <a href="#">Useful Information about the Installer</a> and <a href="#">Troubleshooting with the Installer</a>.</td>
<td>Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)</td>
</tr>
<tr>
<td>Signature Check of Installation Archives</td>
<td>The signature of installation archives is checked automatically by the installer during the Define Parameters phase while processing the Software Package Browser screens. As of now the installer only accepts archives whose signature has been checked. For more information, see <a href="#">Downloading SAP Kernel Archives (Archive-Based Installation)</a> and SAP Note <a href="#">2541751</a>.</td>
<td>Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)</td>
</tr>
<tr>
<td>Enabling IPv6</td>
<td>You can now set up a new SAP system or SAP system instance using Internet Protocol Version 6 (IPv6). For more information, see <a href="#">Prerequisites for Running the Installer</a>.</td>
<td>Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)</td>
</tr>
<tr>
<td>Option to install an SCS instance with integrated SAP Web Dispatcher</td>
<td>You can now install an SAP Web Dispatcher in an SCS instance. You can choose this option while running the SCS instance installation. For more information, see <a href="#">SCS Instance with Integrated SAP Web Dispatcher</a>.</td>
<td>Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Media Signature Check</td>
<td>The signature of media is checked automatically by the installer during the Define Parameters phase while processing the Media Browser screens. As of now the installer only accepts media whose signature has been checked. See also the description of this new security feature in SAP Note 2393060. For more information, see Preparing the Installation Media [page 67] and Running the Installer [page 84].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>SAP Host Agent Upgrade During the Installation (Optional)</td>
<td>During the Define Parameters phase of the installation, the installer prompts you whether you want to upgrade an existing version of the SAP Host Agent on the installation host. If there is no SAP Host Agent on the installation host, it is installed automatically without prompt. For more information, see the General Parameters table in SAP System Parameters [page 44].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>Secure Sockets Layer (SSL) encrypted data transfer</td>
<td>The feature SSL encrypted data transfer is available for SAP ASE 16.0 SP02 starting with PL6. For general limitations and prerequisites refer to SAP Note 2481596 - SYB: Encrypted data transfer between SAP System and SAP ASE database. The SAP installer offers the possibility to enable the SSL encrypted data transfer via a checkbox. The SSL certificates are generated by the SAP installer and enabled for the database server and the SAP application server. There are no manual steps necessary to configure the usage of SSL for the purpose of encrypted data transfer. For more information see Enabling SSL Encrypted Data Transfer [page 196].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>SL Common GUI with SAPINST 7.49</td>
<td>With the new installer framework version SAPINST 7.49, you can now use the new SAPUI5-based graphical user interface (GUI) “SL Common GUI”. For more information, see Useful Information about the Installer [page 89], Running the Installer [page 84].</td>
<td>Software Provisioning Manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td>Verification of Integrity of Data Units in Software Provisioning Manager</td>
<td>The integrity of data units extracted from the Software Provisioning Manager archive is verified. For more information, see Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 71]. In addition, check SAP Note 1680045 whether additional information is available.</td>
<td>Software Provisioning Manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
<tr>
<td>Archive-Based Installation</td>
<td>You can now download the required installation archives instead of the complete SAP kernel installation media. For more information, see section Downloading Specific Installation Archives (Archive-Based Installation) in Preparing the Installation Media [page 67].</td>
<td>Software Provisioning Manager 1.0 SP17 (SL Toolset 1.0 SP17)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Diagnostics Agent</strong></td>
<td>The Diagnostics Agent is no longer installed automatically with the SAP system. The <em>Install Diagnostics Agent</em> check box on the <em>Install Diagnostics Agent</em> screen is no longer available. You now have to install the Diagnostics Agent always separately. We recommend that you install it prior to the installation of your SAP system(s). For more information, see the Diagnostics Agent Installation Strategy attached to SAP Note 1365123, to SAP Note 1833501, and to SAP Note 1858920 and the attached Diagnostics Agent Setup Guide.</td>
<td>Software Provisioning Manager 1.0 SP10 (SL Toolset 1.0 SP16)</td>
</tr>
<tr>
<td><strong>System Provisioning for SAP NetWeaver 7.5 and SAP NetWeaver 7.5-based Products</strong></td>
<td>All system provisioning tasks (installation, system copy, system rename) are available for the new SAP NetWeaver 7.5 release. The Dual Stack option, which integrates an AS ABAP and AS Java in a single system (common System ID <code>&lt;SAPSID&gt;</code>, common startup framework, common database), is no longer supported in SAP systems based on SAP NetWeaver 7.5. After upgrading to SAP NetWeaver 7.5 PI, you first have to split the still existing dual stack system before you can use SAP NetWeaver 7.5 PI productively. For more information, see the Upgrade Master Guide - SAP NetWeaver 7.5 at: <a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a> <em>Installation and Upgrade</em>.</td>
<td>Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP15)</td>
</tr>
<tr>
<td><strong>System Provisioning for SAP Solution Manager 7.2</strong></td>
<td>All system provisioning tasks (installation, system copy, system rename) are available for the new SAP Solution Manager 7.2 release. Compared to previous SAP Solution Manager releases, SAP Solution Manager 7.2 is no longer provided as a classical dual-stack system (ABAP system with Java Add-in), but consists of a separate ABAP and Java stack.</td>
<td>Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP15)</td>
</tr>
<tr>
<td><strong>Windows Domain Organizational Units</strong></td>
<td>You can now specify an optional organizational unit (OU) within the Windows domain where you want the installer to create the SAP system accounts. For more information, see SAP System Parameters [page 44].</td>
<td>Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP14)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Creating Kernel Archives from</td>
<td>You can reuse the binaries of a dedicated SAP system for a new SAP system installation or target system installation in the context of a system copy by creating *.SAR archives based on the *.lst files from the executable (exe) directories of the source SAP system.</td>
<td>Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP14)</td>
</tr>
<tr>
<td>existing SAP System</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td>This feature is only available for Unicode systems.</td>
<td></td>
</tr>
<tr>
<td>Caution</td>
<td>This feature has been deprecated with Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21) and the related option has been removed from the Welcome screen. This deprecation has been accomplished to ensure compliance with the new feature “Media Signature Check” of Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21) described above in this table.</td>
<td></td>
</tr>
<tr>
<td>Usage Type Library Deprecation</td>
<td>Software Provisioning Manager 1.0 no longer uses the “Usage Types” definitions in its business logic for SAP systems based on SAP NetWeaver 7.3 EHP1 and higher. This is done to unify modeling and terminology across all SAP tools used during the planning, installation and maintenance activities. The “Product Instance” definition replaces “Usage Types” regarding product modeling. For more information, see SAP Notes 1970349 and 1877731.</td>
<td>Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12)</td>
</tr>
<tr>
<td>for SAP Systems Based on</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 EHP1 and Higher</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adaptive Installation</td>
<td>You can assign virtual host names to SAP system instances during the input phase of the installation directly on the screens where you define the instance parameters. For more information, see SAP System Parameters [page 44].</td>
<td>Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12)</td>
</tr>
<tr>
<td>Feedback Evaluation Form</td>
<td>SAP SE’s aim is to provide fast and efficient procedures. To evaluate the procedure you just carried out, we need information generated by the tool during process execution and your experience with the tool itself. A new evaluation form contains a simple questionnaire and XML data generated during the procedure. Port 4239 is used for displaying the feedback evaluation form. For more information, see Prerequisites for Running the Installer [page 82].</td>
<td>Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Option Verify Signed</td>
<td>The digital signature ensures that the signatory of a digital document can be identified unambiguously and signatory’s name is documented together with the signed document, the date, and the time.</td>
<td>Software Provisioning Manager 1.0 SP06 (SL Toolset 1.0 SP11)</td>
</tr>
<tr>
<td>Media</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>For more information, see SAP Note 1979965.</td>
<td></td>
</tr>
<tr>
<td>Valid only for SAP</td>
<td>You can install Enterprise Services Repository in an existing SAP NetWeaver Composition Environment 7.1 system using the Add ESR Capability installation option, which is available on the Welcome screen at:</td>
<td>Software Provisioning Manager 1.0 SP05 (SL Toolset 1.0 SP10)</td>
</tr>
<tr>
<td>NetWeaver Composition</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Environment 7.1:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Services</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Repository</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>You can install Enterprise Services Repository in an existing SAP NetWeaver Composition Environment 7.1 system using the Add ESR Capability installation option, which is available on the Welcome screen at:</td>
<td>SAP NetWeaver Composition Environment (CE) 7.1 &lt;Database&gt; SAP Systems Application Server Java Enterprise Services Repository Add-On</td>
</tr>
</tbody>
</table>
2 Installation Options Covered by this Guide

This section shows the installation options covered by this installation guide. You have to decide what exactly you want to install because the steps you have to perform vary according to the installation option you choose. After you have decided on the installation option that you want to use, continue with Planning [page 28].

- Standard System [page 21]
- Distributed System [page 22]
- High Availability System [page 23]
- Additional Application Server Instance [page 23]
- SCS Instance with Integrated SAP Web Dispatcher [page 25]

2.1 Standard System

You can install a standard system on a single host.

In a standard system, all main instances run on a single host.

There are the following instances:

- Central services instance (SCS instance)
  - Contains the Java message server and the Java enqueue server
  - Optionally, you can install the SCS instance with an integrated SAP Web Dispatcher. For more information, see SCS Instance with Integrated SAP Web Dispatcher [page 25].
- Database instance (DB)
- Primary application server instance (PAS instance)

Additionally, you can install one or more additional application server instances. For more information, see Additional Application Server Instance [page 23].
2.2 Distributed System

An SAP system consists of SAP instances. An SAP instance is a group of processes that are started and stopped at the same time.

In a distributed system, every instance can run on a separate host.

**Note**

We strongly recommend installing the ASCS instance on the same host as the primary application server. The installation of the ASCS instance on a separate host is reserved for high-availability configurations on Windows that are not using Microsoft Failover Clustering.

- Central services instance (SCS instance)
  Contains the Java message server and the Java enqueue server
  Optionally, you can install the SCS instance with an integrated SAP Web Dispatcher. For more information, see [SCS Instance with Integrated SAP Web Dispatcher](#).
- Database instance (DB)
  The Java stack uses its own database schema in the database.
- Primary application server instance (PAS)

The following figure assumes the following:

- The SCS instance runs on the SAP global host.
- The global transport directory resides on a separate SAP transport host.

Optionally, you can install one or more additional application server instances. For more information, see [Installation of an Additional Application Server Instance](#).
2.3 High Availability System

For more information about the system components you have to install and how to distribute them on the specific hosts, see System Configuration with Microsoft Failover Clustering [page 147].

2.4 Additional Application Server Instance

You can install one or more additional application server instances for an existing SAP system. Additional application server instances are optional and can be installed on separate hosts.

An additional application server instance can run on:

- The host of any instance of the existing SAP system
- On a dedicated host

**i Note**

We do not recommend installing additional application server instances on the SAP global host.

**i Note**

If you want to install an additional application server instance on an existing SAP system, you must perform a domain installation. You must also make sure that your existing SAP system was installed as a domain installation. For more information, see Domain or Local Installation [page 42].
**Additional Application Server Instance for a Standard System**

The following figure shows additional application server instances that are running on dedicated hosts.

[Diagram of additional application server instance for a standard system]

For more information, see [Standard System [page 21]].

**Additional Application Server Instance for a Distributed System**

The following figure shows additional application server instances that are running on dedicated hosts.
Additional Application Server Instance for a Distributed Java System

For more information, see Distributed System [page 22].

Only valid for ‘High Availability’: HA (Windows)

Additional Application Server Instance for a High-Availability System

In a high-availability system, you require, apart from the primary application server instance, at least one additional application server instance. For more information about how to install and distribute the application servers in an HA configuration, see section System Configuration with Microsoft Failover Clustering [page 147].

End of ‘High Availability’: HA (Windows)

2.5 SCS Instance with Integrated SAP Web Dispatcher

You can install an SAP Web Dispatcher integrated in the SCS instance. If you select this option, an SAP Web Dispatcher is installed running within the SCS instance. No separate SAP Web Dispatcher instance and no dedicated <SAPSID> are created for the SAP Web Dispatcher. We recommend this if you want to use the SAP Web Dispatcher for the system to which the SCS instance belongs.

i Note

We only recommend this option for special scenarios. For more information, see SAP Note 908097. For an SAP Web Dispatcher installation, a standalone installation (see below) continues to be the default scenario.
The SAP Web Dispatcher is located between the Web client (browser) and your SAP system that is running the Web application.

It acts as single point of entry for incoming requests (HTTP, HTTPS), defined by the IP address, port, and URL, and forwards them in turn to the application server (AS) of the SAP system.

The SAP Web Dispatcher receives information about the SAP system that it needs for load distribution (load balancing) from the message server and application server via HTTP.

### Installation of “Standalone” SAP Web Dispatcher with its own <SAPSID> and Instance

If you want to install an SAP Web Dispatcher for another system - that is not for the system for which you use the SCS instance and with its own SAP system ID and instance number - you have to install SAP Web Dispatcher separately as described in the documentation which you can find under http://support.sap.com/sitoolset. System Provisioning > Installation Option of Software Provisioning Manager > Guide for SAP Web Dispatcher for SAP NetWeaver 7.0 or Higher.
More Information

For more information about the architecture and the functions of SAP Web Dispatcher, see the SAP Web Dispatcher documentation in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3</td>
<td>Application Help</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw73">http://help.sap.com/nw73</a></td>
<td>Function-Oriented View</td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td>Application Server Infrastructure</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw731">http://help.sap.com/nw731</a></td>
<td>Components of SAP NetWeaver</td>
</tr>
<tr>
<td>SAP NetWeaver 7.4</td>
<td>Application Server</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw74">http://help.sap.com/nw74</a></td>
<td>SAP Web Dispatcher</td>
</tr>
<tr>
<td>SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td></td>
</tr>
</tbody>
</table>

Related Information

Parameters for Additional Components to be Included in the SCS Instance (Optional) [page 55]
3 Planning

3.1 Planning Checklist

This section includes the planning steps that you have to complete for the following installation options.
- Standard, distributed, or high-availability system
- Additional application server instance

Detailed information about the steps are available in the linked sections.

Prerequisites

1. You have planned your SAP system landscape according to the Master Guide available at the appropriate download location as described in Before You Start [page 13].
2. You have decided on your installation option (see Installation Options Covered by this Guide [page 21]).

Standard, Distributed, or High-Availability System

i Note
In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. Make yourself familiar with the changed file system structure and profiles for SAP systems based on SAP NetWeaver 7.1 and higher compared to SAP systems based on lower SAP NetWeaver releases. For more information, see Changed File System Structure and Profiles for SAP Systems Based on SAP NetWeaver 7.1 and Higher [page 29].
2. If you want to install an SAP Java system along with the required Support Package stack in one implementation run, you need to plan the desired installation target using the maintenance planner at https://apps.support.sap.com/sap/support/mp. In the maintenance planner, a stack XML file with the desired Support Package stack and Add-On information is generated, which you then hand over to Software Provisioning Manager (the “installer” for short) by calling it with command line parameter SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File>. Included constraints and defaults defined in the stack XML file are then used for the initial installation by Software Provisioning Manager and for the application of Support Package stacks and Add-Ons by the Software Update Manager (SUM). For more information, see Installation Using a Stack Configuration File (Optional) [page 30].
Recommendation

We recommend that you perform the installation using a stack configuration file for all new products such as SAP S/4HANA on Premise.

3. You check the hardware and software requirements [page 32] on every installation host.
4. You plan how to set up user and access management [page 41].
5. You identify Basic SAP System Installation Parameters [page 43].
6. You decide whether you want to perform a domain or local installation [page 42].
7. You carefully plan the setup of your database [page 56].
8. You decide on the transport host to use [page 57].
9. You decide whether you want to integrate LDAP Directory Services in your SAP system [page 183].
10. Only valid for ‘High Availability’: HA (Windows)
    To install a high-availability system with Microsoft Failover Clustering, you perform the HA-specific planning steps [page 145].
    End of ‘High Availability’: HA (Windows)
11. Continue with Preparation [page 58].

Additional Application Server Instance

1. You check the hardware and software requirements [page 32] for every installation host on which you want to install one or more additional application server instances.
2. You identify Basic SAP System Installation Parameters [page 43].
3. Continue with Preparation [page 58].

3.2 Changed File System Structure and Profiles for SAP Systems Based on SAP NetWeaver 7.1 and Higher

File system structure

- For SAP system releases based on SAP NetWeaver 7.1 and higher, the directory structure was changed compared to SAP NetWeaver 7.0, in order to support heterogeneous system installations and updates more efficiently.

⚠️ Caution

The directory structure of systems based on SAP NetWeaver 7.1 or higher is not supported on systems based on SAP NetWeaver 7.0 including Enhancement Packages.

- For a manual switch, see the details about targeted file system structure in this documentation and adjust your file system accordingly to avoid later issues for system transformation such as system copy and system rename.
Profiles

- As of SAP NetWeaver 7.3, the start profile as separate file has been removed. In earlier versions of SAP NetWeaver there was one default profile per SAP system, one start profile per Instance and one Instance profile per instance. Now the start profile contents are merged with the instance profile. With the help of the new instance profile, SAP processes are started and at the same time instance-specific parameters are read. This reduces the total number of profile files to one default profile per SAP System, and one instance profile per instance.

For more information, see the SCN blog What’s new in SAP NetWeaver 7.3 - A Basis perspective at: https://blogs.sap.com/2012/05/22/whats-new-in-sap-netweaver-73-a-basis-perspective/.

⚠ Caution

The merged profiles are not supported for SAP NetWeaver 7.0 including Enhancement Packages because this could lead to issues for SAP system copy. If you are not sure which SAP NetWeaver product version you have, see SAP Note 1877731 for more information.

- For more information about merging the start profile with the instance profiles, see SAP Note 1528297.
- Additional application server instances: Double-check the values with the profile values from the primary application server - for example for parameters DIR_CT_RUN, DIR_EXECUTABLE, DIR_SAPJVM - to avoid startup issues.

3.3 Installation Using a Stack Configuration File

The option to perform an installation using a stack configuration file (also called “up-to-date installation” or “UDI” for short) improves the process of provisioning an up-to-date SAP system by creating a unified consumption experience and a direct close collaboration between the involved tools, namely:

- Maintenance Planner, accessible at https://apps.support.sap.com/sap/support/mp
- LMDB in SAP Solution Manager
- Software Provisioning Manager (the “installer” for short)
- Software Update Manager (“SUM”)

The installer then can take over more default settings that are already predefined in the Maintenance Planner.

➡ Recommendation

We recommend that you perform the installation using a stack configuration file for new products, such as SAP S/4HANA or SAP Solution Manager 7.2.
Prerequisites

- To be able to use the Maintenance Planner at https://apps.support.sap.com/sap/support/mpr, your SAP Solution Manager system must have at least one of the following release and Support Package (SP) level:
  - SAP Solution Manager 7.2
  - SAP Solution Manager 7.1 SP06 or higher
  - SAP Solution Manager 7.0 SP 23 and you must have applied the following SAP Notes:
    - 1646604
    - 1783371
    - 1743695
- You must have implemented SAP Note 1940845 in your SAP Solution Manager system.
- For additional information about involved tools and supported SAP system releases, see SAP Note 2277574.

Features

An installation using a stack configuration file provides the following features:

- You can use a stack configuration file generated by the Maintenance Planner at https://apps.support.sap.com/sap/support/mpr. The parameters contained in the stack configuration file can then be processed by the installer to get better integrated with SUM and to simplify the process of installation for a new system on a target software level. This makes IT administration easier by reducing the efforts in Total Cost of Ownership (TCO). For more information, see the Best Practice Guide to Planning Landscape Changes at https://wiki.scn.sap.com/wiki/display/SL/Landscape+Management+-+the+Process.
- When processing a stack configuration file, the installer can take over more default settings that are already predefined in the Maintenance Planner and offers more possibilities for automation as compared to when running without it. For more information about the benefits by comparing the existing process with the new improved process, see Up-To-Date Installation at https://blogs.sap.com/2016/10/21/up-to-date-installation-2/.

**Note**

The procedure and the screenshots provided in the linked document are only an example to show how an up-to-date installation works in general for an example SAP product, and what the benefits are. This document is not intended to serve as a detailed instruction for an up-to-date-installation of any supported SAP product.

- You can use the installer to directly download the installation software from SAP by providing the Maintenance Plan to the installer while running installer option Download Software Packages for Maintenance Planner Transaction.
  For more information, see Downloading Software Packages for a Maintenance Planner Transaction [page 76]
Integration

In addition, each section in this guide describing steps that are completely or at least partially automatized when using a stack configuration files is marked with an appropriate note at the beginning. These are the following sections as listed in the adjacent section Related Information:

Related Information

Preparing the Installation Media [page 67]
Running the Installer [page 84]
Applying the Latest Kernel and Support Package Stacks [page 110]

3.4 Hardware and Software Requirements

Ensure that your hosts meet the hardware and software requirements for your operating system and the SAP instances. Otherwise you might experience problems when working with the SAP system.

Prerequisites

- Make sure that the host name meets the requirements listed in SAP Note 611361.
- Contact your OS vendor for the latest OS patches.

Procedure

1. Check the Product Availability Matrix at http://support.sap.com/pam for supported operating system releases.
2. Check the hardware and software requirements using:
   - The Prerequisite Checker:
     - Standalone (optional) before the installation process
     - Integrated in the installation tool (mandatory) as part of the installation process
   - The hardware and software requirements tables in Requirements for the SAP System Hosts [page 34]
3. If you want to install a production system, the values provided by the Prerequisite Checker and the hardware and software requirements checklists are not sufficient. In addition, do the following:
If you want to install usage type Development Infrastructure (DI), also check SAP Note 737368 for system requirements and sizing.

- You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:
  - The set of applications to be deployed
  - How intensively the applications are to be used
  - The number of users

### 3.4.1 Running the Prerequisites Check in Standalone Mode (Optional)

This section describes how to run the prerequisites check in standalone mode. Running the prerequisites check in standalone mode is optional.

#### Context

When you install an SAP system, the installer automatically starts the prerequisites check and checks the hardware and software requirements in the background. As an optional step during planning, you can also run the prerequisites check in standalone mode to check the hardware and software requirements for your operating system and the SAP instances before the actual installation.

→ Recommendation

We recommend that you use **both** the prerequisites check and the requirements tables for reference.

#### Procedure

1. Download and unpack the Software Provisioning Manager archive to a local directory as described in [Downloading and Extracting the Software Provisioning Manager 1.0 Archive](#).
2. Make either the separate `SAP\<Version\>.SAR` archive or the complete kernel medium available as described in [Preparing the Installation Media](#).
3. Start the installer as described in [Running the Installer](#).
4. On the **Welcome** screen, choose **<SAP_Product>** <Database> **Preparations** Prerequisites Check**.
5. Follow the instructions in the installer dialogs and enter the required parameters.
To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field, and choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.

After you have finished, the Parameter Summary screen appears. This screen summarizes all parameters that you have entered and that you want to have checked. If you want to make a change, select the relevant parameters and choose Revise.

6. To start the prerequisites check, choose Next.

Results

The Prerequisite Checker Results screen displays the results found. If required, you can also check the results in file prerequisite_checker_results.html, which you can find in the installation directory.

Related Information

Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 71]
Preparing the Installation Media [page 67]

3.4.2 Requirements for the SAP System Hosts

This section provides information about the hardware and software requirements for the:

- Central services instance (SCS)
- Database instance
- Primary application server instance
- Additional application server instance

Note

The additional application server instance is optional in a non-HA system, but mandatory in an HA system.

- Only valid for ‘High Availability’: HA (Windows)

High Availability only: Enqueue Replication Server instance (ERS)

End of ‘High Availability’: HA (Windows)

- SAP Host Agent
### General Requirements for a High-Availability System

- **Windows Server 2012 (R2) and higher:**
  1. Check that your cluster hardware is certified for Windows Server 2012 (R2) or Windows 2016 and has the Windows Server 2012 (R2) or Windows 2016 logo.
  2. You must validate your failover cluster configuration by running the command `test-cluster` in a PowerShell. The *Failover Cluster Validation Report* must not show any errors.

- **Windows Server 2008 (R2):**
  1. Check that your cluster hardware is certified for Windows Server 2008 (R2) and has the Windows Server 2008 (R2) logo.
  2. You must validate your failover cluster configuration by running the *Validate a Configuration Wizard*, which is included in the *Failover Cluster Management* snap-in. This must not show any errors.

- The cluster nodes of the cluster must be connected by a private and public network:
  - The public network enables communication from the cluster nodes of the cluster to other resources in the local area network (LAN).
  - The private network enables internal communication between the cluster nodes. In particular, it enables the Cluster Service running on all cluster nodes to regularly exchange messages on the state of the cluster nodes so that the failure of resources is quickly detected.

- Each of the cluster nodes in the cluster must have its own local disks and have access to an external file share or shared disks that can be reached by the cluster nodes via a shared bus. For more information about the distribution of components to local and shared disk, see *Distribution of SAP System Components to Disks for Failover Clustering* [page 154].

- All disk controllers must be able to support hardware-based RAID.

⚠️ **Caution**

You cannot use a host with a domain controller as a cluster node.

### Hardware and Software Requirements

The following tables show the hardware and software requirements. Most of the requirements are valid for every installation host whereas some requirements are instance-specific and are marked accordingly.

ℹ️ **Note**

- The listed values are sufficient for development systems or quality assurance systems but not for production systems.
- If you install several SAP instances on one host, you need to add up the requirements.
Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>• Central services instance (SCS) (not including paging file): 5 GB (x64)</td>
<td>To check disk space:</td>
</tr>
<tr>
<td></td>
<td>If you install the SCS instance with an integrated SAP Web Dispatcher, for the installation as such you require at least 1 GB of hard disk space in addition. For productive use of the SAP Web Dispatcher, you need to reserve at least 5 GB.</td>
<td>• Windows Server 2012 (R2) and higher:</td>
</tr>
<tr>
<td></td>
<td>• Database instance</td>
<td>1. Open PowerShell in elevated mode, and enter the following command: get-volume</td>
</tr>
<tr>
<td></td>
<td>For more information about the required disk space, see SAP Note 1748888.</td>
<td>2. Check the value SizeRemaining of the disk you want to install on.</td>
</tr>
<tr>
<td></td>
<td>• Only valid for ‘High Availability’: HA (Windows)</td>
<td>• Windows Server 2008 (R2):</td>
</tr>
<tr>
<td></td>
<td>High Availability only: Enqueue replication server instance (ERS) (not including paging file): 5 GB (x64)</td>
<td>1. Choose Start ➤ All Programs ➤ Administrative Tools ➤ Storage ➤ Computer ➤ Management ➤ Disk Management ➤ Properties.</td>
</tr>
<tr>
<td></td>
<td>• Primary application server instance (not including paging file): 5 GB (x64)</td>
<td>2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td></td>
<td>o In addition, you require 4 GB (x64) per additional platform.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>o Up to 2 GB for each usage type or software unit you want to install.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Additional application server instance (not including paging file): 2.5 GB (x64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SAP Host Agent: 256 MB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Temporary disk space for every required installation medium that you have to copy to a local hard disk: Up to 6 GB</td>
<td></td>
</tr>
</tbody>
</table>

i Note

For safety reasons (system failure), the file systems must be distributed physically over several disks, or RAID-technology must be used.

For up-to-date information on the released and supported operating system versions for your SAP product and database, see the Product Availability Matrix (PAM) at: http://support.sap.com/pam.
<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum RAM</td>
<td></td>
<td>To check RAM:</td>
</tr>
<tr>
<td></td>
<td>● All instances, except SAP Host Agent:</td>
<td>• Windows Server 2012 (R2) and higher: Open PowerShell in elevated mode, and enter the following command:</td>
</tr>
<tr>
<td></td>
<td>4 GB</td>
<td>Get-WmiObject Win32_Computer System</td>
</tr>
<tr>
<td></td>
<td>● SAP Host Agent:</td>
<td>• Windows Server 2008 (R2): Choose Start Control Panel System</td>
</tr>
<tr>
<td></td>
<td>0.5 GB</td>
<td></td>
</tr>
</tbody>
</table>

**i Note**

If System is not visible, change View by: from Category into Large icons.

If you want to install usage type BI Java, see SAP Note [927530](#) for current information on hardware sizing.
<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paging file size</td>
<td>For more information, see SAP Note <a href="https://support.sap.com">1518419</a>.</td>
<td>To check paging file size:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Windows Server 2012 (R2) and higher: For more information, see Checking and Changing the Paging File Settings on Windows Server 2012 (R2) [page 178]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Windows Server 2008 (R2):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Choose Start &gt;&gt; Control Panel &gt;&gt; System &gt;&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Choose Advanced system settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. In section Performance, select &gt;&gt; Settings... &gt;&gt; Advanced &gt;&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. If required, in section Virtual memory, choose Change.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>i Note</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Do not select Automatically managed paging file.</td>
</tr>
</tbody>
</table>
### Hardware Requirement

<table>
<thead>
<tr>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>size for all drives.</td>
<td>Only valid for ‘High Availability’: HA (Windows)</td>
</tr>
<tr>
<td>i Note</td>
<td>High Availability only: You must adjust the size of the paging file on all cluster nodes.</td>
</tr>
<tr>
<td>i Note</td>
<td>End of ‘High Availability’, HA (Windows)</td>
</tr>
</tbody>
</table>

### Processing units

**For application server instances and database instances:**

The number of physical or virtual processing units usable by the operating system image must be equal to or greater than 2.

**For an SCS instance running on a separate host:** One physical or virtual processing unit usable by the operating system image might be sufficient.

Examples of processing units are processor cores or hardware threads (multithreading).

In a virtualized environment, ensure that adequate processor resources are available to support the workloads of the running SAP systems.

### Suitable backup system

Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.3 to 7.5 on Windows: SAP Adaptive Server Enterprise
## Software Requirements

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Windows operating system | - 64-bit version of one of the following Windows Server Editions:  
  ○ Windows Server 2012 (R2) and higher:  
    ○ Windows Server Standard Edition  
    ○ Windows Server Datacenter Edition  
  ○ Windows Server 2008 (R2) Service Pack 1  
    ○ Only valid for 'High Availability': non-HA  
    ○ Windows Server Standard Edition  
    ○ End of 'High Availability': non-HA  
  ○ Windows Server Enterprise Edition  
  ○ Windows Server Datacenter Edition | To check your Windows version:  
  - Windows Server 2012 (R2) and higher: Open PowerShell in elevated mode, and enter the following command: `Get-WmiObject Win32_OperatingSystem | select caption`  
  - Windows Server 2008 (R2):  
    1. Choose `Start` ➔ `All Programs` ➔ `Accessories` ➔ `Command Prompt`  
    2. Enter the command `winver`  
  - Only valid for 'High Availability': HA (Windows) |

⚠️ Caution

For up-to-date information on the released and supported operating system versions for your SAP product and database, see the Product Availability Matrix (PAM) at http://support.sap.com/pam.

⚠️ Caution

Make sure that you install the **English** language pack so that your support requests can be handled quickly.

- For any version of Windows Server, you need the latest supported service pack.

### Note

- You must add the operating system feature *Failover Clustering* on all cluster nodes.

End of 'High Availability': HA (Windows)

### Note

- You can install additional languages but the default setting for new users must always be *English (United States)*.

---

**English (United States)** must be set by default. For more information about localized Windows versions, see SAP Note 362379.

You can install additional languages but the default setting for new users must always be *English (United States)*.
<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Web Browser</td>
<td>Make sure that you have at least one of the following web browsers installed on the host where you run the installer GUI:</td>
<td>Choose [Start] &gt; [Control Panel] &gt; [Programs and Features]</td>
</tr>
<tr>
<td></td>
<td>● Microsoft Internet Explorer 11 or higher</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Microsoft Edge</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Mozilla Firefox</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Google Chrome</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Always use the latest version of these web browsers.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You need a web browser to be able to run the SL Common GUI, and to display the Evaluation Form and send it to SAP.</td>
<td></td>
</tr>
</tbody>
</table>

### 3.5 Planning User and Access Management

You have to plan how to configure user and access management for the SAP system to be installed.

Before you add a newly installed SAP system to your system landscape, you must decide which kind of user management you want to use:

- The database of AS Java.
- An external ABAP system as the data source for user data
- An LDAP directory as the data source for user data

**Note**

If you want to install an Advanced Adapter Engine Extended (AEX), you can only use the database of AS Java for the user management. After the installation has finished, you cannot change the user management configuration.

You cannot configure the AS Java to simultaneously access an LDAP directory and an AS ABAP as the data source. The AS Java can also use its own database as the data source.

**Procedure**

To specify the initial data source of the User Management Engine (UME), proceed as described in Specifying the Initial Data Source of the User Management Engine [page 82].
More Information

For more information about configuring the user management of your SAP system to be installed, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3</td>
<td><img src="http://help.sap.com/nw73" alt="Application Help" /></td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td><img src="http://help.sap.com/nw731" alt="SAP NetWeaver Library: Function-Oriented View" /></td>
</tr>
<tr>
<td>SAP NetWeaver 7.4</td>
<td><img src="http://help.sap.com/nw74" alt="Security" /></td>
</tr>
<tr>
<td>SAP NetWeaver 7.5</td>
<td><img src="http://help.sap.com/nw75" alt="Identity Management" /></td>
</tr>
</tbody>
</table>

3.6 Domain or Local Installation

Use

Before you install the SAP system, you have to decide whether you want to perform a **domain** or **local** installation, since this affects how the user account information is stored and accessed.

For more information about the differences between a local and domain installation, go to ![Start Help and Support](http://help.sap.com) and search for *What is the difference between a domain and a workgroup?*.

Domain Installation

In a domain installation, the user account information is stored centrally in one database on the domain controller and is accessible to all hosts in the system.

You have to perform a domain installation if one of the following applies:

- You install a distributed system.
- You install a high-availability system with Microsoft Failover Clustering.
- You use a common transport host for several SAP systems running on different computers.

Local Installation

In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a **single** machine (standard system), you can perform a local installation.
### Basic Installation Parameters

The installer prompts for input parameters during the Define Parameters phase of the installation.

You can install your SAP system either in Typical or Custom mode:

- **Typical**
  - If you choose **Typical**, the installation is performed with default settings. This means that the installer prompts you only for a small selection of installation parameters. These parameters include at least the following:
    - SAP system ID and database connectivity parameters
    - Master password
    - JCE Unlimited Strength Jurisdiction Policy files archive (only prompted if you install Adobe Document Services)
    - SAP system profile directory – only for systems with instances on separate hosts
    - User Management Engine (UME) Configuration
  
  **Note**
  - If you want to install an optional standalone unit - Advanced Adapter Engine (AAE), Advanced Adapter Engine Extended (AEX), or Process Integration and Orchestration (PI-CP) - you are not prompted for UME Configuration. Instead, optional standalone units are automatically configured to store the SAP system users in the Java database (see also section User Management Engine Parameters in SAP System Parameters [page 44]).

  For more information about the installation parameters, see the corresponding tables below in this document. If you want to change any of the default settings, you can do so on the Parameter Summary screen.

- **Custom**
  - If you choose **Custom**, you are prompted for all parameters. At the end, you can still change any of these parameters on the Parameter Summary screen.
The tables in the sections below list the basic SAP system installation parameters that you need to specify before installing your SAP system. For all other installation parameters, use the tool help on the installer screens.

### Related Information

- SAP System Parameters [page 44]
- SAP System Database Parameters [page 54]
- Parameters for Additional Components to be Included in the SCS Instance (Optional) [page 55]

### 3.7.1 SAP System Parameters

The tables in this section lists the basic SAP system installation parameters that you need to specify before installing your SAP system. For all other installation parameters, use the tool help on the installer screens.

#### General Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unicode System</td>
<td>A Java standalone system is always a Unicode system.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAP System ID</td>
<td>The SAP system ID (&lt;SAPSID&gt;) identifies the entire SAP system. The installer prompts you for the &lt;SAPSID&gt; when you execute the <strong>first</strong> installation option to install a new SAP system. If there are further installation options to be executed, the installer prompts you for the profile directory. For more information, see the description of the parameter <strong>SAP System Profile Directory</strong>.</td>
</tr>
</tbody>
</table>

**Example**

This prompt appears when you install the SCS instance, which is the first instance to be installed in a distributed system.

**Caution**

Choose your SAP system ID carefully since renaming requires considerable effort.

Make sure that your SAP system ID:

- Is unique throughout your organization. Do not use an existing <SAPSID> when installing a new SAP system.

**Example**

If you have already installed an ABAP system and you want to install a new Java system on the same host, make sure that you enter a <SAPSID> that is different from the <SAPSID> of the existing ABAP system. The <SAPSID> of a Java stack can only be equal to the <SAPSID> of an ABAP stack if they form a dual-stack system.

Dual stack is no longer supported in SAP systems based on SAP NetWeaver 7.5 or higher.

- Consists of exactly three alphanumeric characters
- Contains only uppercase letters
- Has a letter for the first character
- Does not include any of the reserved IDs listed in SAP Note 1979280
- If you want to install an additional application server instance, make sure that no Gateway instance with the same SAP System ID (SAPSID) exists in your SAP system landscape.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System Instance Numbers</td>
<td>Technical identifier for internal processes. It consists of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers. If you do not enter a specific value, the instance number is set automatically to the next free and valid instance number that has not yet been assigned to the SAP system to be installed or to SAP systems that already exist on the installation host.</td>
</tr>
</tbody>
</table>

**Only valid for ‘High Availability’: HA (Windows)**

- **i Note**
  - If you install the central instance and the dialog instances on the cluster nodes of a Microsoft fail-over cluster, SAPinst by default assigns the same instance number.
  - If you install the central instance and the dialog instances on hosts that are not part of a Microsoft failover cluster, we recommend that you use the same instance number for them. If the instance number is already used on other hosts, you have to assign a different instance number for the central instance and the dialog instances.

**End of ‘High Availability’: HA (Windows)**

To find out the instance numbers of SAP systems that already exist on the installation host, look for sub-directories ending with `<Instance Number>` of local `\usr\sap\<SAPSID>` directories.

For more information, see SAP Directories [page 175].

---

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Host Name</td>
<td>Virtual host name (network name) of the SAP <code>&lt;SAPSID&gt;</code> cluster group</td>
</tr>
<tr>
<td></td>
<td>You can assign a virtual host name to an SAP instance in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>• You can assign a virtual host name for the instance to be installed, by specifying it in the <code>&lt;Instance Name&gt; Host Name</code> field of the <code>&lt;Instance Name&gt;</code> <code>Instance</code> screen. Then this instance is installed with this virtual host name.</td>
</tr>
<tr>
<td></td>
<td>• Alternatively you can assign virtual host names also by starting the installer with the <code>SAPINST_USE_HOSTNAME</code> property. For more information, see Running the Installer [page 84].</td>
</tr>
</tbody>
</table>

After the installation has completed, all application servers can use this virtual host name to connect to the instance. If you do not provide the virtual host name, the instance is installed automatically using the physical host name (= Windows host name) of the host where you run the installer.

You must have already reserved the virtual host name (network name) and its IP address on a DNS server before you run the installer. For more information, see Using Virtual Host Names [page 63].

**i Note**

- Fully qualified host names, IPv4, IPv6 are not accepted as virtual host names.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System Profile Directory</td>
<td>The installer retrieves parameters from the SAP system profile directory of an existing SAP system. SAP profiles are operating system files that contain instance configuration information. The installer prompts you to enter the location of the profile directory when the installation option that you execute is not the first one belonging to your SAP system installation, for example if you are installing a distributed system or an additional application server instance to an existing SAP system. See also the description of the parameters SAP System ID and Database ID.</td>
</tr>
<tr>
<td>Destination drive</td>
<td>Base directory for the SAP system.</td>
</tr>
</tbody>
</table>

**Note**

If you install a subsequent SAP system, the saploc share already exists and you cannot select the installation drive. The installer uses the installation drive where the saploc share points to.
### Parameter Description

**Master Password**
Common password for all users that are created during the installation:

- Operating system users (for example `<sapsid>adm`, `<sapsid>SAPService<\sapsid>`)

⚠️ **Caution**
If you did not create the operating system users manually before the installation, the installer creates them with the common master password (see **Operating System Users**). In this case, make sure that the master password meets the requirements of your operating system.

- Java users
  (for example `Administrator`)

- Secure Store key phrase
  **SAP systems based on SAP NetWeaver lower than 7.4:** For more information, see line **Key Phrase for Secure Store Settings** in this table.

⚠️ **Caution**
The installer applies the master password to users SAP* and DDIC for SAP system clients 000 and 001 only, but not to users SAP*, DDIC, and EARLYWATCH in SAP system client 066.

Instead, the installer always assigns the following passwords to these users in client 066:

- **SAP**: 06071992
- **EARLYWATCH**: support

See also **Ensuring User Security**.

⚠️ **Note**
If a user already exists, you are prompted to confirm the password for this user.

#### Basic Password policy
The master password must meet the following requirements:

- It must be 8 to 14 characters long
- It must contain at least one letter (a-z, A-Z)
- It must contain at least one digit (0-9)
- It must not contain \ (backslash) or " (double quote).

**Additional restrictions depending on Windows:**

- If a user already exists, you are prompted to confirm the password for this user.
- Depending on the configuration of the password policy, additional restrictions might apply.

**Additional restrictions depending on SAP Adaptive Server Enterprise:**

- It must be at least 6 characters long
- It can only contain the following characters: a-zA-Z, 0-9, <space>, !#$%&'()+,-./<>? @\^` {~}

Depending on the installation option, additional restrictions may apply.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example</strong></td>
<td>The master password must not contain the name of a Java user created during the installation.</td>
</tr>
</tbody>
</table>

**Message Server Access Control List**

You can specify if you want to have a message server Access Control List (ACL) created.

The ACL is created as a file in the `/<sapmnt>/<SID>/global` directory. If it exists, it defines the hosts from which the message server accepts requests.

⚠️ **Caution**

Only trigger the creation of this file if you do not plan to install any additional instances for this system. With the creation of this ACL, you overwrite existing settings and prevent instances from being installed on additional hosts. If you decide to install an additional instance later, you need to remove this file manually before the installation and create it again after the installation of the additional instance.

For more information, see the information about `ms/acl_info` in SAP Notes [1495075](https://support.sap.com) and [826779](https://support.sap.com).

**Java(TM) Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files Archive**

If you want to install Adobe Document Services, make sure that you download the unlimited version of the JCE Jurisdiction Policy Files archive. For more information about where to download it, see SAP Note [1240081](https://support.sap.com).

**Key Phrase for Secure Store Settings**

This is a random word or phrase that is used to encrypt the secure store.

The Java EE engine uses this phrase to generate the key that is used to encrypt the data.

The uniqueness of the phrase you use contributes to the uniqueness of the resulting key.

➢ **Recommendation**

Use a long key phrase that cannot be guessed easily. Use both uppercase and lowercase letters in the phrase and include special characters.

➢ **Note**

If you choose Typical mode, the installer sets the master password for the key phrase. In this case, make sure that you replace the master password with the required unique key phrase either on the Parameter Summary screen or after the installation has finished.
### Parameter | Description
--- | ---
DNS Domain Name for SAP System | If you want to use HTTP-based URL frameworks such as Web Dynpro applications, you have to specify the DNS domain name for the SAP system.

The DNS Domain Name is used to calculate the Fully Qualified Domain Name (FQDN), which is configured in profile parameter `SAPLOCALHOSTFULL`. FQDN is the fully qualified domain name for an IP address. It consists of the host name and the domain name:

\(<\text{Host}_\text{Name}>.\langle\text{Domain}_\text{Name}\rangle>\)

The DNS Domain Name is needed to define the URLs for the Java application servers. It is appended to the server name to calculate the FQDN.

For more information, see SAP Note 654982.

**Example**

If your application server host is called `kirk.wdf.sap.com`, the DNS Domain Name is `wdf.sap.com`.

### SAP Host Agent Upgrade (Optional)

If there already exists an SAP Host Agent on the installation host, the installer asks you if you want to upgrade it to a newer patch level version. If you want the existing version to be upgraded, you must provide the new target version of the `SAPHOSTAGENT<Version>.SAR` archive.

For more information, see [Downloading SAP Kernel Archives (Archive-Based Installation)](page 73) [page 73].

### Ports

| Parameter | Description |
--- | --- |
Java Message Server Port | **Caution**

The message server port number must be unique on the host where the message server for the SAP system is running. If there are several message servers running on one host, the message server ports must all be unique.

The SCS instance profile contains the configuration for the Java message server.

The Java message server port uses the parameter `rdisp/msserv_internal` with default value `39<SCS_Instance_Number>`.

For more information about the parameters used for message server ports, see SAP Note 821875.
Operating System Users

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of Operating System Users</td>
<td>The passwords of the operating system users must comply with the Windows password policy. The installer processes the passwords of operating system users as follows:</td>
</tr>
<tr>
<td></td>
<td>• If the operating system users do not exist, SAP creates the following users:</td>
</tr>
</tbody>
</table>
|                                  |   ○ <sapsid>adm  
|                                  |     This user is the SAP system administrator user. It is a member of the local Administrators group.  |
|                                  |   ○ SAPService<SAPSID>  
|                                  |     This user is the Windows account to run the SAP system. It is not a member of the local Administrators group.  |
|                                  |   ○ sapadm  
|                                  |     The SAP Host Agent user sapadm is used for central monitoring services. The installer creates this user by default as a local user although it is not a member of the local Administrators group.  |
|                                  |     If required, you can change this user to become a domain user on the Parameter Summary screen. For more information, see Performing a Domain Installation Without Being a Domain Administrator [page 180].  |
|                                  |     For security reasons, however, SAP strongly recommends you to create this user as a local user.  |
|                                  |     The installer sets the master password for these users by default. You can overwrite and change the passwords either by using the parameter mode Custom or by changing them on the Parameter Summary screen.  |
|                                  | • If the operating system users already exist, the installer prompts you for the existing password, except the password of these users is the same as the master password.  |

⚠️ Caution

Make sure that you have the required user authorization [page 61] for these accounts before you start the installation.

Windows Domain Organizational Units

You can choose the organizational units (OUs) within the Windows domain where you want to create the SAP system accounts.

By default, the installer creates the domain users SAPService<SAPSID>, <SAPSID>adm, and the domain group SAP_<SAPSID>_Globaladmin in the domain Users container. Here you can specify an optional organizational unit where the installer creates these domain users and group. The user who performs the installation needs read and write permissions to this organizational unit.

The OU feature is only available when you select Custom mode in SWPM and choose Use Domain of current user. For more information, see SAP Note 2247673.  

Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.3 to 7.5 on Windows: SAP Adaptive Server Enterprise Planning  

PUBLIC 51
## User Management Engine Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Using the Java Database:</strong></td>
<td></td>
</tr>
<tr>
<td>Administrator User</td>
<td>The installer sets the user name <strong>Administrator</strong> and the master password by default. If required, you can choose another user name and password according to your requirements.</td>
</tr>
<tr>
<td>Guest User</td>
<td>The installer sets the user name <strong>Guest</strong> and the master password by default. The guest user is a user for anonymous access.</td>
</tr>
<tr>
<td><strong>Using an External ABAP System – Parameters for the ABAP Connection:</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Application Server Instance Number | This is the instance number on the application server of the central ABAP system to which you want to connect the Application Server Java. To find out the number on the host of the primary application server instance, look in the following SAP directory:  
  - **SAP systems based on SAP NetWeaver 7.1 to 7.4:** /usr/sap/<SAPSID>/DVEBMGS<Instance_Number>  
  - **SAP systems based on SAP NetWeaver 7.5:** /usr/sap/<SAPSID>/D<Instance_Number> |
| Application Server Host           | This is the host name of the relevant application server instance. To find out the host name, enter `hostname` at the command prompt of the host running the primary application server instance. |
| Communication User                | This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system. The default user name is **SAPJSF** |

**Note**  
If you are installing a SAP NetWeaver 7.5 Process Integration (PI) or a SAP Solution Manager 7.2 system, this user has been created during the installation of the SAP NetWeaver 7.5 PI application server ABAP.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator User</td>
<td>This is the name and password of the administrator user that you created on the external ABAP system.</td>
</tr>
<tr>
<td></td>
<td>The default user name is J2EE_ADMIN</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>If you are installing a SAP NetWeaver 7.5 Process Integration (PI) or an SAP Solution Manager 7.2 system, this user has been created during the installation of the Application Server ABAP.</td>
</tr>
<tr>
<td>Administrator Role</td>
<td>The role SAP_J2EE_ADMIN must exist on the external ABAP system.</td>
</tr>
<tr>
<td>Guest User</td>
<td>This is the name and password of the guest user that you created on the external ABAP system.</td>
</tr>
<tr>
<td></td>
<td>The guest user is a user for anonymous access.</td>
</tr>
<tr>
<td></td>
<td>The default user name is J2EE_GUEST</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>If you are installing a SAP NetWeaver 7.5 Process Integration (PI) or an SAP Solution Manager 7.2 system, this user has been created during the installation of the Application Server ABAP.</td>
</tr>
<tr>
<td>Guest Role</td>
<td>The role SAP_J2EE_GUEST must exist on the external ABAP system.</td>
</tr>
<tr>
<td>System Landscape Directory</td>
<td></td>
</tr>
<tr>
<td>SLD Destination for the System</td>
<td>The System Landscape Directory (SLD) registers the systems and the installed software of your entire system landscape.</td>
</tr>
<tr>
<td></td>
<td>You can choose between the following options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Register in existing SLD</strong></td>
</tr>
<tr>
<td></td>
<td>Choose this option to register the SAP system you are installing in an existing SAP System Landscape Directory (SLD) by specifying the SLD connection parameters listed below in this table.</td>
</tr>
<tr>
<td></td>
<td>- <strong>No SLD destination</strong></td>
</tr>
<tr>
<td></td>
<td>Choose this option if you do not want to register the SAP system you are installing in an existing SAP System Landscape Directory (SLD). You then have to configure the SLD destination manually after the installation has finished.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SLD Host</td>
<td>The host name of the existing SLD.</td>
</tr>
<tr>
<td>SLD HTTP(S) Port</td>
<td>HTTP port of the SAP system based on AS Java on which the System Landscape Directory (SLD) resides. The following naming convention applies: 5&lt;Primary_Application_Server_Instance_Number&gt;00.</td>
</tr>
<tr>
<td>SLD Data Supplier User and password</td>
<td>The existing SLD Data Supplier user and password of the existing SLD</td>
</tr>
</tbody>
</table>

### 3.7.2 SAP System Database Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database ID &lt;DBSID&gt;</td>
<td>The &lt;DBSID&gt; identifies the database instance. The installer prompts you for the &lt;DBSID&gt; when you are installing the database instance.</td>
</tr>
<tr>
<td></td>
<td>The &lt;DBSID&gt; can be the same as the &lt;SAPSID&gt;.</td>
</tr>
<tr>
<td></td>
<td><strong>⚠️ Caution</strong></td>
</tr>
<tr>
<td></td>
<td>Choose your database ID carefully. Renaming is difficult and requires you to reinstall the SAP system.</td>
</tr>
<tr>
<td></td>
<td>• If you want to install a new database:</td>
</tr>
<tr>
<td></td>
<td>• Make sure that your database ID:</td>
</tr>
<tr>
<td></td>
<td>• Is unique throughout your organization</td>
</tr>
<tr>
<td></td>
<td>• Consists of exactly three alphanumeric characters</td>
</tr>
<tr>
<td></td>
<td>• Contains only uppercase letters</td>
</tr>
<tr>
<td></td>
<td>• Has a letter for the first character</td>
</tr>
<tr>
<td></td>
<td>• Does not include any of the reserved IDs listed in SAP Note 1979280</td>
</tr>
<tr>
<td>Java Database User (SAPSR3DB)</td>
<td>The user name corresponds to the owner of the database tables.</td>
</tr>
<tr>
<td>Database user for database system administration (sapsa)</td>
<td>This is the default user for database monitoring and administration.</td>
</tr>
</tbody>
</table>
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database user for database system security tasks (sapsso)</td>
<td>This is the default user for security relevant tasks such as user creation and password setup.</td>
</tr>
</tbody>
</table>

### 3.7.3 Parameters for Additional Components to be Included in the SCS Instance (Optional)

You only need to specify the following parameters during the SCS instance installation if you perform an integrated installation of additional components.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install an SAP Web Dispatcher integrated in the SCS instance</td>
<td>When processing the screens for the ASCS instance installation, you are prompted to mark this checkbox on the screen Additional Components to be Included in the SCS Instance. If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters required for the SAP Web Dispatcher installation on the subsequent screens:</td>
</tr>
</tbody>
</table>

- **Message Server Host**
  The name of the host on which the message server is located (profile parameter rdisp/mshost)

- **Message Server HTTP Port**
  HTTP port of the message server (profile parameter ms/server_port_<xx>)

- **Password for the Internet Communication Management (ICM) user**
  In order to use the web administration interface for the Internet Communication Manager (ICM) and SAP Web Dispatcher, an administration user webadm is created by the installer. You have to assign a password for this user.

### Related Information

SCS Instance with Integrated SAP Web Dispatcher [page 25]
3.8 Setup of Database Layout

i Note
The following sections apply especially to the installation of a production system.

When you plan your SAP system installation, it is essential to consider the setup of your database layout with regard to the distribution of SAP directories or database file systems to disks. The distribution depends on your specific environment and you must take factors into consideration, such as storage consumption of the software components involved, safety requirements and expected workload.

Required File Systems for SAP ASE

To ensure that your SAP system performs well in a production environment, you have to define and control the distribution of the database directories to physical disks. You do this by creating separate file systems manually for the directories listed in the following table before you start the installer.

During the installation of your SAP system, you can specify the number and names of the sapdata and saplog directories. You can create additional sapdata and saplog directories before you start the installer.

The following table lists the file systems that are required by the SAP ASE database:

<table>
<thead>
<tr>
<th>File System / Logical Volume</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;drive&gt;\sybase&lt;DBSID&gt;</td>
<td>SAP ASE software ($SYBASE)</td>
</tr>
<tr>
<td></td>
<td>Size: at least 4 GB</td>
</tr>
<tr>
<td>&lt;drive&gt;\sybase&lt;DBSID&gt;\sybsystem</td>
<td>Location for devices master.dat, sybmgmtdb.dat, sybsysdb.dat, sysprocs.dat</td>
</tr>
<tr>
<td></td>
<td>Size: at least 1 GB</td>
</tr>
<tr>
<td>&lt;drive&gt;\sybase&lt;DBSID&gt;\sybtemp</td>
<td>Location for device tempdb</td>
</tr>
<tr>
<td></td>
<td>Size: at least 3 GB</td>
</tr>
<tr>
<td>&lt;drive&gt;\sybase&lt;DBSID&gt;\sapdiag</td>
<td>Location for devices containing the database saptools</td>
</tr>
<tr>
<td></td>
<td>Size: at least 3 GB</td>
</tr>
<tr>
<td>&lt;drive&gt;\sybase&lt;DBSID&gt;\sapdata_&lt;n&gt;</td>
<td>Location for devices containing data</td>
</tr>
<tr>
<td></td>
<td>For more information, see SAP Note 1748888</td>
</tr>
<tr>
<td>&lt;drive&gt;\sybase&lt;DBSID&gt;\saplog_&lt;n&gt;</td>
<td>Location for devices containing logs</td>
</tr>
<tr>
<td></td>
<td>For more information, see SAP Note 1748888</td>
</tr>
</tbody>
</table>
### File System / Logical Volume

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;drive&gt;:\sybase&lt;DBSID&gt;\sybsecurity</td>
</tr>
<tr>
<td>Location for devices containing the database sybsecurity</td>
</tr>
<tr>
<td>Size: at least 1 GB</td>
</tr>
</tbody>
</table>

For information about SAP file systems, see SAP Directories [page 175].

### 3.9 SAP System Transport Host

The transport host contains the transport directory used by the SAP transport system to store transport data and change SAP system information, such as software programs, write dictionary data, or customizing data. If you have several SAP systems it depends on your security requirements whether you want them to share a transport directory or whether you use separate directories.

When you install an SAP system, you have to decide which transport host and directory you want to use for your SAP system:

- Use the transport directory that the installer creates during the installation of the SAP system by default on the global host. The installer by default creates the transport directory on the global host in \usr\sap\trans.
- Use a transport directory located on a host other than the default host:
  - You can use an existing transport directory and host in your SAP system landscape.
  - You can set up a new transport directory on a different host.

In either case, you must prepare this host for use by the new SAP system [page 64].

### More Information

- SAP Directories [page 175]
4 Preparation

4.1 Preparation Checklist

This section includes the preparation steps that you have to perform for the following installation options:

- Standard, distributed, or high-availability system
- Additional application server instance

Detailed information about the steps are available in the linked sections.

Standard, Distributed, or High-Availability System

1. Windows Server 2008 (R2) or higher: you disable the Windows Server firewall [page 59] on each host.
2. You perform basic preparations on Windows [page 60].
3. You check that you have the required user authorization for running the installer [page 61].
4. If required, you prepare the SAP system transport host [page 64] for your SAP system.
5. If you need to configure the User Management Engine (UME) of Application Server Java for the user management of a separate ABAP system, you have to prepare user management for an external ABAP System [page 65].

Standard, Distributed, or High-Availability System

6. You check that the required installation media [page 67] are available for each installation host.

Optional standalone units are automatically configured during the installation to store the SAP system users in the Java database.

7. Only valid for “High Availability”: HA (Windows)
   To install a high-availability system with Microsoft Failover Clustering, you also perform the HA-specific preparation steps [page 145].

8. You continue with Installation [page 80].
Additional Application Server Instance

You have to perform the following preparations on the host where you install the additional application server instances:

1. Windows Server 2008 (R2) or higher: you disable the Windows Server firewall [page 59] on each host.
2. You perform basic preparations on Windows [page 60].
3. You check that you have the required user authorization for running the installer [page 61].
4. If required, you prepare the SAP system transport host [page 64].
5. You check that the required installation media [page 67] are available on each installation host.
6. You continue with Installation [page 80].

4.2 Disabling the Windows Server Firewall on Windows Server 2008 (R2) and Higher

Use

The Windows firewall – which is turned on by default as of Windows Server 2008 (R2) – is configured to allow only a small set of Windows-specific inbound IP connections. By default, outbound connections are not limited to rules and are therefore not restricted by the firewall.

The default firewall settings are valid for the out-of-the-box installation of Windows Server 2008 (R2) and higher. These settings apply to local policies. For domain policies that override local policies, other rules might apply.

To avoid any problems with non-configured TCP/IP ports that are used by the SAP system, you need to disable the firewall on all Windows hosts before you install the SAP system with the installer. We recommend that you secure network access to the SAP application servers with a real physical firewall or use a router Access Control List (ACL).

Procedure

Only valid for 'High Availability': HA (Windows)

i Note

In a high-availability system, you have to disable the firewall on all failover cluster nodes.

End of 'High Availability': HA (Windows)

- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  
  ```
  Set-NetFirewallProfile -enabled false
  ```

Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.3 to 7.5 on Windows: SAP Adaptive Server Enterprise
4.3 Performing Basic Windows Preparation Steps

Use

This section informs you about basic preparation steps that you have to perform before you install the SAP system, including the following:

- Checking the Windows file system
- Checking the Windows domain structure (domain installation only)
- Deciding whether you want to use organizational units (OUs) in the Windows domain (domain installation only)

Procedure

Checking the Windows File System

You need to check which Windows file system you are using on hosts where you want to install the SAP system.

As of Windows Server 2012 R2, you should use the Windows file system ReFs or NTFS. Older Windows Server versions must use NTFS.

\[\text{Note}\]

Do not install the SAP system on a FAT partition.

Perform the check as follows:

- Windows Server 2012 R2 and higher:
  1. Open PowerShell in elevated mode, and enter the following command:
     \[\text{get-volume}\]
  2. Check that the value \text{FileSystem} is ReFs or NTFS.
- Windows Server 2008 (R2) and Windows Server 2012:
  1. Open the Windows Explorer.
  2. Select the relevant disk.
  3. Choose \[\text{Properties} \rightarrow \text{General}\].
     - The system displays the type of file system in use.
  4. Check that the file system is NTFS.

Checking the Windows Domain Structure
For a domain installation, we recommend that you check that all SAP system hosts are members of a single Windows domain. We recommend this for all SAP system setups.

We assume that you are familiar with checking Windows domain structures. For more information, see the Windows documentation.

In Windows, you can implement either of the following domain models for the SAP system:

- **Extra domain**
  
  In this model, the SAP system is embedded in its own domain, which is specially defined for SAP. A second domain exists for the user accounts.
  
  In Windows, the SAP domain and user domain must be incorporated in a domain tree. In this tree, the user accounts must form the root domain and the SAP domain must be a child domain of this.

- **Single domain**
  
  In this model, the SAP system, and the user accounts are included in a single domain.

### Deciding Whether to Use Organizational Units (OUs) in the Windows Domain

For a domain installation, the installer needs to create certain OS users for SAP and database operations in the Windows domain, also called the “Active Directory” (AD). These users are created by default in the AD container "Users".

Depending on a customer’s AD landscape and security policy, there are certain restrictions on where to store users and groups in AD. Contact the administrator of your AD infrastructure to understand where to store all SAP and database-related domain users and domain groups.

The SAP installer offers to define an existing OU in AD to create all needed SAP and database users in this OU. There are many different scenarios and prerequisites concerning how to use OUs. For more information, see SAP Note 2247673, which explains these issues in detail and shows some examples of how to use them.

⚠️ **Caution**

The installer does **not** create OUs. The installer does **not** move existing domain users or groups. The installer does **not** delete existing users, groups, OUs, nor any other object in a Windows domain.

The only exception to this rule is the Uninstall option in SWPM.

### 4.4 Required User Authorization for Running the Installer

Although the installer automatically grants the rights required for the installation to the user account used for the installation, you have to check whether this account has the required authorization to perform the installation. The authorization required depends on whether you intend to perform a **domain** or **local**
installation. If necessary, you have to ask the system administrator to grant the account the necessary authorization before you start the installation. If you attempt the installation with an account that does not have the required authorization, the installation aborts.

This section informs you about the authorization required for a domain and a local installation.

**Procedure**

⚠️ **Caution**

Do not use the user `<sapsid>adm` for the installation of the SAP system.

**Domain Installation**

For a domain installation the account used for the installation needs to be a member of the local Administrators and the domain Admins group of the relevant domain. All machines in the system must belong to the same domain. In a domain installation, the user information is stored centrally on the domain controller and is accessible to all hosts in the system.

If the SAP system is to be distributed across more than one machine, SAP strongly recommends you to perform a domain installation to avoid authorization problems.

⚠️ **Caution**

- If you install a distributed system as a local installation, this can lead to authorization problems for the operating system users `<sapsid>adm` and SAPService `<SAPSID>`. It can also lead to problems with the transport directory, which is usually shared by several SAP systems. SAP does not support distributed SAP systems running with local user accounts.

- Only valid for ‘High Availability’: HA (Windows)
  In a high-availability configuration, you always have to perform a domain installation.

- For performance and security reasons, SAP does not support an SAP system installation on a domain controller.

- If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. However, the domain administrator has to prepare the system appropriately for you.

  For more information, see Performing a Domain Installation without being a Domain Administrator [page 180].

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain Admins group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the domain Admins group.

**Local Installation**

For a local installation the account used for the installation needs to be a member of the local Administrators group of the machine involved. In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.
If the SAP system is to run on a single machine, you can perform a local installation.

⚠️ Caution

Do not use the Windows built-in account Administrator or the renamed built-in account to install your SAP system. The built-in account only has restricted network access rights that are required by the installer. If you renamed the built-in account Administrator, do not create a new account named Administrator.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the local Administrators group.

Related Information

Performing a Domain Installation Without Being a Domain Administrator [page 180]

4.5 Using Virtual Host Names

You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to hide their physical network identities from each other. This can be useful when quickly moving SAP servers or complete server landscapes to alternative hardware since you do not need to reinstall or reconfigure.

Prerequisites

- Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.
- Make sure that you configured the Windows operating system properly to use virtual host names. For more information, see SAP Note 1564275.

Context

Only valid for 'High Availability': HA (Windows)

⚠️ Caution

High Availability only:

- Only use virtual host names if this is explicitly stated in the parts of this installation guide specific to high availability. Otherwise, use the physical host name.
**Do not** start the installer with the command line parameter SAPINST_USE_HOSTNAME=<virtual hostname> on failover cluster nodes.

End of 'High Availability': HA (Windows)

---

**Procedure**

1. Proceed as described in SAP Note 962955. Assign the required virtual host names to the instance to be installed by specifying them in the `<Instance_Name>` Host Name field of the `<Instance_Name>` Instance screen while running the installer.

   For more information, see the Virtual Host Name parameter description in SAP System Parameters [page 44].

2. To install a non-high-availability system, proceed as described in SAP Note 1564275.

---

### 4.6 Preparing the SAP System Transport Host

The transport host has a directory structure that is used by the SAP transport system to store transport data and metadata.

**Context**

When you install an SAP system, the installer by default creates the transport directory on the global host in `\usr\sap\trans`.

If you do not intend to use the directory structure of the system you are going to install, but want to use another new transport directory on another host, or an existing transport directory in your system landscape, you need to prepare that transport host:

- If the directory structure already exists, you must set up its security to allow the new system to write to it.
- If it does not yet exist, you must create the core directory structure and a share to export it for other computers as well as set the security on it.

**Procedure**

1. If the transport directory does not yet exist, do the following:
   a. Create the directory `\usr\sap\trans` on the host to be used as the transport host.
   b. Share the `usr\sap` directory on the transport host as SAPMNT and set the permission for Everyone to Full Control for this share.
This enables the installer to address the transport directory in the standard way as `\SAPTRANSHOST\SAPMNT\trans`.

2. Grant **Everyone** the permission **Full Control** for the transport directory.

⚠️ **Caution**

Remove the **Full Control to Everyone** permission after you have finished the installation and only grant **Full Control** on this directory to the `SAP_<SAPSID>_GlobalAdmin` groups of all the systems that are part of your transport infrastructure. The installer assigns the appropriate rights with the help of an additional `SAP_LocalAdmin` group. For more information, see Automatic Creation of Accounts and Groups [page 198].

## 4.7 Preparing an External ABAP System as Source for User Data

You can use an external ABAP system as the data source for user data for the Application Server Java of your SAP Java system to be installed. To do so, you configure the User Management Engine (UME) of the AS Java for the user management of this external ABAP system.

### Prerequisites

The ABAP system is based on at least SAP Web AS ABAP release 6.20 SP25.

### Context

**Note**

If you want to install an optional standalone unit - Advanced Adapter Engine (AAE), Advanced Adapter Engine Extended (AEX), or Process Integration and Orchestration (PI-CP) - you can skip this section because you are **not** prompted for UME Configuration. Optional standalone units are automatically configured during the installation to store the SAP system users in the Java database.

If you want to connect more than one Java system to the same ABAP system, you need to work out a concept for the communication, administrator, and guest users for each system.

**Note**

If you want to install the application server Java for an **SAP NetWeaver 7.5 Process Integration (PI)** system or for an **SAP Solution Manager 7.2** system, you must use the already installed Application Server ABAP (AS ABAP) as the data source for user data for the Application Server Java to be installed. In this case, the required users were already created during the installation of the Application Server ABAP and you are prompted to enter these users during the installation of the Application Server Java.
You can take one of the following approaches when using an external ABAP system as source for user data:

<table>
<thead>
<tr>
<th>Approach</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each Java system uses different users</td>
<td>No interdependencies between the connected engines</td>
<td>Initially more administration to create the users in the ABAP system</td>
</tr>
<tr>
<td>All Java systems use the same configuration</td>
<td>You create the users only once and enter the same information for every Java system that you install.</td>
<td>Interdependencies between the connected engines:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● If you change the password of any of the users on the ABAP system, this change affects all connected engines.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● If you change the administrator user’s password, you must also change the password in secure storage on all of the connected Java EE Engines.</td>
</tr>
</tbody>
</table>

→ Recommendation
For security reasons, we recommend the first approach.

The procedures below assume that you are using the first approach.

More Information
For more information about AS ABAP user management as data source, see the SAP Library at:

- **SAP Release and SAP Library Quick Link**
  - SAP NetWeaver AS for ABAP 7.51 innovation package: [https://help.sap.com/nw751abap](https://help.sap.com/nw751abap)
  - SAP NetWeaver AS for ABAP 7.52: [https://help.sap.com/nw752abap](https://help.sap.com/nw752abap)

- **SAP Library Path (Continued)**
  - [Application Help](#) > SAP NetWeaver Library: Function-Oriented View > Security > Identity Management > User Management of SAP NetWeaver AS for Java > Configuring User Management > UME Data Sources > User Management of Application Server ABAP as Data Source

Procedure

- The following procedures describe the activities you have to perform in the existing ABAP system and for the Java system to be installed.
- Perform the following steps in the existing ABAP system:
  a. Call transaction **PFCG** to do the following:
○ Check that the roles `SAP_BC_JSF_COMMUNICATION` and `SAP_BC_JSF_COMMUNICATION_RO` exist and make sure that their profiles are generated.

○ Check that the roles `SAP_J2EE_ADMIN`, `SAP_J2EE_GUEST`, and `SAP_BC_FP_ICF` exist. Neither role contains any ABAP permissions, so you do not need to generate any profiles.

b. Call transaction SU01 to do the following:

○ Create a new communication user and assign it to the role `SAP_BC_JSF_COMMUNICATION_RO`. We recommend that you do the following:
  ○ Name this user `SAPJSF`. You can use any password.
  ○ Assign this user the role `SAP_BC_JSF_COMMUNICATION_RO` for read-only (display) access to user data with Java tools. If you intend to maintain user data (that is, to change, create, or delete users) with Java tools, you need to assign the role `SAP_BC_JSF_COMMUNICATION` instead.
  ○ Assign this user the type `Communications` under `Logon data` to make sure that it can only be used for communication connections between systems and not as a dialog user.

○ Create a new administrator user for the J2EE engine and assign it to role `SAP_J2EE_ADMIN`. We recommend that you name this user `J2EE_ADM_<SAPSID_Java_System>`. You can use any password.

○ Create a new guest user for the J2EE engine and assign it to role `SAP_J2EE_GUEST`. We recommend that you name this user `J2EE_GST_<SAPSID_Java_System>`. You can use any password.

Since this user is only used for anonymous access to the system, we recommend you to deactivate the password and, if required, lock it after installation to prevent anyone from using it for explicit named logons.

c. Make sure that you change the initial passwords of these users and take the precautions described in the relevant SAP security guide before you start the installation of the Java system. You can find the security guide in the Security section of the product page for your SAP product at https://help.sap.com/.

- Perform the following steps in the Java System:
  
  a. Before the installation of the Java system, make sure that you have the correct user names and passwords of the users listed above for the separate ABAP system.
  
  b. During the installation of the Java system, make sure that you enter the correct users and passwords in the corresponding installer dialogs.

### 4.8 Preparing the Installation Media

This section describes how to prepare the installation media.

Installation media are available as follows:

- The Software Provisioning Manager 1.0 archive containing the installer
  
  You always have to download the latest version of the Software Provisioning Manager 1.0 archive.

  For more information, see Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 71].

- The media containing the software to be installed. These are the following:
  
  ○ Kernel media:
You can make them available in one of the following ways:

○ Download the specific kernel archives from the SAP Software Center - this is the recommended way.
○ Download the SAP kernel archives (SAR files) from the SAP Software Center. If you are performing an Installation Using a Stack Configuration File [page 30], you can directly download the artefacts (SAR archives) as specified in the Maintenance Plan.
○ Use the physical installation media as part of the installation package.
○ Download the complete kernel media from the SAP Software Center.

○ RDBMS and export media.

You can make them available in one of the following ways:

○ Use the physical installation media as part of the installation package.
○ Download the complete kernel media from the SAP Software Center.

For detailed information about how to obtain these media, see Media Required for the Installation - Listed by SAP System Instance [page 68].

Media Required for the Installation - Listed by SAP System Instance [page 68]

This section provides a list of the media required for the installation, listed by SAP system instance to be installed.

4.8.1 Media Required for the Installation - Listed by SAP System Instance

This section provides a list of the media required for the installation, listed by SAP system instance to be installed.

The signature of installation media is checked automatically by the installer during the Define Parameters phase while the Media Browser screens are processed (see also Running the Installer [page 84]). The installer only accepts media whose signature has been checked. For more information, see SAP Note 2393060.

For more information about which kernel version to use, see SAP Note 1680045. In addition, check the Product Availability Matrix at: http://support.sap.com/pam.

Proceed as follows to make the media available:

1. Identify the required media for your installation [page 21] as listed below.

   Every installation of an SAP system on SAP Adaptive Server Enterprise is Unicode.

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required Software Packages from Installation Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central services instance (SCS instance)</td>
<td>○ Software Provisioning Manager 1.0 archive</td>
</tr>
<tr>
<td></td>
<td>○ UC Kernel (folder K_&lt;Version&gt;<em>U</em>&lt;OS&gt;) where U means Unicode.</td>
</tr>
</tbody>
</table>
**SAP Instance Installation**

**Required Software Packages from Installation Media**

- **Database instance**
  - Software Provisioning Manager 1.0 archive
  - UC Kernel (folder \K<Version>_U<OS>) where \(U\) means Unicode.
  - Database software
  - **SAP Business Suite Java Applications only**: SAP Business Suite Java Content (folders \JAVA_*)

- **Enqueue Replication Server**
  - Software Provisioning Manager 1.0 archive
  - UC Kernel (folder \K<Version>_U<OS>) where \(U\) means Unicode.

- **Primary application server instance**
  - Software Provisioning Manager 1.0 archive
  - UC Kernel (folder \K<Version>_U<OS>) where \(U\) means Unicode.
  - SAP NetWeaver AS for Java Component (folders \JAVA_*)
  - **SAP Business Suite Java Applications only**: SAP Business Suite Java Content (folders \JAVA_*)
  - Database Client Software

- **Additional application server instance**
  - Software Provisioning Manager 1.0 archive
  - UC Kernel (folder \K<Version>_U<OS>) where \(U\) means Unicode.
  - SAP NetWeaver AS for Java Component (folders \JAVA_*)
  - **SAP Business Suite Java Applications only**: SAP Business Suite Java Content (folders \JAVA_*)
  - Database Client Software

---

**SAP Host Agent (Separate Installation Only)**

**SAP Instance Installation**

**Required Media**

- SAP Host Agent (separate installation only)
  - Software provisioning manager 1.0 archive

2. Make the installation media available on each installation host as follows:
   1. Download and unpack the latest version of Software Provisioning Manager as described in "Downloading and Extracting the Software Provisioning Manager 1.0 Archive" [page 71].
   2. Make the kernel media available.
      
      You can do this in one of the following ways:
      - Download the dedicated kernel archives - this is the recommended way.
      - For more information, see "Downloading SAP Kernel Archives (Archive-Based Installation)" [page 73].

---

**i Note**

If you are using a stack configuration file (see "Installation Using a Stack Configuration File" [page 30]), you have the installation media defined when generating the Landscape Plan. The media link provided in the Landscape Plan guides you to the location in the SAP Software Download Center at https://launchpad.support.sap.com/#/softwarecenter where you can download the installation media required for your SAP product, operating system and database.
Using the installer, you can also directly download the artefacts (SAR archives) as specified in the Maintenance Plan. For more information, see Downloading Software Packages for a Maintenance Planner Transaction [page 76].

- Use the physical kernel medium from the installation package. You can do this in one of the following ways:
  - Copy the required media folders directly to the installation hosts.
  - Mount the media on a central media server that can be accessed from the installation hosts.

⚠️ Caution

- If you copy the media to disk, make sure that the paths to the destination location of the copied media do not contain any blanks.
- If you perform a domain installation and do not want to copy the media but use network drives for mapping the installation media, make sure that the `<sapsid>adm` user has access to the UNC paths of the network drives. If the user does not yet exist, you have to create the user manually before you install the SAP system.

- Download the kernel medium from the Software Download Center. For more information, see Downloading Complete Installation Media [page 78].

ℹ️ Note

Even if you use the complete kernel media, the installer might prompt you during the provisioning process for additional archives (*.SAR files) due to special Patch Level (PL) requirements depending on categories such as the product, operating system, and database platform at the end of this section.

For example: The installer might require a certain PL of `<X>` of the `SAPEXEDB.SAR` (for DBTYPE `<Y>`), but this PL of the `SAPEXEDB.SAR` is not contained in the SAP kernel media. In this case you have to download the required PL from [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter) following the instructions in Downloading SAP Kernel Archives (Archive-Based Installation) [page 73].

ℹ️ Note

If you perform an additional application server installation, kernel archives - such as `SAPEXE<Version>.SAR`, `SAPEXEDB<Version>.SAR`, `IGSEX<Version>.SAR`, `igshelper<version>.sar`, `SAPJVM<Version>.SAR` - are only prompted if they cannot be retrieved from the primary application server instance or the SCS instance of the existing SAP system.

3. Make the RDBMS and export media available. You can do this in one of the following ways:
  - Copy the required media folders directly to the installation hosts.
  - Mount the media on a central media server that can be accessed from the installation hosts.

⚠️ Caution

- If you copy the media to disk, make sure that the paths to the destination location of the copied media do not contain any blanks.
If you perform a domain installation and do not want to copy the media but use network drives for mapping the installation media, make sure that the `<sapsid>`adm user has access to the UNC paths of the network drives.

If the user does not yet exist, you have to create the user manually before you install the SAP system.

Related Information

- Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 71]
- Downloading SAP Kernel Archives (Archive-Based Installation) [page 73]
- Downloading Software Packages for a Maintenance Planner Transaction [page 76]
- Downloading Complete Installation Media [page 78]

### 4.8.1.1 Downloading and Extracting the Software Provisioning Manager 1.0 Archive

You must always download and extract the Software Provisioning Manager 1.0 archive from the SAP Software Download Center because you must use the latest version.

**Procedure**

1. **Download the latest version of the Software Provisioning Manager 1.0 archive**
   
   ```
   SWPM10SP<Support_Package_Number>_<Version_Number>.SAR
   ```
   
   from:

   [https://support.sap.com/sitoolset](https://support.sap.com/sitoolset) ➔ System Provisioning ➔ Download Software Provisioning Manager

2. **Make sure that you use the latest version of the SAPCAR tool when manually extracting the Software Provisioning Manager archive.**

   **Note**

   An older SAPCAR version might extract archive files in a wrong way and this could prevent the installer from working consistently.

   Proceed as follows to get the latest version of SAPCAR:

   a. Go to [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter) ➔ SUPPORT PACKAGES & PATCHES ➔ By Category ➔ SAP TECHNOLOGY COMPONENTS ➔ SAPCAR

   b. Select the archive file for your operating system and download it to an empty directory.

   c. To check the validity of the downloaded executable, right-click the executable and choose Properties. On the Digital Signatures tab you can find information about the SAP signature with which the executable was signed.
d. Rename the executable to `sapcar.exe`.

For more information about SAPCAR, see SAP Note 212876.

3. Using the latest version of SAPCAR, you can verify the signature of the downloaded SWPM10SP<Support_Package_Number>_\<Version_Number>.SAR archive as follows:

a. Get the latest version of the SAPCRYPTOLIB archive to your installation host as follows:

1. Go to https://launchpad.support.sap.com/#/softwarecenter SUPPORT PACKAGES & PATCHES and search for “sapcryptolib”.
2. Select the archive file for your operating system and download it to the same directory where you have put the SAPCAR executable.
3. Use the following command to extract the SAPCRYPTOLIB archive to the same directory where you have put the SAPCAR executable:

   ```
   SAPCAR –xvf sapcryptolibp_84...sar –R <target directory>
   ```
4. Download the Certificate Revocation List from https://tcs.mysap.com/crl/crlbag.p7s and move it to the same directory.

b. Verify the signature of the downloaded SWPM10SP<Support_Package_Number>_\<Version_Number>.SAR archive by executing the following command:

   ```
   <Path to SAPCAR>\sapcar.exe -tvVf <Path to Download Directory> \SWPM10SP<Support_Package_Number>_\<Version_Number>.SAR -crl <file name of revocation list>
   ```

4. Unpack the Software Provisioning Manager archive to a local directory using the following command:

   ```
   <Path to SAPCAR>\sapcar.exe -xvf <Path to Download Directory> \SWPM10SP<Support_Package_Number>_\<Version_Number>.SAR -R <Path to Unpack Directory>
   ```

   **Note**
   Make sure that all users have read permissions for the directory where you want to unpack the installer.

   **Caution**
   Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not unpack it to the same folder as other installation media.
4.8.1.2 Downloading SAP Kernel Archives (Archive-Based Installation)

Instead of downloading the complete SAP kernel media, we recommend that you download the SAP kernel archives specifically required for your installation option. During the installation, you can either specify the path to each archive separately, or provide the path to a download basket with all downloaded archives.

**i Note**

If you are performing an installation using a stack configuration file, you can use the service Downloading Software Packages for a Maintenance Planner Transaction [page 76].

**Context**

The signature of installation archives is checked automatically by the installer [page 84] during the Define Parameters phase while processing the Software Package Browser screens. The installer only accepts archives whose signature has been checked. After scanning the archives and verifying the signature, an info file is written where you can find detailed information about matching and non-matching archive files. You can access this info file by choosing the info file link in the Archive Scanning Result section of the Software Package Browser screen. The info file contains only the results of the latest archive scan. For more information, see SAP Note 2393060.

**Procedure**

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 71].
2. Go to https://launchpad.support.sap.com/#/softwarecenter SUPPORT PACKAGES & PATCHES By Category
3. Choose the required software component, release, and technical stack:
   - If you want to install SAP S/4HANA <Release> Server, choose SAP APPLICATION COMPONENTS SAP S/4HANA SAP S/4HANA <Release> SAP S/4HANA SERVER
   - If you want to install SAP S/4HANA <Release> Java, choose SAP NetWeaver and complementary products SAP NETWEAVER SAP NETWEAVER 7.5 Application Server Java
   - If you want to install SAP NetWeaver Composition Environment 7.1 or 7.2, choose SAP NetWeaver and complementary products SAP NETWEAVER CE 7.1X <Release> Entry by Component
   - If you want to install an SAP NetWeaver Java system or optional standalone unit, choose SAP NetWeaver and complementary products SAP NetWeaver <Release> [For releases lower than 7.5: Entry by Component] Application Server Java
If you want to install an SAP Business Suite system based on SAP NetWeaver, choose [ SAP Application Components ] < SAP CRM | SAP ERP | SAP SCM | SAP SRM > < Release > < Entry by Component > < Java Product Instance >

4. Choose the required package:

**i Note**
If you perform an additional application server installation, kernel archives - such as SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR, IGSEXE<Version>.SAR, igshelper<version>.sar, SAPJVM<Version>.SAR - are only prompted if they cannot be retrieved from the primary application server instance or the SCS instance of the existing SAP system.

**⚠ Caution**
- Make sure that you always use the highest available patch level unless special patch levels are specified for the relevant package in SAP Note 1680045.
- Make sure that you always choose SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR of the same SAP kernel release and extension.

**Example**
- If SAPEXE<Version>.SAR is of version 7.49, then SAPEXEDB<Version>.SAR must also be of version 7.49.
- If SAPEXE<Version>.SAR is of version 7.45, then SAPEXEDB<Version>.SAR must also be of version 7.45.
- If SAPEXE<Version>.SAR is of version 7.42 EXT, then SAPEXEDB<Version>.SAR must also be of version 7.42 EXT.

- If you provide the archives in one download folder, and there is more than one version of the same archive available - for example SAPEXE<Version>.SAR - and these versions match the product-specific requirements, the installer selects one of these archive versions. If you want a specific archive version to be used, make sure that this is the only version available in the download folder. When running system provisioning in GUI mode, you can also check in the GUI which archive is being used. So even if there is more than one version of the same archive available in the download folder, you can select the exact archive version you want to use and enter the exact path to the required archive file.

- SAPEXE<Version>.SAR
  - [ SAP KERNEL <Version> <UC> ] < Operating System > # DATABASE INDEPENDENT
    - If you want to install an SAP system based on SAP NetWeaver 7.5, you can either choose 7.45 or 7.49 UNICODE for SAP KERNEL <Version>.
    - If you want to install an SAP system based on SAP NetWeaver 7.4, you can choose either 7.45 or 7.42 for SAP KERNEL <Version>.
    - If you want to install an SAP system based on SAP NetWeaver 7.3 EHP1 or lower, choose 7.21 EXT for SAP KERNEL <Version>.
  - SAPEXEDB<Version>.SAR
    - Choose the version corresponding to the SAPEXE<Version>.SAR from [ SAP KERNEL <Version> <UC> ] < Operating System > < DATABASE >.

Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.3 to 7.5 on Windows: SAP Adaptive Server Enterprise

Preparation
If you want to install an SAP system based on SAP NetWeaver 7.5, choose SAP IGS <7.45 or 7.49> # OS independent, depending on your SAPEXE<Version>.SAR version.

If you want to install an SAP system based on SAP NetWeaver 7.4 and your SAPEXE<Version>.SAR is of version <7.45 or 7.49>, then choose SAP IGS <7.45 or 7.49> # OS independent, depending on your SAPEXE<Version>.SAR version. Otherwise, choose SAP IGS 7.20_EXT # OS independent.

If you want to install an SAP system based on SAP NetWeaver 7.3 EHP1, choose SAP IGS 7.20 EXT # OS independent.

If you want to install an SAP system based on SAP NetWeaver 7.3 or lower and use SAP kernel 7.21_EXT, choose SAP IGS 7.20 # OS independent.

If you want to install an SAP system based on SAP NetWeaver 7.3 or lower and use SAP kernel 7.21, choose SAP IGS 7.20 # OS independent.

If you want to install an SAP system based on SAP NetWeaver 7.3 EHP1 or higher, choose SAP IGS HELPER # OS independent.

If you want to install an SAP system based on SAP NetWeaver 7.3 or lower, choose SAP IGS 7.20 # OS independent.

For SAPJVM<Version>.SAR:

If you want to install an SAP system based on SAP NetWeaver 7.5 or higher, choose SAP JVM 8.1.<Version> # Select Your Operating System.

If you want to install an SAP system based on SAP NetWeaver 7.4 or lower, choose SAP JVM 6.1.<Version> # Select Your Operating System.

If you want to install an SAP system based on SAP NetWeaver 7.3 EHP1 or lower - that is you have to use SAP kernel 7.21 - download the latest patch level of SAPCRYPTOLIB <Version>.SAR from the following path:

It is highly recommended that you always choose the highest SP version of the SAPHOSTAGENT<Version>.SAR archive.

The SAPHOSTAGENT<Version>.SAR archive is only prompted if there is either no SAP Host Agent available on the installation host or you specified during the Define Parameters phase that you want to upgrade an existing version of the SAP Host Agent already available on the installation host. In the latter case, you must specify a higher version of the SAPHOSTAGENT<Version>.SAR. Otherwise, the existing SAP Host Agent is not upgraded.
If you want to install Adobe Document Services, download the unlimited version of the JCE Jurisdiction Policy Files archive. For more information about where to download it, see SAP Note 1240081 (see also SAP System Parameters [page 44]).

Make the RDBMS and the export media available - either by using physical media as described in Media Required for the Installation - Listed by SAP System Instance [page 68] or by downloading them as described in Downloading Complete Installation Media [page 78].

Related Information

Downloading Software Packages for a Maintenance Planner Transaction [page 76]

4.8.1.3 Downloading Software Packages for a Maintenance Planner Transaction

Software Provisioning Manager (the installer) is now enabled to download all software packages that have been defined in a Maintenance Planner Transaction.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>This feature is only available if you perform an installation using a stack configuration file.</td>
</tr>
</tbody>
</table>

Prerequisites

Plan your new SAP system including the required Support Package level (applicable for SAP NetWeaver and S/4HANA) as available in the Maintenance Planner and run `sapinst SAPINST_STACK_XML=<stack configuration file>` in order to benefit from an automated installation process.

Procedure

1. Specify a download directory for the artifacts (SAP archives) to be downloaded.
2. Start the installer as described in Running the Installer [page 84].
4. Follow the instructions on the installer screens.
The installer prompts you for the following input parameters:

○ Maintenance Planner Transaction ID
You can find the Maintenance Planner Transaction ID by one of the following ways:
  ○ In the MP_Plan_<Transaction ID>_<Generation Date>_.pdf file which you can download during the Completed step in the Maintenance Planner by choosing the Download PDF button.
  ○ From the Transaction ID column in the list of transactions displayed in the Transactions panel in the maintenance planner.
  ○ From the parameter mopz-transaction-id in the stack configuration file
    MP_Stack_<Transaction ID>_<Generation Date>_.xml which you can download during the Download Files step in the Maintenance Planner by choosing the Download Stack XML button.

**i Note**
If you started the installer using a stack configuration file, the Maintenance Planner Transaction ID is only displayed.

○ Your S-User ID and password
You call Software Provisioning Manager with command line parameter

*SAPINST_STACK_XML=<Absolute_Path_to_Stack_XML_File>*

to get the Maintenance Planner Transaction ID extracted from the stack configuration file.
You must perform this option directly after creating the Maintenance Planner Transaction, because the contained download links usually expire soon.
Ensure the following for your S-User:
1. You have download permissions for all artifacts on [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter) to be able to download them.
2. Consider the SAP Support Portal and the SAP ONE Support Launchpad password policies. Your **password must be the same** for both of them. If the passwords are not the same, you will lock the S-User in the SAP Support Portal. The **password must meet all of the following requirements:**
   ○ Must be **exactly** eight characters long
   ○ Contains at least one upper-case letter (A-Z)
   ○ Contains at least one lower-case letter (a-z)
   ○ Contains at least one decimal digit (0-9)
   ○ Contains at least one of the following special characters: ! @ $ % / ( [ ] ) + - * = ? ' ~ # _ . , ; : < >
   ○ Must not start with ? or !
   ○ Must not contain any blanks
   ○ Must not begin with three identical characters
   ○ Must be different from the last five passwords you have already used
   ○ Only one password change is allowed per day

○ Location of download folder for the installation software packages to be downloaded

○ If you have a proxy configured in your network, provide the proxy host and port.

5. You get a list of all downloadable artifacts (SAP archives) as specified in the stack configuration file along with their file size.

You can still deselect downloadable artifacts (SAP archives) that you do not need to be downloaded.

6. Choose Next to start the download.
If you get a download error, this is the result of an unsuccessful network connection. Check your network connection and proxy configuration. If the download of some artifacts finishes without any error, but still with a status other than OK, you must do one of the following:

- Create an up-to-date Maintenance Plan and perform again the download of the files which were not downloaded successfully. In case of an error, the installer skips the download of the artifact (SAR archive) in question and continue with the next one in the list.
- Download the still missing files directly from the SAP Software Center at https://launchpad.support.sap.com/#/softwarecenter.

Results

You have downloaded the artifacts (SAP archives) required for your SAP system installation with Software Provisioning Manager (the installer) - corresponding to the archives listed in section Downloading SAP Kernel Archives (Archive-Based Installation) [page 73] - and for applying the required kernel and support packages using Software Update Manager (SUM) after the installation has completed.

**SAP BW/4HANA 1.0 SR1 only:** RDBMS and export media are not covered by this feature. You have to provide them either as physical media or download them from the SAP Software Center as described in Downloading Complete Installation Media [page 78].

### 4.8.1.4 Downloading Complete Installation Media

This section describes how you can download complete media from the SAP Software Download Center.

**Procedure**

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 71].
2. Create a download directory on the host where you want to run the installer.
3. You identify the required media as listed in Media Required for the Installation - Listed by SAP System Instance [page 68].
4. Identify alldownload objects that belong to one medium according to one of the following:

   **Note**

   Installation media might be split into several files. In this case, you have to reassemble the required files after the download.

   - Download path or location:
     - To download the complete kernel media, go to https://support.sap.com/slttoolset System Provisioning > Software Provisioning Manager 1.0 SP<Current Version> > Download Kernel.
releases delivered for SL Toolset ➤ SL TOOLSET 1.0 (INSTALLATIONS AND UPGRADES) ➤ KERNEL FOR INSTALLATION/SWPM

- To download all media required for your SAP product, you can use one of the following navigation paths:
  - https://launchpad.support.sap.com/#/softwarecenter ➤ INSTALLATIONS & UPGRADES ➤ By Category ➤ SAP NETWEAVER AND COMPLEMENTARY PRODUCTS ➤ <Product> ➤ <Product Release>

- Material number
  All download objects that are part of an installation medium have the same material number and an individual sequence number:
  <Material_Number>_<Sequence_Number>

  Example
  51031387_1
  51031387_2
  ...

- Title
  All objects that are part of an installation medium have the same title, such as
  <Solution><Media_Name><OS> or <Database>RDBMS<OS> for database media.

5. Download the objects to the download directory.
6. To correctly re-combine the media that are split into small parts, unpack all parts into the same directory.

In the unpacking directory, the system creates a subdirectory with a short text describing the medium and copies the data into it. The data is now all in the correct directory, the same as on the medium that was physically produced. For more information, see SAP Note 1258173.

⚠️ Caution

Make sure that you unpack each installation media to a separate folder. Do not unpack installation media to the same folder where you unpack the Software Provisioning Manager archive.

Do not unpack installation media to the same folder where you unpack the SAP kernel archives for archive-based installation.
5 Installation

5.1 Installation Checklist

This section includes the installation steps for the following:

- Standard system
- Distributed system
- High-availability system
- Additional application server instance

Detailed information about the steps are available in the linked sections.

**Note**
SAP ASE is installed silently as part of the installation of the respective SAP product. Do not install the database software separately prior to the SAP installation.

### Standard System

**Note**
In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. You check the prerequisites [page 82] and run the installer [page 84] to install the SAP system.
   
   **Note**
   In a standard system, all mandatory instances are installed on one host in one installation run.

2. You continue with Post-Installation [page 99].

### Distributed System

1. On the SCS instance host, you check the prerequisites [page 82] and run the installer [page 84] to install the central services instance.

   **Note**
   If you want to install an SCS instance with integrated SAP Web Dispatcher [page 25], you must choose the **Custom** parameter mode.
When processing the screens for the SCS instance installation, you are prompted to mark the corresponding checkbox on the screen *Additional Components to be Included in the SCS Instance*. If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters required for the SAP Web Dispatcher installation on the subsequent screens.

2. On the database instance host, you **check the prerequisites** [page 82] and **run the installer** [page 84] to install the database instance.

3. On the primary application server instance host, you **check the prerequisites** [page 82] and **run the installer** [page 84] to install the primary application server instance.

4. If required, you install 1 to <N> additional application server instances on the respective hosts, as described later in this section.

5. You continue with **Post-Installation** [page 99].

---

**High-Availability System**

1. To install a high-availability system with Microsoft Failover Clustering, you perform the **HA-specific installation steps** [page 145].

2. You continue with **Post-Installation** [page 99].

---

**Additional Application Server Instance**

You perform the following steps on each host where you install the additional application server instances.

1. You **check the prerequisites** [page 82] and **run the installer** [page 84] to install the additional application server instances.

   **Caution**

   In a high-availability system, you must install at least **one** additional application server instance.

2. You continue with **Post-Installation** [page 99].
5.2 Specifying the Initial Data Source of the User Management Engine

During the installation of your SAP system, you have to specify the initial data source of the User Management Engine (UME).

Prerequisites

You have planned how you want to configure user and access management for your SAP system to be installed as described in Planning User and Access Management [page 41].

Procedure

Using the Database of AS Java

You install your SAP system as described in this installation guide. During the installation, you specify the Java database as data source for the User Management Engine (UME) (see SAP System Parameters [page 44]).

During the installation, the SAP system is automatically configured to use the Java database as data source for the UME.

After the installation has finished, you can still change the user management configuration. For more information, see Configuring User Management [page 116].

Using an LDAP directory as Source for User Data

1. You install your SAP system as described in this installation guide.
2. Configure the user management of the newly installed SAP system to use an LDAP directory.
   For more information, see Configuring User Management [page 116].

5.3 Prerequisites for Running the Installer

Make sure you fulfil the following prerequisites before running the installer.

- For the SL Common GUI, make sure that the following web browser requirements are met:
  - You have one of the following supported browsers on the device where you want to run the SL Common GUI:
    - Google Chrome (recommended)
    - Mozilla Firefox
    - Microsoft Edge
    - Microsoft Internet Explorer 11 or higher.
  Always use the latest version of these web browsers.
If you copy the SL Common GUI URL manually in the browser window, make sure that you open a new
Web browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or
private browsing mode (Firefox). This is to prevent Web browser plugins and settings from interfering
with the SL Common GUI.

Caution

The installer uses a self-signed certificate, which is used temporarily only while the installer is running.
This certificate is not trusted by the browser unless it is imported manually by the user running the
installer. This behavior is intentionally designed in this way because - unlike ordinary public web servers
- the installer has different usage patterns. You must configure your browser do trust the self-issued
certificate of the installer after carefully performing the “thumbprint” verification described in Running
the Installer [page 84]. For more information about adding trusted certificates, see the
documentation of your browser.

For more information about the SL Common GUI, see Useful Information about the Installer [page 89].

- If you want to enable Internet Protocol Version 6 (IPv6), make sure that you set SAP_IPv6_ACTIVE=1
  in the environment of the user with the required authorization [page 61] to run the installer. While running the
  installer, this setting is then also added to the environment of the <sapsid>adm user.

Note

By applying this setting the SAP system administrator is responsible for configuring the IP version on
each host of the system landscape, before installing any additional instance to it.

You need at least 300 MB of free space in the installation directory for each installation option. In addition,
you need 300 MB free space for the installer executables. The installer creates an installation directory
sapinst_instdir, where it keeps its log files, and which is located directly in the %ProgramFiles%
directory. For more information, see Useful Information About the Installer [page 89].

- Make sure that you have defined the most important SAP system parameters as described in Basic
  Installation Parameters [page 43] before you start the installation.

Check that your installation host meets the requirements for the installation options that you want to
install. For more information, see Running the Prerequisite Checker [page 33].

- If you want to install an additional application server instance in an existing SAP system, make sure that:
  - The service definitions for the SAP start services are configured correctly and refer to the correct
    profile files.
  - There are no profile backup files with an underscore “_” in their profile name. If so, replace the “_” with
    a “.”.

Example

Rename <Drive>:\usr\sap\S14\SYS\profile\S14_J20_wsi6408_12 to <Drive>:\usr
\sap\S14\SYS\profile\S14_J20_wsi6408.12.

- Make sure that the following ports are not used by other processes:
  - Port 4237 is used by default as HTTPS port for communication between the installer and the SL
    Common GUI.
  - If this port cannot be used, you can assign a free port number by executing sapinst.exe with the
    following command line parameter:
    SAPINST_HTTPS_PORT=<Free Port Number>
Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer processing. The filled-out evaluation form is then sent to SAP using HTTPS. If this port cannot be used, you can assign a free port number by executing sapinst.exe with the following command line parameter:

```
SAPINST_HTTP_PORT=<Free Port Number>
```

- If you want to perform the installation in unattended mode, see SAP Note 2230669 which describes an improved procedure using inifile.params.

### 5.4 Running the Installer

This section describes how to run the installer.

#### Prerequisites

For more information, see Prerequisites for Running the Installer [page 82].

#### Context

The installer has a web browser-based GUI named “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short.

This procedure describes an installation where you run the installer and use the SL Common GUI, that is you can control the processing of the installer from a browser running on any device.

For more information about the SL Common GUI, see Useful Information About the Installer [page 89].

#### Procedure

1. Log on to the installation host using an account with the required user authorization to run the Installer [page 61].

   △ Caution
   
   Do not use an existing <sapsid>adm user.

   If your security policy requires that the person running the installer is not allowed to know administrator credentials on the installation host, you can specify another operating system user for authentication purposes. You do this using the SAPINST_REMOTE_ACCESS_USER parameter when starting sapinst.exe from the command line. You must confirm that the user is a trusted one. For more information, see SAP Note 1745524.
2. Make the installation media available. You must confirm that the user is a trusted one. For more information, see SAP Note

For more information, see Preparing the Installation Media [page 67].

>Note

Even if you use the complete SAP kernel media, the installer might prompt you during the provisioning process for additional archives (*.SAR files) due to special Patch Level (PL) requirements depending on categories such as the product, operating system, and database platform.

For example: The installer might require a certain PL of <X> of the SAPEXDB.SAR (for DBTYPE <Y>), but this PL of the SAPEXDB.SAR is not contained in the SAP kernel media. In this case you must download the required PL from https://launchpad.support.sap.com/#/softwarecenter following the instructions given in Downloading SAP Kernel Archives (Archive-Based Installation) [page 73].

3. Start the installer from the directory to which you unpacked the Software Provisioning Manager archive with the following command:

`sapinst.exe` (in a command prompt)

`.\sapinst.exe` (in PowerShell)

>Note

If you are using a stack configuration file (see Installation Using a Stack Configuration File (Optional) [page 30]), you must call sapinst.exe with command line parameter SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File>:

`sapinst.exe` SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File> (in a command prompt)

`.\sapinst.exe` SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File> (in PowerShell)

By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the sapinst executable with command line option

SAPINST_BROWSER=<Path to Browser Executable>, for example

SAPINST_BROWSER=firefox.exe.

>Note

If you need to assign a virtual host name to the instance to be installed and you do not want to assign it by entering it as a parameter using the installer screens (see SAP System Parameters [page 44]), you can alternatively assign it as follows:

1. Open a command prompt or PowerShell window in elevated mode and change to the directory to which you unpacked the Software Provisioning Manager archive.
2. Start the installer with the following command:

`sapinst.exe` SAPINST_USE_HOSTNAME=<Virtual_Host_Name> (in a command prompt)

`.\sapinst.exe` SAPINST_USE_HOSTNAME=<Virtual_Host_Name> (in PowerShell)

For more information, see Using Virtual Host Names [page 63].

4. The installer is starting up.

The installer now starts and waits for the connection with the SL Common GUI. If you have a supported web browser (see Prerequisites for Running the Installer [page 82]) installed on the host where you run the installer, the SL Common GUI starts automatically by displaying the Welcome screen.

If the SL Common GUI does not open automatically, you can find the URL you require to access the SL Common GUI at the bottom of the Program Starter window of the installer. You find the icon of the Program Starter window in the taskbar of your Windows host. Open a supported web browser and run the URL from there.

```
Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html
Logon users: [<users>]
```

i Note

If the host specified by <hostname> cannot be reached due to a special network configuration, proceed as follows:

1. Terminate the installer as described in Useful Information about the Installer [page 89].
2. Restart the installer from the command line with the SAPINST_GUI_HOSTNAME=<hostname> property.
   You can use a fully-qualified host name.

⚠️ Caution

After opening the browser URL, make sure that the URL in the browser starts with “https://” to avoid security risks such as SSL stripping.

Before you reach the Welcome screen, your browser warns you that the certificate of the sapinst process on this computer could not be verified.

Proceed as follows to avoid security risks such as a man-in-the-middle attack:

1. Click on the certificate area on the left hand side in the address bar of your browser, and view the certificate.
2. Open the certificate fingerprint or thumbprint, and compare all hexadecimal numbers to the ones displayed in the console output of the installer.
   Proceed as follows to get the certificate fingerprint or thumbprint from the server certificate printed in the installer console:
   1. Go to the sapinst_exe.xxxxx.xxxx directory in the temporary directory to which the installer has extracted itself:
      %userprofile%\.sapinst\%
   2. In the sapinst_exe.xxxxx.xxxx directory, execute the sapgenpse tool with the command line option get_my_name -p.
      As a result, you get the server fingerprint or thumbprint from the server certificate.
3. Accept the warning to inform your browser that it can trust this site, even if the certificate could not be verified.

The SL Common GUI opens in the browser by displaying the Welcome screen.
5. On the **Welcome** screen, choose the required option:
   - Perform preparations
     - Go to [Generic Options ➤ Database ➤ Preparations](#) and choose the required task.
     - To install SAP Host Agent separately, choose [Generic Options ➤ Database ➤ Preparations ➤ SAP Host Agent](#).
   - Install an SAP system or an optional standalone unit (Advanced Adapter Engine, Advanced Adapter Engine Extended, or Process Orchestration):
     - To install an SAP system based on SAP NetWeaver AS Java **from scratch**, choose [Product ➤ Database ➤ Installation ➤ Application Server Java ➤ System Variant](#).
     - To install the application server Java for an SAP Process Integration system based on SAP NetWeaver 7.5 **from scratch**, choose [SAP NetWeaver 7.5 ➤ Database ➤ Installation ➤ Application Server Java for SAP Process Integration ➤ System Variant](#).
     - To install the application server Java for an SAP Solution Manager 7.2 system **from scratch**, choose [SAP Solution Manager 7.2 ➤ Support_Release ➤ Installation ➤ Database ➤ SAP System ➤ Application Server Java ➤ System Variant](#).
     - To install an optional standalone unit **from scratch**, choose [SAP NetWeaver ➤ Release ➤ Installation ➤ Optional Standalone Units ➤ Advanced Adapter Engine | Advanced Adapter Engine Extended | Process Orchestration ➤ System Variant](#).
     - To install an SAP system based on SAP NetWeaver AS Java **as target system of a system copy**, choose [Product ➤ Database ➤ System Copy ➤ Target System ➤ System Variant ➤ Based on AS Java](#).
     - To install the application server Java for an SAP Process Integration system based on SAP NetWeaver 7.5 **as target system of a system copy**, choose [SAP NetWeaver 7.5 ➤ Database ➤ System Copy ➤ Target System ➤ System Variant ➤ Based on AS Java](#).
     - To install the application server Java for an SAP Solution Manager 7.2 system **as target system of a system copy**, choose [SAP Solution Manager 7.2 ➤ Support_Release ➤ System Copy ➤ Target System ➤ System Variant ➤ Based on AS Java](#).
     - To install an optional standalone unit **as target system of a system copy**, choose [SAP NetWeaver ➤ Release ➤ Database ➤ System Copy ➤ Target System ➤ System Variant ➤ Based on AS Java](#).
     - Install an additional application server instance, go to [Product ➤ Database ➤ Additional SAP System Instances ➤ Additional Application Server Instance](#).
   - Perform other tasks or install additional components
     - Go to [Generic Options ➤ Database](#) and choose the required task.

6. Choose **Next**.

**Note**

If there are errors during the self-extraction process of the installer, you can find the log file dev_selfex.out in the temporary directory.

7. If the installer prompts you to log off from your system, log off and log on again.
The installer restarts automatically.

8. Follow the instructions on the installer screens and enter the required parameters.

**Note**
To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field, and choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.

**Note**
If you want to install an SCS instance with integrated SAP Web Dispatcher [page 25], you must choose the Custom parameter mode.

When processing the screens for the SCS instance installation, you are prompted to mark the corresponding checkbox on the screen Additional Components to be Included in the SCS Instance.
If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters required for the SAP Web Dispatcher installation on the subsequent screens.

<table>
<thead>
<tr>
<th>Only valid for ‘High Availability’: HA (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>High Availability only:</strong> If you decide to install an SAP Web Dispatcher or a Gateway in the ASCS instance, note that a failure of the SAP Web Dispatcher or the Gateway causes failover of the ASCS instance to another cluster node. The failover cluster monitors all processes that are started by the SAP start service (sapstartsrv.exe). For an ASCS instance this is: msg_server.exe (message server), enserver.exe (enqueue server), gwrd.exe (Gateway), and sapwebdisp.exe (SAP Web Dispatcher). To prevent failover, see SAP Note 2375999.</td>
</tr>
</tbody>
</table>

**End of ‘High Availability’: HA (Windows)**

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The signature of installation media and installation archives is checked automatically during the Define Parameters phase while processing the Media Browser and - if you perform an archive-based installation - the Software Package Browser screens.</td>
</tr>
<tr>
<td>Note that this automatic check is only committed once and not repeated if you modify artifacts such as SAR archives or files on the media after the initial check has been done. This means that - if you modify artefacts later on either during the remaining Define Parameters phase or later on during the Execute Service phase - the signature is not checked again.</td>
</tr>
<tr>
<td>For more information, see SAP Note 2393060.</td>
</tr>
</tbody>
</table>

After you have entered all requested input parameters, the installer displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that the installer set by default. If required, you can revise the parameters before starting the installation.

9. To start the installation, choose Next.

The installer starts the installation and displays the progress of the installation. When the installation has finished, the installer shows the message: Execution of <Option_Name> has completed.
During the last restart of Application Server Java performed by the installer, the portal starts the processing and upload of the new portal archives. It takes approximately 15 to 90 minutes before the deployment is completed and the portal is launched.

Do not stop the installer or Application Server Java during this phase.

10. If required install an additional application server instance for a standard (central) or distributed system.
11. If you copied the installer software to your hard disk, you can delete these files when the installation has successfully completed.
12. For security reasons, we recommend that you delete the .sapinst directory within the home directory of the user with which you ran the installer:
   
   %userprofile%\sapinst\%

13. The installer log files contain IP addresses and User IDs such as the ID of your S-User. For security, data protection, and privacy-related reasons we strongly recommend that you delete these log files once you do not need them any longer.
   
   You find the installer log files in the sapinst_instdir directory. For more information, see Useful Information about the Installer [page 89].

### 5.5 Additional Information about the Installer

The following sections provide additional information about the installer.

- **Useful Information about the Installer** [page 89]
  
  This section contains some useful technical background information about the installer and the installer GUI.

- **How to Avoid Automatic Logoff by the Installer** [page 91]

- **Interrupted Processing of the Installer** [page 92]

  Here you find information about how to restart the installer if its processing has been interrupted.

- **Entries in the Services File Created by the Installer** [page 95]

- **Troubleshooting with the Installer** [page 96]

  This section tells you how to proceed when errors occur while the installer is running.

- **Using the Step State Editor (SAP Support Experts Only)** [page 97]

  This section describes how to use the Step State Editor available in the installer.

### 5.5.1 Useful Information about the Installer

This section contains some useful technical background information about the installer and the installer GUI.

- Software Provisioning Manager (the “installer” for short) has the web browser-based “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short.
The SL Common GUI uses the SAP UI Development Toolkit for HTML5 - also known as SAPUI5 - a client-side HTML5 rendering library based on JavaScript. The benefits of this new user interface technology for the user are:

- Zero footprint, since only a web browser is required on the client
- New controls and functionality, for example, view logs in web browser.

As of version 1.0 SP24 Patch Level (PL) 5, Software Provisioning Manager comes with a new look and feel of the SL Common GUI. For more information, see https://blogs.sap.com/2018/11/10/new-look-for-software-provisioning-manager/.

The SL Common GUI connects the web browser on a client with the `sapinst` executable - which is part of Software Provisioning Manager - running on the installation host using the standard protocol HTTPS.

For the SL Common GUI, the installer provides a pre-generated URL in the Program Starter window. If you have a supported web browser installed on the host where you run the installer, the SL Common GUI starts automatically.

By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the `sapinst` executable with command line option `SAPINST_BROWSER=<Path to Browser Executable>`, for example `SAPINST_BROWSER=firefox.exe`.

Alternatively you can open a supported web browser on any device and run the URL from there.

For more information about supported web browsers see Prerequisites for Running the Installer [page 82]. If you need to run the SL Common GUI in accessibility mode, apply the standard accessibility functions of your web browser.

- As soon as you have started the `sapinst.exe` executable, the installer creates a `.sapinst` directory underneath the `<Drive>:\Users\<User>` directory where it keeps its log files. `<User>` is the user which you used to start the installer.

After you have reached the Welcome screen and selected the relevant installer option for the SAP system or instance to be installed, the installer creates a directory `sapinst_instdir`, where it keeps its log files, and which is located directly in the `%ProgramFiles%` directory. If the installer is not able to create `sapinst_instdir` there, it tries to create `sapinst_instdir` in the directory defined by the `TEMP` environment variable.

All log files which have been stored so far in the `.sapinst` folder are moved to the `sapinst_instdir` directory as soon as the latter has been created.

> **Recommendation**

We recommend that you keep all installation directories until the system is completely and correctly installed.

- The installer extracts itself to a temporary directory (`TEMP`, `TMP`, `TMPDIR`, or `SystemRoot`). These executables are deleted after the installer has stopped running. Directories called `sapinst_exe.xxxxxx.xxxx` sometimes remain in the temporary directory after the installer has finished. You can safely delete them.

The temporary directory also contains the log file `dev_selfex.out` from the self-extraction process of the installer, which might be useful if an error occurs.

> **Caution**

If the installer cannot find a temporary directory, the installation terminates with the error `FCO-00058`.
5.5.2 How to Avoid Automatic Logoff by the Installer

When you install the SAP system, the installation tool checks whether the user account used for the installation has the required privileges and authorization.

For a domain installation, the account needs to be both a member of the local Administrators group and the domain Admins group. For a local installation, the account needs to be a member of the local group Administrators group.

In both cases, the user account must be authorized to do the following:

- Act as part of the operating system
- Adjust memory quotas for a process
- Replace a process level token

If the user account does not have these rights assigned, the installer assigns them and automatically logs the account off to activate them. To avoid the installer logging the account off, you can set these rights manually before you start the installation.

Procedure

You perform the following steps to assign these rights to the user account used for the installation.

⚠️ Caution

Be aware that domain policies override locally defined policies. This means that if you want to grant domain administrator rights to a user who belongs to the local Administrators group, make sure that you have also defined domain administrator rights for this user on domain level.

1. Windows Server 2012 (R2) and higher: Press Ctrl + Esc and choose Administrative Tools → Local Security Policy.
3. In the Local Security Settings window, choose Local Policies > User Rights Assignment.
4. Double-click the required right under Policy and choose Add User or Group.
5. In the Select Users and Groups window, choose the required user and choose Add.
   The selected user appears in the box below.
6. Confirm your entry and then repeat the steps for each remaining policy that the user requires for the installation.
7. Log off and log on again to apply the changes.

More Information

Required User Authorization for Running the Installer [page 61]

5.5.3 Interrupted Processing of the Installer

Here you find information about how to restart the installer if its processing has been interrupted.

Context

The processing of the installer might be interrupted for one of the following reasons:

- An error occurred during the Define Parameters or Execute phase:
  The installer does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description of the choices listed in the table below as well as a path to a log file that contains detailed information about the error.

- You interrupted the processing of the installer by choosing Cancel in the SL Common GUI.

⚠️ Caution

If you stop an option in the Execute phase, any system or component installed by this option is incomplete and not ready to be used. Any system or component uninstalled by this option is not completely uninstalled.
The following table describes the options in the dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retry</strong></td>
<td>The installer retries the installation from the point of failure without repeating any of the previous steps. This is possible because the installer records the installation progress in the keydb.xml file. We recommend that you view the entries in the log files, try to solve the problem, and then choose <strong>Retry</strong>. If the same or a different error occurs, the installer displays the same dialog box again.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>The installer stops the installation, closing the dialog box, the installer GUI, and the GUI server. The installer records the installation progress in the keydb.xml file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below.</td>
</tr>
<tr>
<td><strong>Continue</strong></td>
<td>The installer continues the installation from the current point.</td>
</tr>
<tr>
<td><strong>View Log</strong></td>
<td>Access installation log files.</td>
</tr>
</tbody>
</table>

The following procedure describes the steps to restart an installation, which you stopped by choosing **Stop**, or to continue an interrupted installation after an error situation.

**Procedure**

1. Log on to the installation host as a user with the required permissions as described in [Running the Installer](#) [page 84].
2. Make sure that the installation media are still available.
   For more information, see [Preparing the Installation Media](#) [page 67].
   → **Recommendation**
   Make the installation media available **locally**. For example, if you use remote file shares on other Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from media mounted with NFS might fail.
3. Make sure that the installation media are still available.
   For more information, see [Preparing the Installation Media](#) [page 67].
   → **Recommendation**
   Make the installation media available **locally**. For example, if you use remote file shares on other Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from media mounted with NFS might fail.
4. Restart the installer by double-clicking `sapinst.exe` from the directory to which you unpacked the Software Provisioning Manager archive.

   By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the `sapinst` executable with command line option

   `SAPINST_BROWSER=<Path to Browser Executable>`, for example

   `SAPINST_BROWSER=firefox.exe`.

5. The installer is restarting.

   The installer now starts and waits for the connection with the SL Common GUI. If you have a supported web browser (see Prerequisites for Running the Installer [page 82]) installed on the host where you run the installer, the SL Common GUI starts automatically by displaying the `Welcome` screen.

   If the SL Common GUI does not open automatically, you can find the URL you require to access the SL Common GUI at the bottom of the `Program Starter` window of the installer. You find the icon of the `Program Starter` window in the taskbar of your Windows host. Open a supported web browser and run the URL from there.

   `...`

   Open your browser and paste the following URL address to access the GUI

   `https://[<hostname>]:4237/sapinst/docs/index.html`

   Logon users: `[<users>]`

   `...`

   **Note**

   If the host specified by `<hostname>` cannot be reached due to a special network configuration, proceed as follows:

   1. Terminate the installer as described in Useful Information about the Installer [page 89].
   2. Restart the installer from the command line with the `SAPINST_GUI_HOSTNAME=<hostname>` property.

   You can use a fully-qualified host name.

   **Caution**

   After opening the browser URL, make sure that the URL in the browser starts with “https://” to avoid security risks such as SSL stripping.

   Before you reach the `Welcome` screen, your browser warns you that the certificate of the `sapinst` process on this computer could not be verified.

   Proceed as follows to avoid security risks such as a man-in-the-middle attack:

   1. Click on the certificate area on the left hand side in the address bar of your browser, and view the certificate.
   2. Open the certificate fingerprint or thumbprint, and compare all hexadecimal numbers to the ones displayed in the console output of the installer.

   Proceed as follows to get the certificate fingerprint or thumbprint from the server certificate printed in the installer console:

   1. Go to the `sapinst_exe.xxxxxx.xxxxx` directory in the temporary directory to which the installer has extracted itself:

      `%userprofile%\sapinst\`
2. In the `sapinst_exe.xxxxx.xxxx` directory, execute the `sapgenpse` tool with the command line option `get_my_name -p`.
   As a result, you get the server fingerprint or thumbprint from the server certificate.

3. Accept the warning to inform your browser that it can trust this site, even if the certificate could not be verified.

The SL Common GUI opens in the browser by displaying the *Welcome* screen.

6. From the tree structure on the *Welcome* screen, select the installation option that you want to continue and choose *Next*.

   The *What do you want to do?* screen appears.

7. On the *What do you want to do?* screen, decide between the following alternatives and continue with *Next*:

<table>
<thead>
<tr>
<th>Alternative</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Perform a new run</em></td>
<td>The installer does not continue the interrupted installation option. Instead, it moves the content of the old installer directory and all installer-specific files to a backup directory. Afterwards, you can no longer continue the old option. The following naming convention is used for the backup directory: log_&lt;Day&gt;_Month_Year_Hours_Minutes_Seconds</td>
</tr>
<tr>
<td><em>Note</em></td>
<td>All actions taken by the installation before you stopped it (such as creating directories or users) are not revoked.</td>
</tr>
<tr>
<td><em>Caution</em></td>
<td>The installer moves all the files and folders to a new log directory, even if these files and folders are owned by other users. If there are any processes currently running on these files and folders, they might no longer function properly.</td>
</tr>
</tbody>
</table>

   | Continue with the existing one | The installer continues the interrupted installation from the point of failure. |

5.5.4 Entries in the Services File Created by the Installer

After the installation has finished successfully, the installer has created the following entries for port names in `<Drive>:\WINDOWS\system32\drivers\etc\services`:

```
sapdp<Instance_Number> = 32<Instance_Number>/tcp
sapdp<Instance_Number>s = 47<Instance_Number>/tcp
```
sapgw<Instance_Number> = 33<Instance_Number>/tcp
sapgw<Instance_Number>s = 48<Instance_Number>/tcp

Note

- There is a port created for every possible instance number, regardless of which instance number you specified during the installation. For example, for sapgw<Instance_Number> = 33<Instance_Number>/tcp the following range of entries is created:
  sapgw00 = 3300/tcp
  sapgw01 = 3301/tcp
  sapgw02 = 3302/tcp
  [...]  
  sapgw98 = 3398/tcp
  sapgw99 = 3399/tcp

- If there is more than one entry for the same port number, this is not an error.

5.5.5 Troubleshooting with the Installer

This section tells you how to proceed when errors occur while the installer is running.

Context

If an error occurs, the installer:

- Stops processing
- Displays a dialog informing you about the error

Procedure

1. Check SAP Note 2393060 for known installer issues.
2. If an error occurs during the Define Parameters or the Execute Service phase, do one of the following:
   - Try to solve the problem:
     - To check the installer log files (sapinst.log and sapinst_dev.log) for errors, choose the LOG FILES tab.

Note

The LOG FILES tab is only available if you have selected on the Welcome screen the relevant installer option for the SAP product to be installed.

If you need to access the log files before you have done this selection, you can find the files in the .sapinst directory underneath the <Drive>:\Users\<User> directory, where <User> is the user that you used to start the installer.
5.5.6 Using the Step State Editor (SAP Support Experts Only)

This section describes how to use the Step State Editor available in the installer.

i Note

Only use the Step State Editor if the SAP Support requests you to do so, for example to resolve a customer incident.

Prerequisites

- SAP Support requests you to use the Step State Editor.
- Make sure that the host where you run the installer meets the requirements listed in Prerequisites for Running the Installer [page 82].

Procedure

1. Start the installer from the command line as described in Running the Installer [page 84] with the additional command line parameter `SAPINST_SET_STEPSTATE=true`.
2. Follow the instructions on the installer screens and fill in the parameters prompted during the Define Parameters phase until you reach the Parameter Summary screen.
3. Choose Next.

   The Step State Editor opens as an additional dialog. Within this dialog you see a list of all steps to be executed by the installer during the Execute Service phase. By default all steps are in an initial state. Underneath each step, you see the assigned installer component. For each step you have a Skip and a Break option.

   - Mark the checkbox in front of the Break option of the steps where you want the installer to pause.
   - Mark the checkbox in front of the Skip option of the steps which you want the installer to skip.
4. After you have marked all required steps with either the Break or the Skip option, choose OK on the Step State Editor dialog.

The installer starts processing the Execute Service phase and pauses one after another when reaching each step whose Break option you have marked. You can now choose one of the following:

- Choose OK to continue with this step.
- Choose Step State Editor to return to the Step State Editor and make changes, for example you can repeat the step by marking the checkbox in front of the Repeat option.
- Choose Cancel to abort the installer.

5. Continue until you have run through all the steps of the Execute Service phase of the installer.
6 Post-Installation

6.1 Post-Installation Checklist

This section includes the post-installation steps that you have to perform for the following:

- Standard, distributed, or high-availability system
- Additional application server instance

More detailed information about the steps are available in the linked sections.

Standard, Distributed, or High-Availability System

- Note
  In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. If required, you perform a full system backup [page 122] immediately after the installation has finished.
2. You check whether you can log on to the Application Server Java [page 100].
3. You install the SAP license [page 104].
4. You configure the remote connection to SAP support [page 107].
5. If required, you set up symbolic links for application servers [page 107].
6. For production systems it is highly recommended that you connect the system to SAP Solution Manager [page 109].
7. You apply the latest kernel and Support Packages [page 110].
8. You configure the Process Integration system after installation [page 111].

- Note
  This post-installation step is only relevant if you have installed an SAP NetWeaver 7.5 Process Integration (PI) system.

9. You ensure user security [page 117].
10. You run automated configuration [page 120].
11. If you have installed a non-central Advanced Adapter Engine as an optional standalone unit, you clear the SLD Data Cache [page 121].
12. You enable the database [page 121].
13. You perform a full system backup [page 122].
14. If you chose to install an integrated SAP Web Dispatcher within the SCS instance, you log on to the SAP Web Dispatcher Management Console [page 123]
15. If you chose to install an integrated SAP Web Dispatcher within the SCS instance, you configure the SAP Web Dispatcher [page 124]
16. You check the Master Guide for your SAP Business Suite application or SAP NetWeaver application (section Configuration of Systems and Follow-Up Activities) for additional implementation and configuration steps, such as language installation, monitoring, work processes, transports, SAP license, printers, system logs, and connectivity to system landscape directory (SLD).

Additional Application Server Instance

1. If required, you perform a full system backup [page 122] immediately after the installation has finished.
2. You check whether you can log on to the Application Server Java [page 100].
3. You ensure user security [page 117].
4. If required, you set up symbolic links for application servers [page 107].
5. You perform a full system backup [page 122].

6.2 Logging On to the Application Server Java

You need to check that you can log on to the Application Server Java with the appropriate administrator user, given in the table below.

Prerequisites

- The SAP system is up and running.
- For the Application Server Java of an SAP Process Integration (PI) 7.5 system or SAP Solution Manager 7.2 system, you must have configured the connection to the ABAP system.

Context

**i Note**

In a distributed or high-availability system, you check whether you can log on to every instance of the SAP system that you installed.

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>J2EE_ADMIN (default) or the name you gave this user during the installation process.</td>
</tr>
</tbody>
</table>

Java User in a Dual-Stack System (SAP Process Integration (PI) 7.5 system or SAP Solution Manager 7.2 system only)

Depending on your SAP system installation, the administrator user can either reside in the database of your Java system or in an external ABAP system.
Java Standalone User

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>The user that you created manually in the external ABAP system. The recommended name is J2EE_ADM_&lt;SAPSID_Java_System&gt;</td>
</tr>
</tbody>
</table>

You access AS Java with a URL using a web browser from your client machines. To log on to the application server Java, proceed as follows:

**Procedure**

1. Start a web browser and enter the following URL:
   
   ```
   http://<Hostname_of_AS_Java_Server>:5<Instance_Number>00
   ```

   **i Note**

   You must always enter a two-digit number for `<Instance_Number>`. For example, do **not** enter 1 but instead enter 01.

   **Example**

   If you installed SAP NetWeaver Application Server for Java on host saphost06 and the instance number of your SAP NetWeaver Application Server for Java is 04, enter the following URL:

   ```
   http://saphost06:50400
   ```

   The start page of the SAP NetWeaver Application Server for Java appears in the web browser.

2. Log on by pressing the link of any of the provided applications, for example **SAP NetWeaver Administrator** or **System Information**.

**Related Information**

Preparing an External ABAP System as Source for User Data [page 65]
6.3 Logging On to the SAP Enterprise Portal

You need to check that you can log on to the application server using the following standard users. This procedure applies when you have installed EP Core - Application Portal only and when you have installed it together with Enterprise Portal (EP).

Prerequisites

The SAP system is up and running.

Context

Java Standalone User

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>The user that you created manually in the external ABAP system. The recommended name is J2EE_ADM_&lt;SAPSID_Java_System&gt;</td>
</tr>
</tbody>
</table>

You access the SAP Enterprise Portal with a URL using a web browser from your client machines.

The default URL consists of the installation host name and the port on which the portal is listening. You can use the HTTP or HTTPS protocol. HTTPS is relevant if you are using Secure Sockets Layer (SSL) communication.

Procedure

1. Start a web browser and enter the following URL: `http://<Hostname_of_AS_Java_Server>:5<Instance_Number>00/irj`

   i Note

   You must always enter a two-digit number for `<Instance_Number>`. For example, do not enter 1 but instead enter 01.
6.4 Logging On to the Development Infrastructure

If you have installed Development Infrastructure (DI), you have to log on to the services of the Development Infrastructure to check whether the installation of the DI was successful.

Procedure

1. Start a web browser and enter the following URL:

   http://<Hostname_of_AS_Java_Server>:5<Instance_Number>00/devinf

   i Note

   You must always enter a 2-digit number for `<Instance_Number>`. For example, do **not** enter **1** but instead enter **01**.

   ❖ Example

   If you installed SAP NetWeaver Application Server for Java with DI on host saphost06 and the instance number of your SAP NetWeaver Application Server for Java is **04**, enter the following URL:

   http://saphost06:50400

2. Log on with the **NWDI_ADM** user.

   The start page *SAP NetWeaver Development Infrastructure* appears in the web browser.

   The following links appear:
   ○ Design Time Repository
   ○ Component Build Service
   ○ Change Management Service
   ○ System Landscape Directory

3. Log on to these services one after another by clicking the appropriate link:
   a. When you click Design Time Repository, the Design Time Repository page with the Repository Browser overview appears.
   b. When you click Component Build Service, the Component Build Service page with the CBS Buildspace Information appears.
c. When you click Change Management Service, the Change Management Service page with the CBS Buildspace Information appears.

d. When you click System Landscape Directory, you should see the System Landscape Directory start page.

**i Note**
The tables displayed on the pages might be empty. They are filled when you configure the development infrastructure either by running the Configuration Wizard or by configuring your system manually.

### 6.5 Providing Access to the SAP NetWeaver Administrator

To be able to log on the SAP NetWeaver Administrator, you must allow access to administration URLs of the NetWeaver Administrator in the Internet Communication Manager (ICM).

**Context**

Due to security restrictions, the SAP NetWeaver Administrator can only be accessed **locally** via http://<Hostname_of_AS_Java_Server>:5<Instance_Number>00/nwa after the installation has finished.

**Procedure**

Allow access to administration requests for the required network segments as described in SAP Note 1451753.

### 6.6 Installing the SAP License

You must install a **permanent** SAP license. When you install your SAP system, a **temporary** license is automatically installed.

**Context**

⚠️ **Caution**

Before the temporary license expires, you must apply for a permanent license key from SAP.
We recommend that you apply for a permanent license key as soon as possible after installing your system.

**High Availability only:** If you do a failover of the SAP SCS instance from one cluster node to another node, and you do not have a permanent license on this node, the generated temporary license is only valid for 30 minutes. Java application servers automatically shut down after 30 minutes of operation. To avoid this, apply a permanent license key as soon as possible.

**Note**

The license key is bound to the hardware key of the host where the message server is running.

**High Availability only:**

In a high-availability system with Microsoft Failover Clustering, the message server is part of the SCS instance that can run on a different cluster node. Therefore you must install the SAP license on both nodes.

You have to do failover from the first cluster node where the SCS instance is installed to the second cluster node. Use the hardware key of the second cluster node for the installation of the second SAP license.

For more information about SAP license keys and how to obtain them, see [http://support.sap.com/licensekey](http://support.sap.com/licensekey).

**Procedure**

Install the SAP license as described in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ SAP NetWeaver 7.3</td>
<td>➤ Application Help ➤ Function-Oriented View: English ➤ Solution Life Cycle Management ➤ SAP Licenses</td>
</tr>
<tr>
<td>○ SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>○ SAP NetWeaver 7.4</td>
<td></td>
</tr>
<tr>
<td>○ SAP NetWeaver 7.5</td>
<td></td>
</tr>
</tbody>
</table>
6.7 High Availability: Setting Up Licenses

You need to install a **permanent** license, which is determined by the hardware environment of the message server.

**Prerequisites**

The SAP system is up and running.

**Context**

SAP has implemented a license mechanism for switchover solutions and clustered environments. Your customer key is calculated on the basis of local information on the message server host. This is the host machine where the central services instance (SCS instance) runs.

To be able to perform a switchover, the **temporary** license that is installed automatically with the SCS instance is not sufficient. You first need to install a **permanent** license, which is determined by the hardware environment of the message server. Since SAP's high-availability (HA) solution stipulates two or more cluster nodes (host machines) where the message server is enabled to run, you have to order as many **license keys** [page 104] as you have cluster nodes.

When we receive confirmation from your vendor that you are implementing a switchover environment, we provide the required license keys for your system, one key for each machine.

**Procedure**

1. To find the hardware key of the primary host, run the SAP NetWeaver Administrator (NWA) on any application server instance and choose **Configuration Management** ➤ **Infrastructure Management** ➤ **Licenses**.
   
   The hardware key is displayed in the NWA.

2. Perform a switchover of the central services instance (SCS) to another node in the cluster and repeat the previous step.

   Repeat this for all remaining nodes in the cluster.

3. To obtain the two license keys, enter the hardware IDs for each cluster node, where message server is enabled to run: http://support.sap.com/licensekey

4. To import the files containing the two licenses to the primary cluster node, run the NWA on any application server instance and choose:

   **Configuration Management** ➤ **Infrastructure Management** ➤ **Licenses**

5. Perform a switchover of the central services instance (SCS) to another node in the cluster and repeat the previous step.
Repeat this for all remaining nodes in the cluster.

Results

The license is no longer a problem during switchover. This means you do not need to call saplicense in your switchover scripts.

6.8 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the Early Watch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP.

For more information, see SAP Support Portal at https://support.sap.com/remote-support.html.

6.9 Creating Symbolic Links on Windows Server 2008 (R2) and Higher for Application Servers

Use

As of Windows Server 2008 (R2) you can create symbolic links for additional application server instances to simplify their administration.

Only valid for 'High Availability': HA (Windows)

In a high-availability system, you can additionally create symbolic links for the primary application server instance.

End of 'High Availability': HA (Windows)

Symbolic links for application servers let you access from your local host the SYS directory that is located on the global host, without having to specify its UNC path. Instead you can browse, for example, in the Windows explorer on your local host to the SYS directory and its subdirectories on the global host.

Procedure

Windows Server 2012 (R2) and higher
To create symbolic links, perform the following steps:

1. Open a PowerShell command in elevated mode, and enter the following PowerShell command in a single line:

```
cmd /c mklink /d <localdisk>:\usr\sap\<SAPSID>\SYS \<sapglobalhost>\sapmnt\<SAPSID>\SYS
```

**iNote**
Enter a blank before `\<sapglobalhost>`.

2. If you use a central transport directory, you can also create the following link in PowerShell:

```
cmd /c mklink /d <localdisk>:\usr\sap\trans \<trans_dir_host>\sapmnt\trans
```

**iNote**
The transport directory host `<trans_dir_host>` and the `<sapglobalhost>` can be identical.

⚠️ **Caution**
The command `mklink` creates the link without checking whether the link target exists or is accessible. If the link does not work after you created it, make sure that it exists and check the accessibility of the UNC path.

**Windows Server 2008 (R2)**

To create symbolic links, perform the following steps:

1. In the **Start** menu, right-click on **Command Prompt** and choose **Run as administrator**.

2. Enter the following command in a single line:

```
mklink /d <localdisk>:\usr\sap\<SAPSID>\SYS \<sapglobalhost>\sapmnt\<SAPSID>\SYS
```

**iNote**
Enter a blank before `\<sapglobalhost>`.

3. If you use a central transport directory, you can also create the following link:

```
mklink /d <localdisk>:\usr\sap\trans \<trans_dir_host>\sapmnt\trans
```

**iNote**
The transport directory host `<trans_dir_host>` and the `<sapglobalhost>` can be identical.

⚠️ **Caution**
The command `mklink` creates the link without checking whether the link target exists or can be accessed. If the link does not work after you created it, make sure that it exists and check that the UNC path can be accessed.
6.10 Connecting the System to SAP Solution Manager

Here you find information about how to connect your newly installed SAP system to SAP Solution Manager.

Prerequisites

An SAP Solution Manager system must be available in your system landscape. For more information, see http://help.sap.com/solutionmanager.

Context

SAP Solution Manager gives you central access to tools, methods, and preconfigured content that you can use to evaluate and implement your solutions.

When your implementation is running, you can use SAP Solution Manager to manage, monitor, and update systems and business processes in your solution landscape, and also to set up and operate your own solution support.

Procedure

You connect a technical system to SAP Solution Manager by the following steps:

1. On the technical systems of your landscape, data suppliers are implemented, for example, with transaction RZ70 for Application Server ABAP and with Visual Administrator for Application Server Java.

   For more information, see the SAP Solution Manager Application Help:
   ○ If your SAP Solution Manager release is 7.1:
   ○ If your SAP Solution Manager release is 7.2:

2. The data suppliers send information about the hardware and installed software to a central System Landscape Directory (SLD). Updates are sent to the SLD as well.

   For more information, see the Planning Guide - System Landscape Directory in the SAP Community Network at System Landscape Directory (SLD) - Overview

3. From the SLD, this information is regularly synchronized with SAP Solution Manager where it is managed in the Landscape Management Database (LMDB).
For more information, see the SAP Solution Manager Application Help:

- If your SAP Solution Manager release is 7.1:
  
  
- If your SAP Solution Manager release is 7.2:
  

4. In the LMDB, you complete the information from the SLD manually.

For more information, see the SAP Solution Manager Application Help:

- If your SAP Solution Manager release is 7.1:
  
  
- If your SAP Solution Manager release is 7.2:
  
  Technical Infrastructures Landscape Management Database (LMDB) Managing Technical System Information

Next Steps

For more information, see the following pages in the SAP Community Network:

- System Landscape Directory (SLD) - Overview
- Documentation for Landscape Management Database - LMDB

6.11 Applying the Latest Kernel and Support Package Stacks

We strongly recommend that you apply the latest kernel and Support Package stacks before you start configuring your SAP system.

**Note**

If you are using a stack configuration file (see Installation Using a Stack Configuration File (Optional) (page 30)), you already downloaded the `stack.xml` file and the delta archives using the Maintenance Optimizer in your SAP Solution Manager. If you then already called the Software Update Manager (SUM) from the installer and applied the Support Package Stacks after the installation had finished, you can skip this section.
**Context**

**i Note**

If you have installed an SAP Solution Manager 7.2 system, you must apply at least Support Package Stack (SPS) 01. You cannot use SAP Solution Manager 7.2 with SPS 00.

**Procedure**

- Download and apply the latest Kernel and Support Package stacks using the Software Update Manager (SUM) as described in the documentation Updating SAP Systems Using Software Update Manager <Release> available at [https://support.sap.com/sltoolset](https://support.sap.com/sltoolset) System Maintenance ➔ Software Update Manager (SUM) scenarios ➔ Software Update/Upgrade with SUM <Release> ➔

- If you want to update the kernel manually, proceed as described below:
  - a. Log on as user `<sapsid>adm` to the hosts of the SAP system instances to be updated.
  - b. Download the latest kernel for your operating system and database platform as described in SAP Note 19466.
  - c. Back up the kernel directory that is specified by the profile parameter `DIR_CT_RUN`.
  - d. Extract the `SAR` files of the kernel Support Packages of the target SP level to a temporary directory using the `SAPCAR` tool.
  - e. Copy or move the extracted programs from the temporary directory to the local kernel directory.

**6.12 PI 7.5 Only: Configuring the Process Integration System After the Installation**

To configure your SAP Process Integration 7.5 (SAP PI 7.5) system after installation, execute the Central Technical Configuration (CTC) Wizard.

**Procedure**

To configure your SAP PI 7.5 system, execute the “SAP NetWeaver initial setup” CTC Wizard described in SAP Note 1309239.

**i Note**

The CTC Wizard automatically executes all required technical configuration steps.
For more details about all single configuration steps executed by the CTC Wizard and how to apply them manually, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.5</td>
<td><img src="http://help.sap.com/nw75" alt="Application Help" /></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td>Function-Oriented View: English</td>
</tr>
<tr>
<td></td>
<td>Process Integration</td>
</tr>
<tr>
<td></td>
<td>Configuring Process Integration After Installation</td>
</tr>
<tr>
<td></td>
<td>Configuring Process Integration (PI) Dual Usage</td>
</tr>
<tr>
<td></td>
<td>Type</td>
</tr>
<tr>
<td></td>
<td>Basic Configuration for SAP Process Integration (PI)</td>
</tr>
</tbody>
</table>

### 6.13 PI-PCK, PI-AF, PI-AEX, PI-CP Only: System Configuration After the Installation

The CTC Wizards or Functional Unit Configurations execute automatically all required technical configuration steps.

#### CTC Wizards or Functional Unit Configurations

SAP Note [1362909](http://help.sap.com/nw73) collects all notes that describe the CTC Wizards or Functional Unit Configurations, which must be executed in each of the following systems after the installation:

- Composition Environment (CE)
- Advanced Adapter Engine Extended (PI-AEX)
- Advanced Adapter Engine (PI-AF)
- Partner Connectivity Kit (PI-PCK)
- Process Orchestration (PI-CP)

#### SAP NetWeaver 7.30: Configuring the Partner Connectivity Kit (PI-PCK)

To configure your PI-PCK system after the installation, execute the “PI-PCK initial setup” CTC Wizard described in SAP Note [1319008](http://help.sap.com/nw73).

For more information about all single configuration steps executed by the CTC Wizard and how to apply them manually, see the SAP Library at:

Configuring the Adapter Engine (PI-AF)

To configure your PI-AF system after the installation execute “PI-AF initial setup” CTC Wizard described in SAP Note 1314855.

For more information about all single configuration steps executed by the CTC Wizard and how to apply them manually, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>● SAP NetWeaver Process Integration 7.1</td>
<td>Application Help ➤ SAP Library: English ➤ SAP NetWeaver Process Integration Library ➤ Administrator’s Guide ➤ Configuration of SAP NetWeaver ➤ Configuration of the Standalone Engines ➤ Configuring the Non-Central Advanced Adapter Engine ➤ Wizard-Based Basic Configuration</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwpi71">http://help.sap.com/nwpi71</a></td>
<td></td>
</tr>
<tr>
<td>● SAP NetWeaver Process Integration 7.1 Including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwpi711">http://help.sap.com/nwpi711</a></td>
<td></td>
</tr>
<tr>
<td>● SAP NetWeaver 7.3</td>
<td>If you want to connect PI-AF to a PI system:</td>
</tr>
<tr>
<td>If you want to connect PI-AF to a PI-AEX system:</td>
<td></td>
</tr>
<tr>
<td>SAP Release and SAP Library Quick Link</td>
<td>SAP Library Path (Continued)</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td>If you want to connect PI-AF to a PI system:</td>
</tr>
<tr>
<td></td>
<td>If you want to connect PI-AF to a PI-AEX or PI-CP system:</td>
</tr>
<tr>
<td></td>
<td>➤ Application Help ➤ Function-Oriented View: English ➤ Process Integration ➤ Configuring Process Integration After Installation ➤ Configuring Advanced Adapter Engine Extended (PI-AEX) ➤ Basic Configuration for SAP NetWeaver PI Advanced Adapter Engine Extended ➤ Configuring the Non-Central Advanced Adapter Engine (PI-AF) for AEX</td>
</tr>
<tr>
<td>SAP NetWeaver 7.4</td>
<td>If you want to connect PI-AF to a PI system:</td>
</tr>
<tr>
<td></td>
<td>If you want to connect PI-AF to a PI-AEX or PI-CP system:</td>
</tr>
<tr>
<td></td>
<td>➤ Application Help ➤ Function-Oriented View: English ➤ Process Integration ➤ Configuring Process Integration After Installation ➤ Configuring Advanced Adapter Engine Extended (PI-AEX) ➤ Basic Configuration for SAP PI Advanced Adapter Engine Extended ➤ Configuring the Non-Central Advanced Adapter Engine (PI-AF) for AEX</td>
</tr>
</tbody>
</table>
### SAP NetWeaver 7.5

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.5</td>
<td>If you want to connect <strong>PI-AF</strong> to a <strong>PI</strong> system:</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td>Choose from:</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Application Help" /> ➤ <strong>Function-Oriented View: English</strong> ➤ <strong>Process Integration</strong> ➤ <strong>Configuring Process Integration After Installation</strong> ➤ <strong>Configuring Process Integration (PI) Dual Usage Type</strong> ➤ <strong>Basic Configuration for SAP Process Integration (PI)</strong> ➤ <strong>Configuring the Non-Central Advanced Adapter Engine (PI-AF)</strong> ➤ <strong>Manual Configuration of Non-Central Advanced Adapter Engine (PI-AF)</strong></td>
</tr>
</tbody>
</table>

If you want to connect **PI-AF** to a **PI-AEX** or **PI-CP** system:

| ![Application Help](#) ➤ **Function-Oriented View: English** ➤ **Process Integration** ➤ **Configuring Process Integration After Installation** ➤ **Configuring Advanced Adapter Engine Extended (PI-AEX)** ➤ **Basic Configuration for SAP PI Advanced Adapter Engine Extended** ➤ **Configuring the Non-Central Advanced Adapter Engine (PI-AF) for AEX** |

### SAP NetWeaver 7.30 or Higher: Configuring the Advanced Adapter Engine Extended (PI-AEX)

To configure your **PI-AEX** system after the installation, execute the “**PI-AEX initial setup**” CTC Wizard described in SAP Note 1414465.

For more information about all single configuration steps executed by the CTC Wizard and how to apply them manually, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="SAP NetWeaver 7.3" /> ➤ <a href="http://help.sap.com/nw73">http://help.sap.com/nw73</a></td>
<td>Choose from:</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Application Help" /> ➤ <strong>Function-Oriented View: English</strong> ➤ <strong>Process Integration</strong> ➤ <strong>Configuring Process Integration (PI) After Installation</strong> ➤ <strong>Basic Configuration (CTC Wizard-Assisted and Manual)</strong> ➤ <strong>Basic Configuration for SAP NetWeaver PI Advanced Adapter Engine Extended</strong></td>
</tr>
</tbody>
</table>

---

Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.3 to 7.5 on Windows: SAP Adaptive Server Enterprise

Post-Installation  

PUBLIC  

115
SAP NetWeaver 7.30 Including Enhancement Package 1 and Higher: Configuring the Process Orchestration (PI-CP)

To configure your PI-CP system after the installation, execute the “PI-CP initial setup” CTC Wizard described in SAP Note 1548120.

For more information about all single configuration steps executed by the CTC Wizard and how to apply them manually, see the SAP Library at:

6.14 Configuring the User Management

After the installation has completed, configure the user management of your SAP system.

Procedure

During the installation of your SAP system, you specified one of the following initial data sources of the User Management Engine (UME) (for more information, see SAP System Parameters [page 44]):
  ○ Database of the Application Server Java
  ○ External ABAP system
After the installation of your SAP system has finished, you can still change the data source of the UME. The following changes of data source are supported:

- From the database of the Application Server Java to user management of an external ABAP system
- From the database of the Application Server Java to a directory service

⚠️ Caution
This is not valid for an Advanced Adapter Engine (AEX) installation.

For more information about changing the data source after installation and about related restrictions, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3</td>
<td>Application Help Function-Oriented View: English</td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td>Application Server Java Configuring User Management</td>
</tr>
<tr>
<td><a href="https://help.sap.com/nw731">https://help.sap.com/nw731</a></td>
<td>UME Data Sources</td>
</tr>
<tr>
<td>SAP NetWeaver 7.4</td>
<td></td>
</tr>
<tr>
<td><a href="https://help.sap.com/nw74">https://help.sap.com/nw74</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td><a href="https://help.sap.com/nw75">https://help.sap.com/nw75</a></td>
<td></td>
</tr>
</tbody>
</table>

### 6.15 Ensuring User Security

You need to ensure the security of the users that the installer created during the installation.

The tables below at the end of this section list the following users:

- Operating system users
- SAP system users

During the installation, the installer by default assigned the master password to all users created during the installation unless you specified other passwords.

→ **Recommendation**

In all cases, the user ID and password are encoded only when transported across the network. Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog and RFC.

⚠️ Caution

Make sure that you perform this procedure **before** the newly installed SAP system goes into production.

For the users listed below, take the precautions described in the relevant SAP security guide.
You can find the security guide in the Security section of the product page for your SAP product at https://help.sap.com/

Operating System and Database Users

After the installation, operating system users for SAP system, database, and SAP Host Agent are available as listed in the following table:

### Operating System Users

<table>
<thead>
<tr>
<th>User Type</th>
<th>User</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP system administrator</td>
<td>sapsidadm</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td>Database administrator</td>
<td>sydbsid</td>
<td>Database administrator</td>
</tr>
<tr>
<td>SAP service user</td>
<td>sapsid</td>
<td>SAP service user</td>
</tr>
</tbody>
</table>

### SAP Host Agent User

<table>
<thead>
<tr>
<th>User Type</th>
<th>User</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP Host Agent administrator is the user for central monitoring services. You do not need to change the password of this user after the installation. This user is for administration purposes only. You are not able to log on as sapadm as this user is locked.</td>
</tr>
</tbody>
</table>

SAP System Users

Depending on the UME (User Management Engine) configuration that you specified during the installation, the following UME users are available after the installation:

- If you have chosen option Use Java Database, UME users are stored in the database (Java UME) – see table Users Stored in the Java Database below. You can manage users and groups with the UME Web admin tool and the SAP NetWeaver Administrator only.

- If you have chosen option Use ABAP, UME users are stored in an external ABAP system (ABAP UME) – see table Users Stored in an External ABAP System below. For more information, see Preparing an External ABAP System as Source for User Data [page 65].
The following tables show these users together with recommendations on how you can ensure the security of these users:

### SAP System Users Stored in an External ABAP System

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server Java Admin-</td>
<td>The name that you gave this user when you created it manually in the external ABAP system (see Preparing an External ABAP System as Source for User Data [page 65])</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the AS Java Config Tool.</td>
</tr>
<tr>
<td>istrator</td>
<td></td>
<td>→ Recommendation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>We recommend that you use strong password and auditing policies for this user.</td>
</tr>
<tr>
<td>Application Server Java Guest</td>
<td>The name that you gave this user when you created it manually in the external ABAP system (see Preparing an External ABAP System as Source for User Data [page 65])</td>
<td>Lock this user for interactive logon.</td>
</tr>
<tr>
<td>Communication user for Applica-</td>
<td>The name that you gave this user when you created it manually in the external ABAP system (see Preparing an External ABAP System as Source for User Data [page 65])</td>
<td>Specify this user as a Communications user and not as a dialog user. This user exists in at least the SAP system client that you specified during the installation.</td>
</tr>
<tr>
<td>tion Server Java</td>
<td></td>
<td>→ Recommendation</td>
</tr>
</tbody>
</table>

### SAP System Users Stored in the Database

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>The name that you gave this user during the installation or the default name Administrator</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the AS Java Config Tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>→ Recommendation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>We recommend that you use strong password and auditing policies for this user.</td>
</tr>
<tr>
<td>Guest</td>
<td>The name that you gave this user during the installation or the default name Guest</td>
<td>This user is used for anonymous access. Lock this user for interactive logon.</td>
</tr>
</tbody>
</table>
6.16 Performing Automated Configuration

This section provides references to documentation about how to run automated configuration tasks for the initial configuration of SAP NetWeaver functional units.

⚠️ Caution

Do not use the functional unit configuration tool to configure functional units that have already been enabled after:

- Upgrade
- Update
- System copy

If you need to change the configuration of functional units that have already been enabled, then you must execute the configuration steps manually.

If you want to use a functional unit that has not previously been enabled, you can either use the functional unit configuration tool or execute the steps manually.

To initially configure an SAP NetWeaver functional unit, proceed as described in the SAP Library for the SAP NetWeaver release your application is based on:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3</td>
<td>Application Help</td>
</tr>
<tr>
<td><a href="https://help.sap.com/nw73">https://help.sap.com/nw73</a></td>
<td>SAP NetWeaver Library: Function-Oriented View</td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td>Solution Life Cycle Management</td>
</tr>
<tr>
<td>SAP NetWeaver 7.4</td>
<td>Configuration Wizard</td>
</tr>
<tr>
<td><a href="https://help.sap.com/nw74">https://help.sap.com/nw74</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.5</td>
<td></td>
</tr>
</tbody>
</table>
6.17 Clearing the SLD Data Cache after Installing a Non-central Advanced Adapter Engine (Optional Standalone Unit)

When you have installed a non-central Advanced Adapter Engine, you need to manually clear the SLD Data Cache in the Integration Builder to make it visible and selectable in the communication channels.

Procedure

1. After SAPinst has finished, open the Integration Builder of your PI system at http://<host>:<port>/dir/start/index.jsp and logon as a user with the ABAP role SAP_XI_CONFIGURATOR assigned.
2. In the Integration Builder, choose Environment.
3. From the drop-down list, choose Clear SLD Data Cache.

6.18 Enabling the Database

Use

After the SAP system installation, you must enable the database.

Procedure

⚠️ Caution

The DBA Cockpit is not available in a Java-only system. To monitor the ASE database of your Java stack, connect it to a DBA Cockpit of an ABAP system in your system landscape.

1. Make sure that the version of your database is still supported, and check if there are newer versions available. For more information, see SAP Notes 1554717 and 1590719.
2. You must enable the database for monitoring by setting up a DBA Cockpit Framework (DCF) after the SAP system installation. The DCF provides a time-based collection and evaluation of performance, configuration, and space-related data. In your SAP system, call transaction DBACOCKPIT to start the DBA Cockpit. Calling the DBA Cockpit automatically checks the existence of the DCF.

→ Recommendation

To make sure that the DCF was set up correctly, we recommend that you go to Configuration Data Collectors and Admin Procedures in the DBA Cockpit.
3. Apply the latest patches for the DBA Cockpit. For more information, see SAP Note 1558958.
4. Set up Automatic Table Maintenance in the DBA Cockpit. Read the article DBA Cockpit: Automatic Table Maintenance for SAP ASE (http://scn.sap.com/docs/DOC-15162).
5. Check SAP Note 1539124 to make sure that the database configuration for your SAP installation complies with SAP’s requirements and recommendations.
6. For systems with high load, refer to SAP Note 1722359.

6.19 Performing a Full System Backup

You must perform a full system backup, including the operating system disk, system state, and all other disks, after the configuration of your SAP system. If required, you can also perform a full system backup after the installation (recommended). In addition, we recommend you to regularly back up your database.

Prerequisites

- You are logged on as user <sapsid>adm.
- You have shut down the SAP system and database.

Procedure

For more information about backing up your SAP system on Windows, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3</td>
<td>Application Help</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw73">http://help.sap.com/nw73</a></td>
<td>Function-Oriented View: English</td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td>Solution Life Cycle Management</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw731">http://help.sap.com/nw731</a></td>
<td>Backup and Recovery</td>
</tr>
<tr>
<td>SAP NetWeaver 7.4</td>
<td>Backing Up and Restoring your SAP System on Windows</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw74">http://help.sap.com/nw74</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td></td>
</tr>
</tbody>
</table>

More Information:

6.20 Logging on to the SAP Web Dispatcher Management Console

This section describes how to log on to the SAP Web Dispatcher.

Context

Note

This step is only required if you chose to install an integrated SAP Web Dispatcher instance within the SCS instance.

You must log on to the SAP Web Dispatcher Management Console to do the following:

- Check whether the SAP Web Dispatcher was installed successfully,
- Change the password of the webadm user,
- Access monitoring and administration tools.

Procedure

1. Open a web browser.
2. Enter the following URL, depending on whether you use HTTP or HTTPS:
   
   http(s)://<Webdispatcher_Host>:<HTTP(S)_PORT>/sap/wdisp/admin/public/default.html

   Example


3. Log on as user webadm with the password that you entered during the input phase of the installation.
   
   The SAP Web Dispatcher Monitor screen appears.

4. We recommend that you change the password of webadm immediately after the installation for security reasons.

   For more information on how to change passwords of existing users using the Admin Handler, see the SAP Library at:

Related Information

SCS Instance with Integrated SAP Web Dispatcher [page 25]
6.21 SAP Web Dispatcher Configuration (Optional)

After installing SAP Web Dispatcher, you must configure it to be able to use it.

Note

This step is only required if you chose to install an integrated SAP Web Dispatcher instance within the SCS instance.

You can find the configuration information in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>• SAP NetWeaver 7.3</td>
<td>Application Help ➤ Function-Oriented View ➤ Application</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw73/">http://help.sap.com/nw73/</a></td>
<td>Server Infrastructure ➤ Components of SAP NetWeaver</td>
</tr>
<tr>
<td>• SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td>Application Server ➤ SAP Web Dispatcher</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw731/">http://help.sap.com/nw731/</a></td>
<td></td>
</tr>
<tr>
<td>• SAP NetWeaver 7.4</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw74/">http://help.sap.com/nw74/</a></td>
<td></td>
</tr>
<tr>
<td>• SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75/">http://help.sap.com/nw75/</a></td>
<td></td>
</tr>
</tbody>
</table>

Related Information

SCS Instance with Integrated SAP Web Dispatcher [page 25]
In the following chapters you will learn how to set up a disaster recovery solution using SAP ASE 15.7, the SAP Replication Server and the Disaster Recovery Agent Management utility.

⚠️ Caution

Carefully follow the instructions outlined in the following chapters. This is the only supported installation method to set up a disaster recovery solution with the SAP Replication Server!

This solution is not designed to support high availability, reporting, or other solutions that might be supported by replication tools.

In a typical replication scenario, the SAP system updates data on the primary database. Transactions are replicated automatically to the standby database by the replication software. In a failover scenario, the SAP application connections are switched to the standby database. Transactions generated on the standby database continue to be saved by the replication server until the primary database comes back online. Once the primary database returns to service, the saved standby database transactions are released and applied to the primary host. Both databases are resynchronized.

The figure below illustrates the replication architecture. It consists of the primary and the standby environments. The database and replication servers need to be run on the same hardware platform and operating system at both sites. The hosts can be virtual or physical machines, or a mix of both.
All components of a primary or standby environment can run on the same host (co-located environment). It is also possible to separate the database and the Replication Server (dis-located environment). The Replication Server and Disaster Recovery Agent must run on the same host.

⚠️ Caution

The installation and uninstallation processes of the Replication Server software require having the corresponding SAP system directory (\<SAPGLOBALHOST>\sapmnt) available on that host.

For more information, see SAP Directories [page 175].

Replication is set up to support a replication in both directions between the primary and the standby site, although only one direction is available at any one point in time. Two databases are replicated between the primary and the standby site:

- SAP application database
- SAP ASE master database

Initially, the SAP Business Suite product must be installed with the SAP ASE database on the primary site. The SAP Netweaver Application Server can be installed on the database host or a separate host. The standby database must be a copy of the database instance of the primary site. In case of a failover, the work processes of the SAP Netweaver Application Server will automatically reconnect to the standby database.

⚠️ Caution

Do not enable a replication environment if you are not familiar with the SAP Replication Server product. Particularly in outage situations, the database log of the primary database can run out of space and the SAP system could face downtime as a result. Stopping the replication in an inappropriate manner may require rematerialization of the standby database.

Read SAP Note 1891560 before you start the installation. This SAP Note contains the most recent information on the installation, as well as corrections to the installation documentation.

For more information, see the following guides:

- **Rolling Database Update in an SAP ASE and SAP Replication Server Environment**:
- **HADR Users Guide**:

### 7.2 Implementation Considerations

The standby database requires the same levels of protection and scheduled maintenance as the primary database. Periodic reorganizations, generation of statistics, and other housekeeping tasks are also required on the standby site. The standby site requires its own backup and recovery process. This includes disk-based file backup and recovery, as well as dump creation and archiving at database level.

As a result of the logical replication method, the standby database might need more device space than the primary site. Dump files from the primary host cannot be used for recovery of the standby site. Once replication begins, the physical attributes of the primary and standby databases are no longer equivalent and they cannot share the same dump and load files for recovery.
During replication, additional information is written to the database transaction log for each database. The transaction log volume will increase by 40 to 50%.

The master database will always be replicated. It is not possible to exclude it.

### 7.3 Prerequisites

The following prerequisites must be fulfilled before you set up a disaster recovery solution:

<table>
<thead>
<tr>
<th>Area</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Software</strong></td>
<td>SAP recommends to install the latest versions of SAP ASE and of the SAP Replication Server: For more information on the latest versions and the certified combinations of SAP ASE and SAP Replication Server, see SAP Note 1891560.</td>
</tr>
<tr>
<td><strong>Hardware</strong></td>
<td>Database and replication server must use the same hardware platform. SAP recommends installing the replication server on a separate host to keep the impact on the database as low as possible.</td>
</tr>
<tr>
<td><strong>ASE Server Names</strong></td>
<td>The SAP ASE server name is based on the $&lt;SID&gt;$ value and is the same on both primary and standby sites. The SAP database name is the same on both sites.</td>
</tr>
<tr>
<td><strong>Directories</strong></td>
<td>For an SAP installation, the replication environment must be installed in the following directory: <code>&lt;drive:&gt;</code>\sybase$&lt;SID&gt;_REP Reserve at least 6 GB free space for software and configuration files. The initial replication server partition file is placed in a folder at: <code>&lt;drive:&gt;</code>\sybase$&lt;SID&gt;_REP\repdata_1 You can specify another folder for placing replication server partition files during installation. This allows distribution of disk I/O to several disks. The initial size of the partition file should be at least factor 1.5 of the log size of the SAP application database. Reserve additional 2 GB for replication server usage in this folder.</td>
</tr>
</tbody>
</table>
| **TCP/IP ports**      | In addition to the ASE TCP/IP ports, the following ports are required for the replication environment:  
  - Replication server: 4905  
  - Replication server system database: 4906  
  - Replication server system database replication agent: 4907  
  - DR agent RMI: 4908  
  - DR agent: 4909  
  The values for the TCP/IP ports are default values. It is possible to customize the port numbers. The primary and the standby site can use the same port numbers. |
### Requirements:

<table>
<thead>
<tr>
<th>Area</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Time Synchronization</td>
<td>Both primary and standby databases must have the same UTC time. Otherwise the SAP application will not work properly, if the SAP system is using the standby database.</td>
</tr>
<tr>
<td>Database User</td>
<td>The following users are required on both sites:</td>
</tr>
<tr>
<td></td>
<td>• <code>sapsa</code></td>
</tr>
<tr>
<td></td>
<td>• <code>sapsso</code></td>
</tr>
<tr>
<td></td>
<td>• Replication user (<code>&lt;SID&gt;_maint</code>)</td>
</tr>
<tr>
<td></td>
<td>• DR agent administrator (<code>DR_admin</code>)</td>
</tr>
</tbody>
</table>

The `sapsa` and `sapsso` logins and their passwords must be identical across both databases. The replication user and the DR agent administrator are created by the SAP installer.

Be aware that the database user `DR_admin` is included in the secure storage of the SAP system, should you want to change the password.

| Operating system user            | The replication server and the DR agent are started with OS user `syb<dbsid>`. All operating system users and groups need to have the same user and group ID on all servers. |
|                                  | Windows services are set up for the replication server and the DR agent. The services are installed with the logon information of OS user `syb<dbsid>`. Whenever the password of OS user `syb<dbsid>` is changed, you also have to change the services accordingly. |

### 7.4 Installing the Replication Environment

Choose one of the following topologies and perform the appropriate installation steps to enable replication of an SAP system:

- Co-Located Replication Topology: PAS at the Primary Site [page 129]
- Co-Located Replication Topology: PAS on a Separate Server [page 130]
- Dis-Located Replication Topology: PAS on a Separate Server [page 132]

⚠️ **Caution**

- SRS is installed silently as part of the installation of the respective SAP product. Do not install the SRS separately.
- If you use virtual host names, choose parameter mode **Custom** during the installation. The installer will ask for the server names of SAP ASE and SRS. Enter the virtual host names not the physical host names. If the databases are located in different networks, specify the fully qualified DNS Domain Name (FQDN).
- The DR agent will tune the SRS memory parameters based on the Physical Memory value of the SRS. If the values need to be changed after the installation, run the DR_agent command `sap_tune_rs` again on both sites.
7.4.1 Co-Located Replication Topology: Central Instance at the Primary Site

The following replication topology shows a co-located scenario. The database and the SAP Replication Server are installed on the same server. In this scenario the Primary Application Server (PAS) is also installed on one of the database servers.

Prerequisites

You have installed an SAP application on SAP ASE. The Primary Application Server (PAS) and ASE 1 are installed on host 1 according to the SAP Installation Guide.

Installation Steps

Proceed as follows to install an additional replication environment to ensure high availability:

- Step 1: Install the SAP Replication Server software on host 1.
- Step 2: Install the secondary ASE database and SAP Replication Server on host 2. Configure the replication environment on host 2.
Step 1: Install the SAP Replication Server software on host 1.

1. Run the installer with the following option: \textbf{SAP NetWeaver <Version> \rightarrow SAP ASE \rightarrow Database Replication Setup of Replication Environment}.
2. Follow the instructions in the installation dialog. Select the following options:
   1. Select \textit{Install the replication server software}.
   2. Finish the installation process.

Step 2: Install the secondary ASE database and SAP Replication Server on host 2. Configure the replication environment on host 2.

1. Run the installer with the following option: \textbf{SAP NetWeaver <Release> \rightarrow SAP ASE \rightarrow Database Replication Setup of Replication Environment}.
2. Follow the instructions in the installation dialog. Select the following options:
   \begin{itemize}
   \item \textit{Set up a secondary database instance}
   \item \textit{Install the replication server software}
   \item \textit{Configure the replication system}
   \item \textit{Materialize the secondary databases}
   \end{itemize}
   Select the desired materialization method.
   The materialization step performs the initial copy of database content from one site to the other. Once completed, the replication software will maintain the data integrity of the target site by continuously applying changes that occur after completion of the materialization process. The procedure for materialization is dependent on the type and size of the database being materialized (see section \textit{Materializing Databases}). The installer provides user interaction points that are used to synchronize the replication environment with the end user’s manual dump and load activities.
3. Finish the installation process.

7.4.2 Co-Located Replication Topology: PAS on a Separate Server

The following replication topology shows a co-located scenario. The database and the SAP Replication Server are installed on one server. The Primary Application Server (PAS) is installed on a separate server.
Co-Located Replication Topology: PAS on a Separate Server

**Prerequisites**

You have installed an SAP application on SAP ASE. The Primary Application Server (PAS) and ASE 1 are installed on host 1 according to the SAP Installation Guide.

SAP system folder (`\sapmnt\<SID>` of host 3) is mapped on host 1.

The SAP central instance and the application server are installed on host 3.

ASE 1 is installed as a distributed database instance on host 1.

**Installation Steps**

The following procedure describes the installation steps for a replication environment to ensure high availability. Standard inquiries for the software location and the password need to be filled out as well.

- Step 1: Install the SAP Replication Server software on host 1.
- Step 2: Install the secondary ASE database and SAP Replication Server on host 2. Configure the replication environment on host 2.
Step 1: Install the SAP Replication Server software on host 1.

1. Run the installer with the following option: SAP NetWeaver <Release> ➤ SAP ASE ➤ Database Replication ➤ Setup of Replication Environment ➤.
2. Follow the instructions in the installation dialog. Select the following options:
   1. Select Install the Replication Server software.
   2. Finish the installation process.

Step 2: Install the secondary ASE database and SAP Replication Server on host 2. Configure the replication environment on host 2.

1. Run the installer with the following option: SAP NetWeaver <Release> ➤ SAP ASE ➤ Database Replication ➤ Setup of Replication Environment ➤.
2. Follow the instructions in the installation dialog. Select the following options:
   ○ Set up a secondary database instance
   ○ Install the replication server software
   ○ Configure the replication system
   ○ Materialize the secondary databases
     Select the desired materialization method.
     The materialization step performs the initial copy of database content from one site to the other. Once completed, the replication software will maintain the data integrity of the target site by continuously applying changes that occur after completion of the materialization process.
     The procedure for materialization is dependent on the type and size of the database being materialized (see section Materializing Databases).
     The installer provides user interaction points that are used to synchronize the replication environment with the end user’s manual dump and load activities.
3. Finish the installation process.

7.4.3 Dislocated Replication Topology: Central Instance on a Separate Server

The following replication topology shows a dislocated scenario. The database, the SAP Replication Server, and the Primary Application Server (PAS) are installed on separate hosts.
Prerequisites:

- You have installed an SAP application on SAP ASE. You want to install an additional replication environment to ensure high availability.
- SAP system folder (`\sapmnt\<SID>`) of host 3 is mapped on host 1.
- The SAP central instance and the application server are installed on host 5.
- ASE 1 is installed as a distributed database instance on host 1.

Installation Steps

The following procedure describes the installation steps for a replication environment to ensure high availability. Standard inquiries for the software location and the password need to be filled out as well.

- Step 1: Install the SAP Replication Server software on host 3.
- Step 2: Install the secondary ASE database on host 2.
- Step 3: Install the SAP Replication Server and configure the replication environment on host 4.

Step 1: Install the SAP Replication Server software on host 3.

Procedure:

1. Run the installer with the following option: `SAP NetWeaver <Release> SAP ASE Database Replication Setup of Replication Environment`.
2. Follow the instructions in the installation dialog.
   Select the following option:
   *Install the replication server software*

   Finish the installation process.

**Step 2: Install the secondary ASE database on host 2.**

Procedure:

1. Run the installer with the following option:
   - [SAP NetWeaver <Release>] > [SAP ASE] > [Database Replication]
   > [Setup of Replication Environment].

2. Follow the instructions in the installation dialog using the installation option *Custom*.
   Select the following option:
   *Set up a secondary database instance*

   Finish the installation process.

**Step 3: Install the SAP Replication Server. Configure the replication environment on host 4.**

1. Run the installer with the following option:
   - [SAP NetWeaver <Release>] > [SAP ASE] > [Database Replication]
   > [Setup of Replication Environment].

2. Follow the instructions in the installation dialog. Select the following options:
   - *Install the replication server software*
   - *Configure the replication system*
   - *Materialize the secondary databases*

   Select the desired materialization method.

   The materialization step performs the initial copy of database content from one site to the other. Once completed, the replication software will maintain the data integrity of the target site by continuously applying changes that occur after completion of the materialization process.

   The procedure for materialization is dependent on the type and size of the database being materialized (see section *Materializing Databases*).

   The installer provides user interaction points that are used to synchronize the replication environment with the end user’s manual dump and load activities.

3. Finish the installation process.

**7.4.4 Materializing Databases**

This section describes how to materialize the following databases:

- Master database
- SAP database
Materialize the Master Database

Some information in the master database is site-specific. The only master database changes that are replicated are logins and roles for synchronizing users and credentials between the two sites. The DR agent facilitates materialization of the master database providing an automated materialization function.

The SAP installer materializes the master database automatically.

Materialize the SAP Database

The SAP installer, by default, offers automatic database materialization through database dump and load. This is the easiest method to materialize the SAP application database on the standby site. In this case, the installer will execute the `dump database` and `load database` commands without the interaction of a database administrator. Large databases may not fit for automatic materialization. Their size requires timing and control that is best left to the attention of the administrator. Therefore it is also possible to perform a customized database materialization. The SAP installer provides user interaction points that are used to synchronize the replication environment with the end user's manual database actions.

To guarantee recoverability, read SAP Note 1585981.

7.4.4.1 Manual Materialization

The following methods are available:

- Using Single Database Dump and Load
- Using Database and Transaction Dump and Load
- Using Snapshot Materialization

Using Single Database Dump and Load

If the database is small enough to support materialization using a single database dump file, the sequence for performing this process is as follows:

1. The installer stops for manual loading of the standby database. The primary database contains the necessary replication markers at this time.
2. Dump the database using the command `dump database` in the primary database server.
3. Copy the dump file to the standby site. You can use shared storage or FTP to make a copy of the dump file available at the standby site.
4. Load the SAP database using the ASE command `load database` in the standby database server.
5. Bring the standby database online using the command `online database` to make the database available for use in the standby system.
6. Confirm the installer dialog. The database will be checked for the dump marker.
Using Database and Transaction Dump and Load

For large databases, it may be impractical to create a new dump of the entire database. Or the time required to
dump the database might create a backlog of hours or days that replication would need to apply in order to get
back in sync. To facilitate materialization for large databases, the dump can be done in advance and transferred
to the target side before the replication is started. Using this method, which includes transaction dumps,
means that the replication delay and backlog are kept to a minimum.

The key difference in this technique is that the SAP installer is not involved until just before the last transaction
dump is to be created. This allows the replication products to only address activity that occurs after the last
transaction dump.

The sequence for performing materialization using transaction dump and load is as follows:

1. Dump the database on the primary database server. This can be a new dump or an existing dump if your
   system is already configured to perform periodic dumps of the entire database. If you are creating a new
dump, use the ASE command `dump database` in the primary database server to create a dump of the
   entire database. Transfer the database dump to the standby site.
2. Install the SAP Replication Server software and perform the configuration on the primary site just before
   you intent to do the last transaction dump/load.
3. The installer stops for manual loading of the standby database. The primary database now contains the
   necessary replication markers.

   **Note**
   Make sure that there is no automatic `dump database` or `dump transaction` enabled at that time.
   Once you start the installer on the primary site to install and configure the replication server no
   automatic/manual dump should occur.

4. Load the database on the standby database server. Use the ASE command `load database` in the
   standby database server to load the dump.
5. Apply the necessary transaction log dumps to the standby database with the ASE command `load
   transaction`.
6. Dump the final transaction log of the SAP database which contains the replication marker. Use the ASE
   command `dump transaction` in the primary database server to create the last dump of the ASE
   transaction log.
7. Load the last transaction log dump.
8. Bring the standby database online using the ASE command `online database` to make the database
   available for use.
9. Confirm the installer dialog. The database will be checked for the dump marker.

Using Snapshot Materialization

It is possible to materialize the standby database by using a snapshot of the primary database files with the
help of a hardware mirroring product.

The sequence for performing materialization using database device files is as follows:

1. The installer stops for manual materialization of the standby database. The primary database contains the
   necessary replication markers at this time.
2. Quiesce the primary database.
   Use the ASE command `quiesce database` to freeze the database by suspending all disk write activities.

3. Generate a snapshot of the database files. The action to be performed depends on the hardware mirror product you are using. You could also just copy the files, use shared storage or FTP to make a copy of the dump file available at the standby site.

4. Unquiesce the primary database.
   Use the ASE command `quiesce database ... release` to enable disk write activities on the primary database again.

5. Load the standby database with the snapshot files.
   Use the ASE command `mount database` in the standby database to mount the database content.

6. Bring the database online using the ASE command `online database` in the standby database server to make the database available for use.

7. Confirm the installer dialog. The database will be checked for the dump marker.

### 7.5 Starting and Stopping the DR Agent and the Replication Server

To be able to stop and start the DR agent and the replication server, you must have the credentials of OS user `syb<dbsid>`.

**i Note**

ASE, the DR agent and the replication server can also be started and stopped using `startdb, stopbd, sapdbctrl, or saphostctrl`. For more information, see SAP Note 1899185: "SAP ASE and SAP Replication Server: startdb & stopdb".

**Connecting to the DR Agent**

Although there are two DR agents (one in primary and another in the standby environment), you will only need to enter commands at one of the DR agents. The DR agents can connect to each other in order to share configuration information or to execute any activity that requires local access to the host. To set up and monitor replication, log on to the DR agent on the primary environment.

Use the DR agent’s host and port and the DR agent administrator’s security credentials to establish a connection to the DR agent. The following example illustrates the use of ISQL to connect to the DR agent. Open a command shell for OS user `syb<dbsid>`:

**Example**

```
isql -X -U DR_admin -S <hostname>:<DR agent port>
```

The DR agent does not store its own security credentials, but rather, enforces authentication by pass-through authentication to the database server, or replication server.
Starting the DR Agent

Start the Windows Service named DRAgent_<SID>.

Stopping the DR Agent

Stop the Windows Service named DRAgent_<SID>.
If you are using Microsoft Cluster Services, both the replication server and DR agent must be represented by Windows Services, and they must be defined as services in all nodes of the cluster. If the services are not defined on all nodes, attempts to fail-over will not be successful.

Starting the Replication Server

Start the Windows service named SYBREP_<SID>_REP.

Stopping the Replication Server

Stop the Windows service named SYBREP_<SID>_REP.

7.6 Removing the Replication Environment

The installer provides installation options for teardown and removal of a replication environment.
Start with the uninstallation of the current primary environment. Otherwise database connects will be redirected and the installer will not be able to execute the necessary cleanup in the database.
As soon as the primary replication environment is removed, it is possible to uninstall the standby replication environment.
Choose the following installer options to disable replication and remove the replication software on the hosts running the replication servers.

Specify the kind of removal. Choose one of the following options:

- Tear down replication system
  This option
  ○ disables replication in the ASE servers
stops the replication servers
- deletes all directories and files created during setup, including the replication server instances

Data that was replicated to the standby databases will not be modified. The databases on the primary and standby hosts will not be “unmarked” for replication. The state of the environment after teardown will allow the immediate recreation of the replication environment. Materialization will again be required after setup.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can only tear down the replication environment if the DR Agent is up and running.</td>
</tr>
</tbody>
</table>

- **Unmark databases for replication and remove replication software**
  - This option
    - unmarks the databases
    - drops the database users for replication
    - removes the replication software

If the replication server was running on a separate host, it is possible to clean up remaining SAP standalone units using the installer option *Deleting an SAP System or Single Instances*.
7.7 Integration of the SAP Replication Server into an OS Cluster Environment

Installing the SAP Replication Server on the same host as the SAP ASE database is not supported in an OS cluster environment. The only supported option is to install the SAP Replication Server on its own host as shown below:

![Diagram showing OS Cluster Server Failover, Active/Passive Servers, ASE 1 and ASE 2, Shared Disk, LAN or WAN, Host 2, Host 3, Host 4, SRS 2, DR Agent]

7.8 Defining Dependencies

Both resources for replication – the replication server and the DR agent resource – will have the same dependencies. Each will be dependent on:

- The shared disk resource(s)
- The IP Address handling resource

Use the appropriate commands for your cluster software to add these dependencies to both the replication server and DR agent resources.

**Note**

There is no dependency between the replication server and DR agent. They can execute independently of each other.
7.9 Defining Node Failure Criteria

Most cluster software allows the state of the different cluster resources to trigger an automatic fail-over from one node in the cluster to another. The replication server and DR agent resource availability should not be used to trigger cluster fail-over.

Since the replication server processing is considered part of the SAP ASE database solution, no separate fault monitoring is required. If your existing hardware server or ASE monitoring determines that fail-over should occur, this is sufficient for replication to participate. It is not suggested that you add replication availability as a monitor for cluster node or ASE availability.

A failure by either of the replication resources will not affect the availability of your SAP application. However, a failure of your ASE resources does affect your SAP application availability. It is recommended that node failure continue to be triggered by ASE, but not include replication availability.
8   SAP ASE 16.0: Disaster Recovery Setup with SAP Replication Server

8.1  Disaster Recovery Setup with SAP Business Suite on SAP ASE 16.0

The Disaster Recovery setup for SAP ASE 16.0 offers the following replication modes:

- Synchronous Replication (Hot Standby)
- Near-Synchronous Replication (Hot Standby)
- Asynchronous Replication (Warm Standby)

SAP recommends to always install the latest versions of SAP ASE and of the SAP Replication Server. For more information on the latest versions and the certified combinations of SAP ASE and SAP Replication Server, see SAP Note 1891560.

The DR setup with SAP ASE 16.0 provides additional features for monitoring the SAP Replication Server using the Replication Management Agent (RMA).

You can install the SAP Replication Server on the same host as SAP ASE 16.0 (co-located scenario).

For more information, see the HADR Users Guide for SAP ASE 16.0, Chapter 4, Installing HADR for SAP Business Suite and SAP Note 1891560, section Additional Information.
High Availability with Microsoft Failover Clustering

You can install a high-availability SAP system with Microsoft Failover Clustering. The Failover Clustering software improves the availability of the system and protects it against failure and unplanned downtime, enabling 24-hour operation, 365 days a year.

With high availability, you enable critical system components, known as “Single Points of Failure (SPOFs)”, to be automatically switched from one machine to the other, if hardware or software problems arise on one machine. With the help of this switchover – or failover – the system can continue functioning.

Apart from enabling failover when hardware problems occur, you can also use Failover Clustering to avoid downtime when you perform essential system maintenance. If you need to maintain one host (failover cluster node), you can deliberately switch the cluster resources to the other host (failover cluster node) and temporarily operate it there while maintenance is in progress. When maintenance work is finished, you can easily move the resources back to their original node and continue operating them there.

When you are setting up the SAP system with Microsoft Failover Clustering, you combine standard installation steps, described earlier in this documentation, with cluster-specific steps, described here.

You have the following options to install a high-availability SAP system with Microsoft Failover Clustering:

- You install the SAP related parts (for example: SCS instance, additional standalone Gateways, Web Dispatcher instance, etc.) in one Microsoft Failover Cluster.
- You install the SAP related parts (for example: SCS instance, additional standalone Gateways, Web Dispatcher instance, etc.) in two Microsoft Failover Clusters.
- You install several SAP systems in one or more Microsoft Failover Clusters with two or more Microsoft Failover Cluster nodes.

You have the following options to install a Microsoft Failover Cluster:

- CSD (Cluster Shared Disks)
  - A Failover Cluster which contains shared disks.
    A database can be optionally installed in this Cluster in its own cluster group.
- FSC (File Share Cluster)
  - A Failover Cluster which does not contain shared disks and uses a remote file share instead.
    A database cannot be installed in this cluster because databases need shared disks. One exception: MS SQL using “AlwaysOn” option.

**i Note**
The user starting the installer must have full access rights on the file share `\<sapglobalhost>\sapmnt`. 

Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.3 to 7.5
on Windows: SAP Adaptive Server Enterprise

High Availability with Microsoft Failover Clustering
You have the following options to install the database instance with a high-availability SAP system:

- You install the database instance on a different host or cluster on either the same or a different operating system.
- You use third-party high-availability solutions to improve the availability of your database instance.

**Important Information**

To install a new SAP system with Microsoft Failover Clustering, you have to perform a number of extra steps specially required for the cluster and configure the SAP system so that it can take advantage of the cluster functionality:

- Since the correct configuration of network addresses is absolutely essential for the cluster to function properly, you have to perform a number of additional steps that are necessary to set up and check address resolution.
- Since the cluster hardware has at least two nodes that have access to all local and shared storage devices, you have to install some components on all nodes and pay attention to special rules for distributing components to local disks, shared disks, or external file shares.
You have to install and configure the SCS instance to run on two cluster nodes in one Microsoft Failover Cluster.

**Note**

If you have an existing SAP system and plan to migrate to a failover cluster with new hardware, you install the SAP system using a *system copy*.

For more information about the system copy, see the System Copy Guide for your SAP system at:

http://support.sap.com/sitoolset System Provisioning System Copy Option

The system copy guide does not include the cluster-specific information, which is described here.

**Terminology**

- In this documentation the hosts in a Microsoft Failover Cluster are referred to as first cluster node and additional cluster node(s):
  - The *first* cluster node is the cluster node where you perform the general installation of an SAP system, for example where the database or SCS instance is to be installed.
  - The *additional* cluster node is the node where you configure the already installed SAP instances to run in Microsoft Failover Clustering.
- As of Windows Server 2008, there are the following terminology changes for a cluster configuration:
  - The cluster feature is called *Failover Clustering*. You might still find the previous terminology *Microsoft Cluster Service* and abbreviation *MSCS* in some sections of this guide.
  - *Cluster groups* are called *services and applications* (Windows Server 2008 (R2)), or *roles* (Windows Server 2012 (R2) and higher).
    In some sections we are continuing to use the old term. In this case, “cluster group” also means “service and application”, or “role”.
  - The *Cluster Administrator* is called *Failover Cluster Manager*.

### 9.1 Checklist for a High-Availability System

This section includes the steps that you have to perform for your SAP system using Microsoft Failover Clustering. Detailed information about the steps is available in the relevant section.

**Planning**

1. You check that you have completed the same planning activites as for a non-HA system.
2. You decide how to set up your SAP system components in an HA configuration [page 147].
3. You decide how to distribute SAP system components to disks for HA [page 154].
4. You read Directories in an HA Configuration [page 157].
5. You read IP Addresses in an HA Configuration [page 158].
6. You obtain IP addresses for HA [page 160].

i Note

The user starting the installer must have full access rights on the file share `\<sapglobalhost>\sapmnt`.

Preparation

1. You check that you have completed the same preparations [page 58] as for a non-HA system.
2. To make sure that all preparation steps have been correctly performed, check that the storage resources are available to all cluster nodes. If you want to run the CSD option, check if you can move the disk resources from one cluster node to another so that they are accessible from a single node at any time. If you want to run the FSC option, check if the external file share is accessible by your installation user from all cluster nodes.

Installation

1. You make sure that:
   1. You are logged on as domain administrator or as a domain user who is a local administrator on all cluster nodes, unless otherwise specified.
   2. You do not use the user `<sapsid>adm` unless specified.
   3. If you are prompted during the installation process, log off and log on again.
2. You configure the first cluster node [page 163].
3. You install the database instance on the first cluster node [page 164] of the host where the database instance is to run.
4. You configure the database on the additional node. [page 165]
5. You configure the additional cluster node [page 166].
6. You install the primary application server instance [page 167].
7. You install at least one additional application server instance [page 167].

Post-Installation

1. You install the permanent SAP licenses on all cluster nodes.
2. You perform the post-installation checks for the enqueue replication server.
3. You perform the same post-installation steps [page 99] as for a non-HA system.
### Additional Information

- Moving Cluster Groups, or Services and Applications, or Roles [page 170]
- Starting and Stopping the SAP System in a HA Configuration [page 171].

### 9.2 Planning

The following sections provide information about how to plan the installation of the SAP system for Microsoft Failover Clustering. For a complete list of all steps, see section Planning in the Installation Checklist for a High-Availability System [page 145].

### 9.2.1 System Configuration with Microsoft Failover Clustering

The following chapters provide information about the configuration of your SAP system with Microsoft Failover Clustering. It describes the components you have to install for an SAP system running in a Microsoft Failover Cluster, and how to distribute them on the specific host. For more information, see:

- SAP System Components in a Microsoft Failover Cluster [page 147]
- Multiple SAP Systems in One Microsoft Failover Cluster [page 151]
- Multiple SAP Systems in Multiple Microsoft Failover Clusters [page 152]
- Enqueue Replication Server in a Microsoft Failover Cluster [page 154]

### 9.2.1.1 SAP System Components in a Microsoft Failover Cluster

In a Microsoft Failover Cluster configuration, you have the following mandatory components for your SAP system:

<table>
<thead>
<tr>
<th>Component</th>
<th>Number of Components per SAP System</th>
<th>Single Point of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCS instance (message services and enqueue services)</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Database instance (*)</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Component</td>
<td>Number of Components per SAP System</td>
<td>Single Point of Failure</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Application server instance (primary application server, additional application server)</td>
<td>1-&lt;n&gt;</td>
<td>no</td>
</tr>
</tbody>
</table>

(*) the database instance can also be installed outside the Microsoft Failover Cluster.

- To protect the SPOFs (SCS instance and database instance), you have to use Microsoft Failover Clustering. If a hardware or software problem occurs on the first cluster node, the clustered SCS instance and the clustered database automatically fail over to another node. If you need to maintain the cluster node where the SCS instance and database are running, you can switch these instances to another node. When maintenance work is finished, you move the SCS and database instance back to the original node.
- To protect system components that are non-SPOFs, for example application servers, you have to install them as multiple components. In this case, you must install at least two application servers (the primary application server instance and one additional application server instance) on two different hosts. You have the following options:
  - You install the primary application server and the additional application server instance on the cluster nodes of a Microsoft Failover Cluster. You install them on a local disk or external file share. Any additional application server instances are installed on hosts outside of the Microsoft failover cluster. If you have to maintain a cluster node, you have to stop the primary application server or the additional application server instance on that node. When you have finished maintenance, you restart the instances.

  **Note**
  
  If you install the primary application server and the additional application server instance on the cluster nodes, you must perform the hardware sizing for the failover cluster host, as in this case the application server is always running on this host. This increases system load and might impact performance.

  Note that, as usual in a failover cluster setup, the SCS and database instances also switches to run on the failover cluster host in the event of failover, which temporarily also increases system load.

  - You install the primary application server and all additional application server instances on hosts, which are not part of a Microsoft Failover Cluster.

**SAP System Components in One Microsoft Failover Cluster**

The following figures show examples for the installation of SPOFs and non-SPOFs of an SAP system in one Microsoft Failover Cluster with two nodes.

The first figure shows an Microsoft Failover Cluster configuration where the non-SPOFs components (primary application server instance, additional application server instance) are installed locally on the cluster nodes. Any additional application server instances are installed outside the Microsoft Failover Cluster on separate hosts.
Java System

The following figure shows an HA configuration, where the non-SPOFs components (primary application server instance, additional application server instance) are installed on separate hosts that are not part of the failover cluster.
Besides installing your SAP system in one Microsoft Failover Cluster, you can also set up two failover clusters and distribute the SPOF system components on these clusters to protect them against system failure.

The following figure shows an example where the database instance for the SAP system is installed in one Microsoft Failover Cluster, and the SCS instance is installed on the second failover cluster. The application servers (primary application server instance, additional application server instance) can either be installed on a local disk on the cluster nodes or on separate hosts that are not part of the Microsoft Failover Cluster.
Multiple SAP Systems In One Microsoft Failover Cluster

Before SAP NetWeaver 7.0, SAP only supported the installation of one clustered SAP system in one Microsoft Failover Cluster with two cluster nodes. The reason was that the cluster share sapmnt resource could only be assigned to one cluster group and could only point to one shared drive.

The solution was to rename the cluster share sapmnt resource into sapmnt<SAPSID>, and use junctions, which pointed to the local disk. This is no longer required.

⚠️ Caution

All local instances such as an enqueue replication server, primary or additional application server and the local part of the SCS when you use a file share cluster are installed on the local disk where the saploc share is pointing to. Make sure that you have enough space on this local disk.

Every SAP system is placed in a separate cluster group with the unique name SAP <SAPSID>. Each SAP cluster group has its own IP address, network name, as well as the SAP service resource (or generic service resource), and the SAP instance resource. If you use the CSD option, the cluster group also contains a shared disk and a sapmnt share. In case of the FSC option, the group does not contain a shared drive and the sapmnt share is located on a file share.
If you have an HA configuration with three or more cluster nodes, the following restrictions apply:

- The SCS instance must be configured to be able to perform a fail over between two cluster nodes in one Microsoft Failover Cluster. For more information, see SAP Note 1634991.
- If the database supports the installation on several cluster nodes, the database instance can be installed on more than two cluster nodes in one Microsoft Failover Cluster.

The following figure shows the installation of multiple SAP systems in one Microsoft Failover Cluster. For each SAP system you have to install one primary and at least one additional application server.

9.2.1.3 Multiple SAP Systems In Multiple Microsoft Failover Clusters

Besides installing multiple SAP systems in one Microsoft Failover Cluster, you can also install multiple SAP systems in several Microsoft Failover Clusters with two or more cluster nodes.

**Note**

As of Windows Server 2012, the Microsoft Failover Clustering software supports up to 64 cluster nodes.
For this failover cluster configuration, the following restrictions apply:

- The SCS instance must be configured to run on two cluster nodes in one Microsoft Failover Cluster. For more information, see SAP Note [1634991](https://support.sap.com/). If the database supports the installation on several cluster nodes, the database instance can be installed on more than two cluster nodes in one Microsoft Failover Cluster.

The following figure shows the installation of multiple SAP systems in two Microsoft Failover Clusters with three cluster nodes, called Node A, B, and C. In this example, the SCS instances are installed in the first Microsoft Failover Cluster, and the database instances for the two SAP systems are installed on the second Microsoft Failover Cluster. The application servers can be either installed on a local disk on the cluster nodes or outside the Microsoft Failover Cluster on separate hosts.

**i Note**

If you use an enqueue replication server, you must configure the enqueue replication server, and the SCS instance on two nodes.

For more information, see SAP Note [1634991](https://support.sap.com/).
9.2.1.4 Enqueue Replication Server in a Microsoft Failover Cluster

The enqueue replication server contains a replica of the lock table (replication table) and is an essential component in a high-availability setup. It is installed on the two cluster nodes where the SCS instance is installed and configured to run, even if you have more than two cluster nodes.

In normal operation the enqueue replication server is always active on the host where the SCS instance is not running.

If an enqueue server in a Microsoft Failover Cluster with two nodes fails on the first cluster node, the enqueue server on the additional cluster node is started. It retrieves the data from the replication table on that node and writes it in its lock table. The enqueue replication server on the first cluster node then becomes inactive. If the first cluster node is available again, the enqueue replication server on the second cluster node becomes active again.

The following figure shows the enqueue replication server mechanism in an Microsoft failover cluster configuration with two nodes:

![Enqueue Replication Server Mechanism on One Microsoft Failover Cluster with Two Nodes]

9.2.2 Distribution of SAP System Components to Disks for Failover Clustering

When planning the Microsoft Failover Cluster installation, keep in mind that the cluster hardware uses different storage resources:

- Local Resources
  - Local disks that are connected directly to the cluster nodes
- Shared Storage Resources
  - Shared disks that can be accessed by all cluster nodes via a shared interconnect if CSD option is used

Note: Shared disk is a synonym for the cluster Resource type Physical disk.
You need to install the SAP system components in both the following ways:

- Separately on all cluster nodes to use the local storage on each node
- You have two options to distribute the shared files which are used by all cluster nodes:
  - You install the following on different shared disks:
    - Database instance files, if the database instance is installed in the failover cluster
    - SCS instance
    - Single quorum device, if used
  - On an external file share that is made accessible to all cluster nodes:
    - All database files are installed on an external host, or an additional cluster in this scenario
    - If a quorum is used, it is configured as a file share quorum on the file share host

⚠️ Caution
You must not install any SAP components on the quorum disk.

Distribution of SAP System Components For One SAP System in a Failover Cluster with Shared Disks (CSD)
Quorum Configurations on Windows

On Windows, there are several quorum configurations available. The configuration to use mainly depends on the cluster setup, such as the number of cluster nodes, the storage type (single or distributed), the distribution to shared disk and file share, and the number of data centers. For more information, see the Windows documentation.

If the number of cluster nodes is odd, you need no quorum. For a cluster with an even number of nodes you can configure a disk quorum, a file share quorum, or a cloud quorum.

The default quorum configuration is called *Node and Disk Majority* for clusters with more than two nodes.

With a quorum configuration, each node and the witness maintain its own copy of the cluster configuration data. This ensures that the cluster configuration is kept running even if the active node fails or is offline.

⚠️ Caution

If you do not use the default quorum configuration for your operating system, contact your hardware partner, who can help you to analyze your needs and set up your cluster model. SAP supports these configurations if they are part of a cluster solution offered by your Original Equipment Manufacturer (OEM), or Independent Hardware Vendor (IHV).

Geographically Dispersed Cluster (Geospan)

The standard cluster configuration consists of two cluster nodes and a shared storage with all technical components located in the same data center. In a geographically dispersed cluster, also known as a geospan cluster, the cluster nodes are distributed across at least two data centers to avoid the full outage of a data center in the event of disaster.
A geospan configuration requires a more sophisticated storage architecture since a standard shared storage can only be located in one data center and might therefore be a single point of failure (SPOF). To prevent the disk storage becoming a SPOF, you have to configure the storage system in each data center and to replicate its content to the storage system of the other data center.

Replication can either be synchronous or asynchronous, depending on the:

- Functionality of the storage subsystem
- Acceptable amount of data loss during a failover
- Physical layout of the storage area network
  - This includes the distance between the storage systems, signal latency, capacity, and speed of the network connection.
- Customer budget

The database components in geospan configurations are often no longer part of the cluster and the database is replicated by pure database techniques, such as shadow database, log shipping, and mirrored database.

⚠️ Caution

- Currently, it is only possible to configure geospan clusters in the same subnet since on Windows Server 2008 (R2), you must not change a virtual IP address during failover.
- The numerous variants with geospan cluster configurations and the complex technical requirements are the reasons why the installation and configuration of such high-availability (HA) systems are not directly supported by SAP. Instead, the hardware vendors of this cluster configuration are responsible for the installation, configuration, and operation of the HA components running in geospan clusters. SAP only supports the standard operation and function of the SAP components running in such cluster configurations.

All functionality to set up geospan clusters is available as of Windows Server 2008 (R2).

### 9.2.3 Directories in a Microsoft Failover Cluster Configuration

The following tables show the directories where the main software components for a high-availability system are stored:

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>A supported operating system</td>
<td>%windir%</td>
</tr>
<tr>
<td>Microsoft Failover Clustering software</td>
<td>%windir%\Cluster</td>
</tr>
<tr>
<td>Only if FSC option is used: SCS instance</td>
<td>&lt;Local_Drive&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
</tr>
<tr>
<td>Application server</td>
<td>&lt;Local_Drive&gt;:\usr\sap&lt;SAPSID&gt;&lt;Instance&gt;</td>
</tr>
</tbody>
</table>
9.2.4 Hostnames in a Failover Cluster Configuration

A part of the installation process that is unique to Microsoft Failover Clustering is the configuration of host names and IP addresses in the network. This is a particularly important task because the addressing plays a key role in the switchover procedure. Addressing must be set up correctly so that the system can take advantage of the cluster functionality and switch between nodes when hardware problems arise.

This section explains the different types of IP addresses and their function in the switchover mechanism of one Microsoft Failover Cluster with two cluster nodes.

**Note**

As of Windows Server 2008, besides static IP addresses, you can also have DHCP-based (dynamic) IP addresses.

DHCP-based IP configurations are not supported for high-availability SAP systems. If the virtual IP address of the SAP cluster group changes during a failover, your clients can no longer reach the system due to caching.

### Types of IP Addresses

In a proper configured cluster with at least two nodes, there are at least seven IP addresses and corresponding host names for your SAP system. You have two IP addresses for each cluster node, one IP address for the cluster, one address for the SAP cluster group and one for the database cluster group.

Some of the addresses are assigned to the network adapters (network interface card, NIC) whereas others are virtual IP addresses that are assigned to the cluster groups.
Physical IP Addresses Assigned to Network Adapters

A Microsoft Failover Cluster configuration has at least two networks:

- A public network that is used for the communication between the primary application server, additional application servers, and the LAN.
- A private network that is used internally for communication between the nodes of the cluster, also called heartbeat.

The following figure shows a Microsoft Failover Cluster with two nodes and illustrates the adapters required for the public and private networks, and their corresponding physical IP addresses. A physical IP address, in contrast to a virtual one, is stationary and permanently mapped to the same adapter.

![Adapters and IP Addresses Required for Public and Private Networks in an Microsoft Failover Cluster with Two Nodes](image)

Host Names Assigned to Network Adapters

Each of the physical IP addresses of the network adapters must have a corresponding host name. For example, on the left-hand node in the figure above, you might assign the IP addresses of the public and private network adapters as follows:

<table>
<thead>
<tr>
<th>Network Adapter</th>
<th>IP Address</th>
<th>Host Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter 1 (private network)</td>
<td>10.1.1.1</td>
<td>clusA_priv</td>
</tr>
<tr>
<td>Adapter 3 (heartbeat network)</td>
<td>192.168.1.1</td>
<td>clusA</td>
</tr>
</tbody>
</table>

⚠️ Caution

- The IP address and host name of the **public** network adapter is also the IP address and name of the machine. In our example, this means that the machine that is the cluster node on the left in the figure has the name `clusA`.
- Do not confuse the **host name** with the **computer name**. Each node also has a computer name, which is usually the same as the host name. The computer name is displayed in the node column of the Failover Cluster Management. However, it is **not** required for the TCP/IP communication in the cluster. When you configure IP addresses and
Virtual IP Addresses Assigned to Cluster Groups

After you have installed the SAP system and fully configured the cluster, the critical system resources are bound together in three different groups.

Each of these groups requires a virtual IP address and network name that is permanently mapped to the group and not to a particular node. The advantage of this is that, whenever a group is moved between nodes, its IP address and network name move together with the group.

An HA configuration has the following groups:

- SAP cluster group for each clustered SAP system
- Cluster group

The following figure illustrates how the virtual IP addresses of the database group and SAP group can move from one node to the other during a failover.

9.2.5 Obtaining IP Addresses for a Microsoft Failover Cluster Configuration

This chapter describes how to obtain the IP addresses for the network adapters (cards) that are required to install and run your high-availability system.

Context

For a clustered system, you have to configure IP addresses correctly. During the installation procedure you have to assign at least seven IP addresses and host names. You normally obtain these names and addresses from the system administrator.
Procedure

Ask the system administrator to give you the addresses and host names listed in the tables below, which show an example for a configuration with one Microsoft failover cluster with two nodes. You need to enter the addresses and host names later during the installation process.

The column **Defined During** indicates at which stage of the installation of the operating system and the SAP system the addresses are defined in the system.

⚠️ **Caution**
Use the names *exactly* as specified by the system administrator.

ℹ️ **i Note**
Note: In the following tables we are still using the terminology *cluster group*, and not the Windows Server 2008 (R2) terminology *services and applications* or the Windows Server 2012 (R2) terminology *Roles*.

### Physical IP Addresses

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Physical IP Address</th>
<th>Example for Physical Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>First cluster node: adapter for heartbeat network</td>
<td>10.1.1.1</td>
<td>clusA_priv</td>
<td>Address for internode communication on the heartbeat network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>First cluster node: adapter for public network</td>
<td>129.20.5.1</td>
<td>clusA</td>
<td>Address of the first cluster node for communication with application servers and LAN (this is the same as the address of the first cluster node)</td>
<td>Windows installation</td>
</tr>
<tr>
<td>Additional cluster node: adapter for heartbeat network</td>
<td>10.1.1.2</td>
<td>clusB_priv</td>
<td>Address for internode communication on the heartbeat network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>Additional cluster node: adapter for public network</td>
<td>129.20.5.2</td>
<td>clusB</td>
<td>Address of the additional cluster node for communication with application servers and LAN (this is the same as the address of the additional cluster node)</td>
<td>Windows installation</td>
</tr>
</tbody>
</table>
Virtual IP Addresses

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Virtual IP Address</th>
<th>Example for Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster group</td>
<td>129.20.5.3</td>
<td>clusgrp</td>
<td>Virtual address and name of the cluster group. It identifies the cluster and is used for administration purposes.</td>
<td>Failover cluster software configuration</td>
</tr>
<tr>
<td>Database cluster group</td>
<td>129.20.5.4</td>
<td>dbgrp</td>
<td>Virtual address and name for accessing the group of database resources, regardless of the node it is running on</td>
<td>Execution of HA-wizard or database-specific cluster scripts</td>
</tr>
<tr>
<td>SAP cluster group</td>
<td>129.20.5.5</td>
<td>sapgrp</td>
<td>Virtual address and name for accessing the group of SAP resources, regardless of the node it is running on</td>
<td>Configuration of SAP system for high availability with the installer on the first node</td>
</tr>
</tbody>
</table>

### 9.3 Preparation

This section provides information about how to prepare the installation of the SAP system for Microsoft Failover Clustering. For a complete list of all steps, see section *Preparation* in the *Installation Checklist for a High-Availability System* [page 145].

1. You check that you have completed the same preparations [page 58] as for a non-HA system.
2. To make sure that all preparation steps have been correctly performed, check that the storage resources are available to all cluster nodes. If you want to run the CSD option, check if you can move the disk resources from one cluster node to another so that they are accessible from a single node at any time. If you want to run the FSC option, check if the external file share is accessible by your installation user from all cluster nodes.

### 9.4 Installation

The following sections provide information about how to install the SAP system in a high-availability environment. For a complete list of all steps, see section *Installation* in the *Installation Checklist for a High-Availability System* [page 145].
You have the following options to install the database instance:

- **CSD (Cluster Shared Disk)**
  - You use a high available database outside the cluster used for the SCS instance. This scenario requires a shared disk for the SCS instance and requires an additional cluster used for the database which may also require shared disks.
  - You install the database on a shared disk in the same cluster used for the SCS instance.

- **FSC (File Share Cluster)**
  - You use a high available database outside the cluster used for the SCS instance. This scenario does not require shared disks for the SCS instance and requires an additional cluster used for the database which may require shared disks.

---

**i Note**

The user starting the installer must have full access rights on the file share `\<sapglobalhost>\sapmnt`.

---

### 9.4.1 Configuring the First Cluster Node

At the beginning of the SWPM installation, you will be asked to choose between FSC and CSD installation option. For more information, see [Installation](#).

When you run the **First Cluster Node** option, the installer:

- Creates the `saploc` share, pointing to a local disk
- Creates the `sapmnt` share, pointing to a local disk if the CSD option is used, or to the external file share if the FSC option is used
- Installs the central services instance (SCS) and prepares this host as the SAP global host
- Creates the SAP cluster group and adds the SCS instance to the SAP cluster group
- Installs the enqueue replication server instance (ERS instance) for the SCS instance
- Installs the SAP Host Agent

---

**Caution**

When you reboot during the conversion to Failover Clustering, resources fail over to the other cluster node. Therefore, after each reboot you have to return the system to the state it was in before the reboot.

---

### Prerequisites

- You are logged on to the **first** cluster node as domain administrator or as a local user with domain administration rights. For more information, see [Performing a Domain Installation without being a Domain Administrator](#).
- **CSD**: You must install the SCS instance on a shared disk, and the ERS instance and SAP Host Agent on a local disk.
  - **FSC**: You must install the SCS instance on a local disk, like ERS instance and SAP Host Agent.
i Note

If you are installing SAP NetWeaver 7.5 Process Integration (PI) system, it is mandatory to use different shared disks for the SCS instance if you’re using a shared disk cluster. In case you use a File Share Cluster, you have to use different sapmnt shares for both instances.

- If you select the FSC option at the beginning of the installation, the global parts of a SAP system are stored on an external file share. The SCS instance, the ERS instance, and SAP Host Agent are installed on a local disk.

Procedure

1. Run the installer [page 84] and on the Welcome screen, choose <Product> <Database> SAP Systems <System> High-Availability System First Cluster Node.

i Note

If the installer prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.

i Note

- For more information about the input parameters, position the cursor on a parameter and press F1 in the installer.
- If you have a Microsoft cluster configuration with more than two nodes in one cluster, apply SAP Note 1634991.

More Information

Moving Cluster Groups, or Services and Applications, or Roles [page 170]

9.4.2 Installing the Database Instance

Use

This procedure describes how to install the database instance on the first cluster node.
Prerequisites

- The SAP cluster group is Online on the first cluster node.
- The DB cluster group is Online on the first cluster node.

Procedure

Perform the following steps on the first cluster node.

1. Run the installer [page 84] and on the Welcome screen, choose <Product> <Database> SAP Systems <System> High-Availability System Database Instance.
2. Follow the instructions in the installer dialogs and enter the required parameter values.
   1. For the profile directory you have to use the UNC path of the virtual SCS host name, for example: \\
      <SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
      In an HA-system, the virtual host name of the SCS instance is the same as the SAP global host name.
   2. When the installer prompts you for the database host, make sure that you enter the virtual database host name.

   Note
   For more information about the input parameters, position the cursor on a parameter and press the F1 key in the installer.

9.4.3 Configuring the Database on the Additional Node

Perform the steps below to configure the database on the additional cluster node.

1. On the additional cluster node, run the installer [page 84] and in the Welcome screen, choose <Product> <Database> SAP Systems <System> High-Availability System Additional Database Cluster Node.
2. Follow the instructions in the installer dialogs and enter the required parameter values.

   Caution
   - Make sure that you enter the same drive as you did on the first database node.
   - Make sure that you distribute the SAP ASE software and logs correctly to local and shared disks as described in Directories in a Microsoft Failover Cluster Configuration [page 157].

   Note
   For more information about the input parameters, position the cursor on a parameter and press the F1 key in the installer.
9.4.4 Configuring the Additional Cluster Node

Use

When you run the Additional Cluster Node option it:

- Configures the additional cluster node to run the SAP cluster group
- Creates the saploc share, pointing to a local disk
- If you chose the FSC option:
  - Installs the SCS instance
  - Installs the enqueue replication server instance (ERS) for the SCS instance
- Installs the SAP Host Agent

⚠ Caution
You must install the instances and SAP Host Agent on a local disk.

Prerequisites

- You are logged on to the additional cluster node as domain administrator or as a domain user who is a local administrator on all cluster nodes. For more information, see Performing a Domain Installation without being a Domain Administrator [page 180].
- You have already performed the First Cluster Node [page 163] option.

Procedure

1. Run the installer [page 84] and on the Welcome screen, choose <Product> <Database> SAP Systems <System> High-Availability System Additional Cluster Node.

   i Note
   If the installer prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.

   i Note
   For more information about the input parameters, position the cursor on the parameter and press F1 in the installer.
9.4.5 Installing the Primary Application Server Instance

Use

You have the following options to install the primary application server instance:

- You install the primary application server instance on a cluster node.
- You install the primary application server instance on a host outside of Microsoft Failover Cluster.

Procedure

1. Run the installer [page 84] and on the Welcome screen, choose <Product> <Database> SAP Systems <System> High-Availability System Primary Application Server Instance.
2. If the installer prompts you to log off, choose OK and log on again.
3. Follow the instructions in the installer dialogs and enter the required parameter values.

   i Note
   ○ For more information about the input parameters, position the cursor on a parameter and press F1 in the installer.
   ○ If you install the primary application server instance on an cluster node, make sure that on the screen General SAP System Parameters for the:
     ○ Profile Directory, you use the UNC path (not the local path) of the SAPGLOBALHOST host name, for example; for example:
       \<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
       If CSD option is used, the virtual host name of the SCS instance is the same as the SAPGLOBALHOST host name.
       If FSC option is used the virtual host name of the SCS instance is different from the SAPGLOBALHOST host name.

   i Note
   If you are installing a SAP NetWeaver 7.5 Process Integration (PI) system, make sure that the virtual host names for the ASCS instance and the SCS instance are different.

   ○ Installation Drive, you choose the local disk where you want to install the primary application server instance.
4. Check that the primary application server instance is running.

9.4.6 Installing the Additional Application Server Instance

Use

You have to install at least one additional application server instance for Microsoft Failover Clustering.
You have the following options, to install the additional application server instance:

- You install the additional application server instance on a cluster node.
- You install the additional application server instance on a host outside of the failover cluster.

**Procedure**

1. Run the installer [page 84] and on the Welcome screen, choose <Product> <Database> SAP Systems <System> High-Availability System Additional Application Server Instance.
2. If the installer prompts you to log off, choose OK and log on again.
3. Follow the instructions in the installer dialogs and enter the required parameter values.

   - **Note**
     - For more information about the input parameters, position the cursor on a parameter and press F1 in the installer.
     - If you install the additional application server instance on a cluster node, make sure that on the screen General SAP System Parameters for the:
       - **Profile Directory**, you use the UNC path (not the local path) of the SAPGLOBALHOST host name, for example: \\
         \<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
       - If CSD option is used, the virtual host name of the SCS instance is the same as the SAPGLOBALHOST host name.
       - If FSC option is used, the virtual host name of the SCS instance is different from the SAPGLOBALHOST host name.
     - **Installation Drive**, you choose the local disk where you want to install the additional application server instance.
     - **Additional application server instance**, you enter the same instance number as for the primary application server.

4. When you have finished, change the instance profile of the additional application server instance so that the number of its work processes equals the number of work processes of the primary application server instance.
5. If required, install more additional application server instances outside of the failover cluster.

   - **Note**
     - Make sure that on the screen General SAP System Parameters for the Profile Directory, you use the UNC path of the virtual SCS host name, for example:
       \\
         \<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
     - In a HA-system, the virtual host name of the SCS instance is the same as the SAP global host name.
9.5 Post-Installation

To complete and check the installation of the SAP system for a high-availability configuration, you need to perform the following steps:

1. You install the permanent SAP licenses on all cluster nodes.
2. After a new installation of a clustered SCS instance, make sure that you update the saprc.dll (part of the NTCLUST.SAR) package in C:\windows\system32 as soon as possible. For more information, see SAP Note 1596496.
3. For information about Rolling Kernel Switch on Windows Failover Clusters, see SAP Note 2199317.
4. You perform the post-installation checks for the enqueue replication server.

For more information, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3</td>
<td>Application Help</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw73">http://help.sap.com/nw73</a></td>
<td>Function-Oriented View</td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement</td>
<td>Application Server</td>
</tr>
<tr>
<td>Package 1</td>
<td>Application Server Infrastructure</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw731">http://help.sap.com/nw731</a></td>
<td>Standalone Enqueue Server</td>
</tr>
<tr>
<td></td>
<td>Installing the Standalone Enqueue Server</td>
</tr>
<tr>
<td></td>
<td>Replication Server: Check Installation</td>
</tr>
<tr>
<td>SAP NetWeaver 7.4</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw74">http://help.sap.com/nw74</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td></td>
</tr>
</tbody>
</table>

5. If required, you perform the general post-Installation steps [page 99] listed in this guide.

9.6 Additional Information

The following sections provide additional information about:

- Moving Cluster Groups, or Services and Applications, or Roles [page 170]
- Starting and Stopping the SAP System in a Microsoft Failover Cluster Configuration [page 171].
9.6.1 Moving Cluster Groups, or Services and Applications, or Roles

Use

When you reboot during the conversion to Microsoft Failover Clustering, cluster resources fail over to the other cluster node. Therefore, you have to return the system to the state it was in before the reboot, and move the resources back to the original node.

To move the database, or SCS from one cluster node to the other, you use the following:

- **PowerShell** (Windows Server 2012 (R2) and higher)
- **Failover Cluster Manager** (Windows Server 2008 (R2))

**Note**

As of Windows Server 2008 (R2) there are the following terminology changes:

- Cluster groups are called **services and applications** (Windows Server 2008 (R2), or **Roles** (Windows Server 2012 (R2) and higher)
  We do not always use all names in this section.
- The **Cluster Administrator** is now called **Failover Cluster Manager**.

**Prerequisites**

Windows Server 2008 (R2):

The services or applications you want to move are configured and are visible in the **Failover Cluster Manager**.

**Procedure**

**Moving Roles, or Services and Applications, or Groups**

To move the roles (Windows Server 2012 (R2) and higher) or services and applications (Windows Server 2008 (R2)), proceed as follows:

- Windows Server 2012 (R2) and higher:
  1. To move a role, open PowerShell in elevated mode, and enter the following command:
     
     ```
     move-clustergroup "<role name>"
     ```
  2. Repeat these steps for each role that you want to move.
- Windows Server 2008 (R2):
  1. Start the **Failover Cluster Manager** with → **Start** → **Administrative Tools** → **Failover Cluster Manager** →
  2. In the **Failover Cluster Manager**, right-click the service and application you want to move.
  3. Choose → **Move this service or application to another node** → **Move to <relevant node>** →
  4. Repeat the previous step for each service and application that you want to move.
You can only move disks that are assigned to Services and Applications (Windows Server 2008 (R2)) or Roles (Windows Server 2012 (R2) and higher).

The disks that are added to the cluster are automatically added to a group named Available Storage. Although the groups Available Storage and Cluster Group exist in a failover cluster on Windows Server 2008 (R2) or higher, they are not visible under Services and Applications (Windows Server 2008 (R2)) or Roles (Windows Server 2012 (R2) and higher). Therefore, you cannot move these groups with the Failover Cluster Manager.

- If you use Windows Server 2012 (R2) and higher, proceed as follows:
  - To move Cluster Group, open PowerShell in elevated mode, and enter the following command: `move-clustergroup "cluster group"`
  - To move Available Storage, open PowerShell in elevated mode, and enter the following command: `move-clustergroup "Available Storage"

- If you use Windows Server 2008 (R2) proceed as follows:
  - To move Cluster Group, open a command prompt and enter: `cluster group "cluster group" /move`
  - To move Available Storage, open a command prompt and enter: `cluster group "Available Storage" /move`

9.6.2 Starting and Stopping the SAP System in a Microsoft Failover Cluster Configuration

Use

An SAP System in an HA configuration is typically configured into two HA groups: one cluster resource group contains the database resources, the other group contains the SAP SCS instance.

- If you use Windows Server 2012 (R2) and higher, proceed as follows:
  - To move Cluster Group, open PowerShell in elevated mode, and enter the following command: `move-clustergroup "cluster group"`
  - To move Available Storage, open PowerShell in elevated mode, and enter the following command: `move-clustergroup "Available Storage"

- If you use Windows Server 2008 (R2) proceed as follows:
  - To move Cluster Group, open a command prompt and enter: `cluster group "cluster group" /move`
  - To move Available Storage, open a command prompt and enter: `cluster group "Available Storage" /move`

With the SAP MMC, or SAPControl you can start and stop all SAP instances whether they are clustered or not, except the database instance.

With certain HA administration tools (Cluster Administrator, Failover Cluster Manager, or PowerShell), you can only start or stop clustered SAP instances, such as the SCS instance, or the database instance.
Procedure

Starting and Stopping a Complete System or a Single Instance with SAP MMC or SAPControl

With the SAP MMC, or the command line tool SAPControl, you can start or stop the complete SAP system or a single clustered or non-clustered SAP instance, except the database instance.

To start or stop the database instance, you have to use the tools described in “Starting and Stopping the clustered SCS and Database Instance”.

For more information about SAP MMC or SAPControl, see Starting and Stopping the SAP System [page 192].

**Note**

- To use SAP MMC or SAPControl for starting or stopping a clustered SAP instance, the "SAP <SAPSID> <Instance_Number> Service" resource of the clustered instance must be online. Therefore, SAP recommends keeping the "SAP <SAPSID> <Instance_Number> Service" cluster resource always online, and using the SAP MMC or SAPControl to start or stop a clustered instance.
- You can also start SAPControl in the PowerShell.

Starting and Stopping the clustered SCS and Database Instance

With certain HA administration tools, such as PowerShell (Windows Server 2012 (R2) and higher), or Failover Cluster Manager (Windows Server 2008 (R2)), you can only start or stop clustered SAP instances, such as the SCS instance or the database instance. For all other non-clustered instances, such as additional application server instances or the primary application server instance, you must use the SAP MMC or SAPControl.

- **Using PowerShell** (Windows Server 2012 (R2) and higher)
  
  To start or stop the clustered SCS instance or the database instance with PowerShell do the following:
  
  1. To start the clustered database instance, open PowerShell in elevated mode, and enter the following command:
     
     ```
     start-clusterresource <database resource>
     ```
  2. To start the clustered SCS instance, open PowerShell in elevated mode, and enter the following command:
     
     ```
     start-clusterresource "SAP <SAPSID> <Instance_Number> Instance"
     ```
  3. To stop the clustered SCS instance, open PowerShell in elevated mode, and enter the following command:
     
     ```
     stop-clusterresource "SAP <SAPSID> <Instance_Number> Instance"
     ```
  4. To stop the clustered database instance, open PowerShell in elevated mode, and enter the following command:
     
     ```
     stop-clusterresource <database resource>
     ```

- **Using the Failover Cluster Manager** (Windows Server 2008 (R2))

  With the Failover Cluster Manager, you can only start or stop clustered instances such as the SCS instance or the database instance.

  For all other non-clustered instances, such as additional application server instances or the primary application server instance, you must use the SAP MMC or SAPControl.

  To start or stop the clustered SCS instance or the database instance with the Failover Cluster Manager do the following:

  1. Start the Failover Cluster Manager by choosing **Start** ➤ **Administrative Tools** ➤ **Failover Cluster Manager** .
  2. To start the database instance, right-click the database instance <database_resource>, and choose **Bring this resource online**.
3. To start the SCS instance, select the relevant service and application SAP <SAPSID>. In the right-hand pane, under Other Resources, right-click the resource SAP <SAPSID> <Instance_Number> Instance, and choose Bring this resource online.

4. To stop the SCS instance, select the relevant service and application SAP <SAPSID>. In the right-hand pane, under Other Resources, right-click the resource SAP <SAPSID> <Instance_Number> Instance, and choose Take this resource offline.

5. To stop the database instance, right-click the database instance <database_resource>, and choose Take this resource offline.
10  Additional Information

10.1  Additional Information

The following sections provide additional information about optional preparation, installation, and post-installation tasks.

There is also a section describing how to delete an SAP system.

Planning

SAP Directories [page 175]

Preparation

- Performing a Domain Installation Without Being a Domain Administrator [page 180]
- Integration of LDAP Directory Services [page 183]
- Preparing an External ABAP System as Source for User Data [page 65]

Installation

- Installing the Host Agent Separately [page 190]

Post-Installation

- Starting and Stopping the SAP System [page 192]
- Configuring the Windows Server 2008 (R2) Firewall [page 194].
- SAP System Security on Windows [page 196]
- Automatic Creation of Accounts and Groups [page 198]
Deleting an SAP System or SAP Instance

- Deleting an SAP System [page 200]

10.2 SAP Directories

This section describes the directories that are available in an SAP system.

If you want to install a high-availability system, see also Directories in a Microsoft Failover Cluster Configuration [page 157].

The installer automatically creates the following directories during the installation:

- \usr\sap
  This directory is created on the:
  - Global host and shared with the network share sapmnt
    - In a non-high-availability-system, you can install the primary application server instance or the (A)SCS instance on the global host or on any other host.
    - On local hosts, the \usr\sap directory contains copies of the SAP software and local (instance-specific) data.
  - Local host and shared with the name saploc.
    - In a high availability system this directory is located on a local disk. You have at least two disk drives with a \usr\sap directory structure.

---

**Note**

- Since SAP traces for the instance are created in \usr\sap, make sure that there is sufficient space available in this directory. Changes in SAP profiles can also affect the disk space.
- The executables on the local host are replicated from those on the global host every time the local instance is started. The SAP copy program sapcpe compares the binaries in the \<Platform> directory on the global host and the binaries in the \exe directory on the application server. If the binaries in the \exe directory are older than those in the \<Platform> directory, sapcpe replaces them with the newer version of the global host.
Other application servers access the global data using the Universal Naming Convention (UNC) path \\<SAPGLOBALHOST>\sapmnt. The SAP programs access their instance-specific data with the UNC path \\<SAPLOCALHOST>\saploc. If the UNC path points to a local directory, the local path (and not the UNC path) is used to access the directory. The parameters SAPGLOBALHOST and SAPLOCALHOST have the same values on the global host.

### i Note

Windows Server 2008 (R2) and higher:

In a high-availability system, file shares pointing to directories on shared disks are only visible or can be accessed with the virtual host name of the cluster group the shared disks belong to.

This lets you have several shares with the same name pointing to different disks (multi-SID).

---

**Directory Structure**

The following figures show how the physical directory \usr\sap is shared on the global host in a standard and in a distributed system. In both cases, the UNC paths are used as follows:

- \\<SAPGLOBALHOST>\sapmnt to access global directories
- \\<SAPLOCALHOST>\saploc to access local instance-specific data

### i Note

There are the following instance names available in an SAP system:

- Central services instance: SCS<Instance_Number>
- Primary application server instance: J<Instance_Number>
- Additional application server instance: J<Instance_Number>.
**High Availability only:** Enqueue Replication Server instance: \text{ERS<Instance\_Number>}

End of 'High Availability': HA (Windows)

**Directory Structure on the Global Host in a Standard (Central) Java System**

**Directory Structure for a Distributed Java System**
10.3 Checking and Changing the Paging File Settings on Windows Server 2012 (R2) and Higher

Use

This section describes how to check and change the paging file size on Windows Server 2012 (R2) and higher with PowerShell.

The PowerShell commands also work in previous Windows versions where PowerShell is available.

i Note

Some paging file operations require a reboot of the server to activate the changes you made. Wmi-commands do not indicate whether a reboot is required or not. Therefore, we recommend rebooting your system every time you change the paging file settings with PowerShell.

Prerequisites

Always start the PowerShell in elevated mode (run as administrator).

Procedure

Checking the Size of a Paging File

2. Check whether the default value *Automatic manage pagefile size for all devices* is activated.

**iNote**

We do not support automatically managed page file sizes.

To check this, enter the following command:

```
(Get-WmiObject Win32_Pagefile) -eq $null
```

If *Automatic manage pagefile size for all devices* is enabled, the output value is *True*.

If necessary, disable *Automatic manage pagefile size for all devices* with the following command:

```
$sys = Get-WmiObject Win32_Computersystem -EnableAllPrivileges
$sys.AutomaticManagedPagefile = $false
$sys.put()
```

3. Check the size of the paging files with the following command:

```
Get-WmiObject WIN32_Pagefile | Select-Object Name, InitialSize, MaximumSize, FileSize
```

The output looks like the following:

<table>
<thead>
<tr>
<th>MaximumSize</th>
<th>Name</th>
<th>InitialSize</th>
<th>FileSize</th>
</tr>
</thead>
<tbody>
<tr>
<td>41943040000</td>
<td>C:\pagefile.sys</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>41943040000</td>
<td>E:\pagefile.sys</td>
<td>40000</td>
<td>80000</td>
</tr>
</tbody>
</table>

In this example, in the first line, the *InitialSize* and *MaximumSize* values of a paging file are 0, which means that the paging file size is *system managed* (not recommended).

In the second line, the paging file size has a minimum and a maximum size (recommended).

### Changing the Size of a Single Paging File

Changing the *InitialSize* and *MaximumSize* values of a paging file to a size other than 0, will automatically switch off *system managed size*.

In the following example, we change the size of the paging file on C: to the *InitialSize* of 40 GB and to the *MaximumSize* of 80 GB.

Use the following commands in a PowerShell:

```
$Pagefile = Get-WmiObject Win32_PagefileSetting | Where-Object {$_ .name -eq "C:\pagefile.sys"}
$Pagefile.InitialSize = 40000
$Pagefile.MaximumSize = 80000
$Pagefile.put()
```

Typically, you choose the same value for *InitialSize* and *MaximumSize*.

**iNote**

The sum of all paging files *InitialSize* values must be equal to or higher than the value recommended for your SAP system.
Creating a Second Paging File on Another Disk

You might want to create a second or additional paging files to improve system performance, or if your disk does not have enough space.

To do so, enter the following commands in a PowerShell:

```powershell
$Pagefile = Get-WmiObject Win32_PagefileSetting
$Pagefile.Name = "E:\pagefile.sys"
$Pagefile.Caption = "E:\pagefile.sys"
$Pagefile.Description = "'pagefile.sys' @ E:\"
$Pagefile.SettingID = "pagefile.sys @ E:"
$Pagefile.InitialSize = 80000
$Pagefile.MaximumSize = 80000
$Pagefile.put()
```

Deleting a Paging File on a Specific Device

To delete a paging file, enter the following commands in a PowerShell:

```powershell
$pagefile = Get-WmiObject Win32_PagefileSetting | Where-Object {$_ .name -eq "E:\pagefile.sys"}
$pagefile.delete()
```

10.4 Performing a Domain Installation Without Being a Domain Administrator

You normally perform a domain installation of the SAP system with a user who is a member of the domain Admins group, as described in Required User Authorization for Running the Installer [page 61]. If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. In this case, the domain administrator has to prepare the system appropriately for you. The domain administrator can perform the following steps either using the installer or manually:

1. Create the new global group SAP_<SAPSID>_GlobalAdmin.
2. Create the two new SAP system users <sapsid>adm and SAPService<SAPSID>.
3. Add the users <sapsid>adm and SAPService<SAPSID> to the newly created group SAP_<SAPSID>_GlobalAdmin.

**Note**

The installer creates the operating system user for the SAP Host Agent by default as a local user that is not a member of the local Administrators group. If you want to create this user manually as a domain user, you must perform the following steps:

Creating the SAP Host Agent User and Group Manually
1. Create the new global group `SAP_SAP_GlobalAdmin`.
2. Create the SAP system user `sapadm`.
3. Add the user `sapadm` to the newly created group `SAP_SAP_GlobalAdmin`.

However, for security reasons we strongly recommend you to create this user as a local user.

**Prerequisites**

- You must be domain administrator to perform the required steps.
- You must have installed the feature *Remote Server Administration Tools* as follows:
  - Windows Server 2012 (R2) and higher:
    - Open PowerShell in elevated mode, and enter the following command:
      ```
      add-windowsfeature RSAT-ADDS
      ```
  - Windows Server 2008 (R2):
    2. In the Server Manager window, select Features.

**Procedure**

**Creating the Required Users and Groups Using the Installer**

On the host where the SAP system is to be installed, the domain administrator starts the installer as described in *Running the Installer* [page 84] and chooses Generic Installation Options ➔ Database ➔ Preparations ➔ Operating System Users and Groups ➔ to have the group and users created automatically.

**Creating the Required Users and Groups Manually**

- **Note**
  To create the users and groups specific to the SAP Host Agent, you must follow the procedure below, and replace the users and groups with those for the SAP Host Agent.

**Creating the New Global Group SAP_<SAPSID>._GlobalAdmin**

Perform the following steps:

- **Windows Server 2012 (R2) and higher:**
  - Open PowerShell in elevated mode, and enter the following command:
    ```
    net group SAP_<SAPSID>._GlobalAdmin /add /domain
    ```
- **Windows Server 2008 (R2):**
  1. Log on as domain administrator.
  2. Start the Active Directory Users and Computers Console by choosing:
    ```
    ```
3. Right-click Users in Tree, and choose \[ New \] Group.

4. Enter the following:
   - Group name: SAP_<SAPSID>_GlobalAdmin

5. Select the following:
   1. Group scope: Global
   2. Group type: Security

6. Choose OK.

Creating the New SAP System Users <sapsid>adm and SAPService<SAPSID>

Perform the following steps:

- Windows Server 2012 (R2) and higher:
  1. Open PowerShell in elevated mode.
  2. Create the <sapsid>adm user with the following command:
     \[ net user <sapsid>adm <Password> /add /domain \]
  3. Create the SAPService<SAPSID> user with the following command:
     \[ net user SAPService<SAPSID> <Password> /add /domain \]

- Windows Server 2008 (R2):
  1. In Active Directory Users and Computers Console, right-click Users in Tree and choose:
     \[ New \] User.
  2. Enter the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input for &lt;sapsid&gt;adm</th>
<th>Input for SAPService&lt;SAPSID&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Initials</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Last name</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

3. Choose Next and enter the following:
   - Password: <Password>
   - Confirm password: <Password>

4. Select Password never expires.

5. Choose Next Finish.

Adding the Manually Created Users to Groups

- Note

To add the users specific to the SAP Host Agent to the relevant groups, you must follow the procedure below, and replace the users and groups with those for the SAP Host Agent.

Adding the <sapsid>adm User to the SAP_<SAPSID>_GlobalAdmin Group

- Note

Make sure that no other options are selected.
- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  ```
  net group SAP_<SAPSID>_GlobalAdmin <sapsid>adm /add /domain
  ```
- Windows Server 2008 (R2):
  1. In the Users folder, double-click the newly created user account <sapsid>adm in the list on the right.
  2. Choose `Member > Add`.
  3. Select the new SAP_<SAPSID>_GlobalAdmin group and choose Add to add it to the list.
  4. Choose OK twice.

### Adding the SAPService<SAPSID> User to the SAP_<SAPSID>_GlobalAdmin Group

- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  ```
  net group SAP_<SAPSID>_GlobalAdmin SAPService<SAPSID> /add /domain
  ```
- Windows Server 2008 (R2):
  1. In the Users folder, double-click the newly created user account SAPService<SAPSID> in the list on the right.
  2. Choose `Member > Add`.
  3. Select the new SAP_<SAPSID>_GlobalAdmin group.
  4. Choose Add to add it to the list, and then OK.
  5. Choose OK to close SAPService<SAPSID>Properties.

## 10.5 Integration of LDAP Directory Services

This section explains the benefits of using the SAP system with the Lightweight Directory Access Protocol (LDAP) directory and gives an overview of the configuration steps required to use an SAP system with the directory.

LDAP defines a standard protocol for accessing directory services, which is supported by various directory products such as Microsoft Active Directory, and OpenLDAP slapd. Using directory services enables important information in a corporate network to be stored centrally on a server. The advantage of storing information centrally for the entire network is that you only have to maintain data once, which avoids redundancy and inconsistency.

If an LDAP directory is available in your corporate network, you can configure the SAP system to use this feature. For example, a correctly configured SAP system can read information from the directory and also store information there.

### i Note

- The SAP system can interact with the Active Directory using the LDAP protocol, which defines:
  - The communication protocol between the SAP system and the directory
How data in the directory is structured, accessed, or modified

If a directory other than the Active Directory also supports the LDAP protocol, the SAP system can take advantage of the information stored there. For example, if there is an LDAP directory on a UNIX or Windows server, you can configure the SAP system to use the information available there. In the following text, directories other than the Active Directory that implement the LDAP protocol are called **generic LDAP directories**.

---

**Prerequisites**

You can only configure the SAP system for Active Directory services or other LDAP directories if these are already available on the network. As of Windows 2000 or higher, the Active Directory is automatically available on all domain controllers. A generic LDAP directory is an additional component that you have to install separately on a UNIX or Windows server.

---

**Features**

In the SAP environment, you can exploit the information stored in an Active Directory or generic LDAP directory by using:

- **SAP Logon**
- **The SAP Microsoft Management Console (SAP MMC)**
  
  For more information about the automatic registration of SAP components in LDAP directories and the benefits of using it in SAP Logon and SAP MMC, see the documentation **SAP System Information in Directory Services** at:
  

- **The SAP Management Console (SAP MC)**

**SAP Logon**

Instead of using a fixed list of systems and message servers, you can configure SAP Logon in the `sapmsg.ini` configuration file to find SAP systems and their message servers from the directory. If you configure SAP logon to use the LDAP directory, it queries the directory each time **Server** or **Group** selection is chosen to fetch up-to-date information on available SAP systems.

To use LDAP operation mode, check that the `sapmsg.ini` file contains the following:

```
[Address]
Mode=LDAPdirectory
LDAPserver=
LDAPnode=
LDAPoptions=
```

---

**Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.3 to 7.5 on Windows: SAP Adaptive Server Enterprise**

---

**Additional Information**
Distinguish the following cases:

- If you use an Active Directory, you must set `LDAPoptions=“DirType=NT5ADS“`. For more information, see the SAP system profile parameter `ldap/options`.

- You must specify the directory servers (for example, `LDAPserver=pcintel6 p24709`) if one of the following is true:
  - The client is not located in the same domain forest as the Active Directory
  - The operating system does not have a directory service client (Windows NT and Windows 9X without installed `dsclient`).

  For more information, see the SAP system profile parameter `ldap/servers`.

- For other directory services, you can use `LDAPnode` to specify the distinguished name of the SAP root node. For more information, see the SAP system profile parameter `ldap/saproot`.

**SAP MMC**

The SAP MMC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. It is automatically set up when you install an SAP system on Windows. If the SAP system has been prepared correctly, the SAP MMC presents and analyzes system information that it gathers from various sources, including the Active Directory.

Integrating the Active Directory as a source of information has advantages for the SAP MMC. It can read system information straight from the directory that automatically registers changes to the system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MMC.

If you need to administer distributed systems, we especially recommend that you use the SAP MMC together with Active Directory services. You can keep track of significant events in all of the systems from a single SAP MMC interface. You do not need to manually register changes in the system configuration. Instead, such changes are automatically updated in the directory and subsequently reflected in the SAP MMC.

If your SAP system is part of a heterogeneous SAP system landscape that comprises systems or instances both on Unix and Windows operating systems, you can also use the SAP MMC for operating and monitoring the instances running on Unix.

**SAP MC**

You can also use the SAP Management Console (SAP MC) for administering and monitoring SAP systems from a central location.
For more information about the SAP MC and about how to configure it to access LDAP directories, see the documentation SAP Management Console in the SAP Library at:

**SAP Release and SAP Library Quick Link**

<table>
<thead>
<tr>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>● SAP NetWeaver 7.3</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw73">http://help.sap.com/nw73</a></td>
</tr>
<tr>
<td>● SAP NetWeaver 7.3 including Enhancement Package 1</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw731">http://help.sap.com/nw731</a></td>
</tr>
<tr>
<td>● SAP NetWeaver 7.4</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw74">http://help.sap.com/nw74</a></td>
</tr>
<tr>
<td>● SAP NetWeaver 7.5</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
</tr>
</tbody>
</table>

**Configuration Tasks for LDAP Directories**

This section describes the configuration tasks for the Active Directory or other (generic) LDAP directories.

**Configuration Tasks for Active Directory**

To enable an SAP system to use the features offered by the Active Directory, you have to configure the Active Directory so that it can store SAP system data.

To prepare the directory, you use the installer to automatically:

- Extend the Active Directory schema to include the SAP-specific data types
- Create the domain accounts required to enable the SAP system to access and modify the Active Directory. These are the group `SAP_LDAP` and the user `sapldap`.
- Create the root container where information related to SAP is stored
- Control access to the container for SAP data by giving members of the `SAP_LDAP` group permission to read and write to the directory

You do this by running the installer [page 84] and choosing: `Generic Installation Options ➤ Preparations ➤ LDAP Registration ➤ Active Directory Configuration`.

**Note**

You have to configure the directory server only once. Then all SAP systems that need to register in this directory server can use this setup.

**Configuration Tasks for Generic LDAP Directories**

To configure other LDAP directories, refer to the documentation of your directory vendor. The installer software contains schema extensions for directory servers Netscape/iPlanet (ldregns4.txt, ldregns5.txt) and OpenLDAP slapd (ldregslapd.schema). Both files are located in the directory `<Unpack_Directory>\COMMON\ADS`. After you have applied the schema extension, you need to create a root container to store the SAP-related information and create a directory user that the SAP application server can use to write information to the directory.

For more information about how to set up a Netscape/iPlanet directory server, see the documentation SAP System Information in Directory Services at: https://archive.sap.com/documents/docs/DOC-14384

**Enabling the SAP System LDAP Registration**

Once you have correctly configured your directory server, you can enable the LDAP registration of the SAP system by setting some profile parameters in the default profile.
To do this, run the installer [page 84] once for your system and choose:

对该安装程序的一次性运行，您可以选择:

- **Generic Installation Options**
- **<Database>**
- **Preparations**
- **LDAP Registration**
- **LDAP Support**

If you use a directory server other than Microsoft Active Directory and/or non-Windows application servers, you have to store the directory user and password information by using ldappasswd pf=<any_instance_profile>. The information is encrypted for storage in DIR_GLOBAL and is therefore valid for all application servers. After restarting all application servers and start services, the system is registered in your directory server. The registration protocols of the components are dev_ldap*. The registration is updated every time a component starts.

### 10.6 Preparing an External ABAP System as Source for User Data

You can use an external ABAP system as the data source for user data for the Application Server Java of your SAP Java system to be installed. To do so, you configure the User Management Engine (UME) of the AS Java for the user management of this external ABAP system.

#### Prerequisites

The ABAP system is based on at least SAP Web AS ABAP release 6.20 SP25.

#### Context

**Note**

If you want to install an optional standalone unit - Advanced Adapter Engine (AAE), Advanced Adapter Engine Extended (AEX), or Process Integration and Orchestration (PI-CP) - you can skip this section because you are not prompted for UME Configuration. Optional standalone units are automatically configured during the installation to store the SAP system users in the Java database.

If you want to connect more than one Java system to the same ABAP system, you need to work out a concept for the communication, administrator, and guest users for each system.

**Note**

If you want to install the application server Java for an SAP NetWeaver 7.5 Process Integration (PI) system or for an SAP Solution Manager 7.2 system, you must use the already installed Application Server ABAP (AS ABAP) as the data source for user data for the Application Server Java to be installed. In this case, the required users were already created during the installation of the Application Server ABAP and you are prompted to enter these users during the installation of the Application Server Java.
You can take one of the following approaches when using an external ABAP system as source for user data:

<table>
<thead>
<tr>
<th>Approach</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each Java system uses different users</td>
<td>No interdependencies between the connected engines</td>
<td>Initially more administration to create the users in the ABAP system</td>
</tr>
</tbody>
</table>
| All Java systems use the same configuration | You create the users only once and enter the same information for every Java system that you install. | Interdependencies between the connected engines:  
  - If you change the password of any of the users on the ABAP system, this change affects all connected engines.  
  - If you change the administrator user’s password, you must also change the password in secure storage on all of the connected Java EE Engines |

→ Recommendation

For security reasons, we recommend the first approach.

The procedures below assume that you are using the first approach.

More Information

For more information about AS ABAP user management as data source, see the SAP Library at:

- SAP NetWeaver 7.3  
  http://help.sap.com/nw73
- SAP NetWeaver 7.3 including Enhancement Package 1  
  http://help.sap.com/nw731
- SAP NetWeaver 7.4  
  http://help.sap.com/nw74
- SAP NetWeaver 7.5  
  http://help.sap.com/nw75
- SAP NetWeaver AS for ABAP 7.51 innovation package  
  https://help.sap.com/nw751abap
- SAP NetWeaver AS for ABAP 7.52  
  https://help.sap.com/nw752abap

Procedure

- The following procedures describe the activities you have to perform in the existing ABAP system and for the Java system to be installed.
- Perform the following steps in the existing ABAP system:
  a. Call transaction PFCG to do the following:
Check that the roles SAP_BC_JSF_COMMUNICATION and SAP_BC_JSF_COMMUNICATION_RO exist and make sure that their profiles are generated.

Check that the roles SAP_J2EE_ADMIN, SAP_J2EE_GUEST, and SAP_BC_FP_ICF exist. Neither role contains any ABAP permissions, so you do not need to generate any profiles.

b. Call transaction SU01 to do the following:

○ Create a new communication user and assign it to the role SAP_BC_JSF_COMMUNICATION_RO. We recommend that you do the following:

○ Name this user SAPJSF. You can use any password.

○ Assign this user the role SAP_BC_JSF_COMMUNICATION for read-only (display) access to user data with Java tools. If you intend to maintain user data (that is, to change, create, or delete users) with Java tools, you need to assign the role SAP_BC_JSF_COMMUNICATION instead.

○ Assign this user the type Communications under Logon data to make sure that it can only be used for communication connections between systems and not as a dialog user.

○ Create a new administrator user for the J2EE engine and assign it to role SAP_J2EE_ADMIN. We recommend that you name this user J2EE_ADM_<SAPSID_Java_System>. You can use any password.

○ Create a new guest user for the J2EE engine and assign it to role SAP_J2EE_GUEST. We recommend that you name this user J2EE_GST_<SAPSID_Java_System>. You can use any password.

Since this user is only used for anonymous access to the system, we recommend you to deactivate the password and, if required, lock it after installation to prevent anyone from using it for explicit named logons.

c. Make sure that you change the initial passwords of these users and take the precautions described in the relevant SAP security guide before you start the installation of the Java system. You can find the security guide in the Security section of the product page for your SAP product at https://help.sap.com/.

- Perform the following steps in the Java System:

  a. **Before** the installation of the Java system, make sure that you have the correct user names and passwords of the users listed above for the separate ABAP system.

  b. **During** the installation of the Java system, make sure that you enter the correct users and passwords in the corresponding installer dialogs.
10.7 Installing the SAP Host Agent Separately

This procedure tells you how to install an SAP Host Agent separately.

Context

The SAP Host Agent is installed automatically during the installation of new SAP instances with SAP kernel 7.20 or higher (integrated installation). This procedure is only for hosts with no SAP Host Agent running on them, due to the following reasons:

- There is no SAP system or instance on the host.
- The SAP system or instance running on the host has a kernel release lower than SAP kernel 7.20 and the host does not yet have an SAP Host Agent.
- You have upgraded your SAP system to a release with a kernel release lower than SAP kernel 7.20 and the host of the upgraded system or instance does not yet have an SAP Host Agent.

SAP Host Agent has the following executable programs and services:

- The SAPHostExec service
- The sapstartsrv service SAPHostControl
- The operating system collector saposcol

Note

The installed programs are automatically started when the host is booted.

On Microsoft Windows hosts, the services SAPHostControl and SAPHostExec start the installed programs automatically.

The following procedure describes the steps you have to perform on the host where you install the SAP Host Agent separately.

Procedure

1. Perform basic preparations on Windows [page 60].
2. Check that you have the required user authorization for running the installer [page 61].
3. Download and unpack the Software Provisioning Manager 1.0 archive on the host where you want to install the SAP Host Agent as described in Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 71].
4. Make the latest patch level of the SAPHOSTAGENT <Version>.SAR available on the host where you want to install the SAP Host Agent.

Download it from the following path: https://launchpad.support.sap.com/#/softwarecenter

SUPPORT PACKAGES & PATCHES > By Category > SAP Technology Components > SAP HOST AGENT
    > SAP HOST AGENT 7.21 > <Operating System>
**Note**

The signature of installation archives is checked automatically by the installer [page 84] during the Define Parameters phase while processing the Software Package Browser screens. The installer only accepts archives whose signature has been checked. After scanning the archives and verifying the signature, an info file is written where you can find detailed information about matching and non-matching archive files. You can access this info file by choosing the info file link in the Archive Scanning Result section of the Software Package Browser screen. The info file contains only the results of the latest archive scan. For more information, see SAP Note 2393060.

→ **Recommendation**

It is highly recommended that you always choose the highest SP version of the SAPHOSTAGENT<SP-version>.SAR archive.

5. To install the SAP Host Agent, you start the installer [page 84] and choose Generic Options ➤ Generic Options ➤ Preparations ➤ SAP Host Agent on the Welcome screen of the installer.

6. Follow the instructions on the installer screens and enter the required parameters.

7. When the installation has finished, the installer shows the message: Execution of SAP Host Agent has completed.

**Post-Installation**

8. Check that the SAP Host Agent is installed and running by entering this command:

```
<Drive>:\usr\sap\hostctrl\exe\saphostexec -status
```

If the SAP Host Agent is running, you see something like this:

```
sapstartsrv running (pid =21944)
```

9. If the SAP Host Agent is installed but not running, enter the following:

```
<Drive>:\usr\sap\hostctrl\exe\saphostexec -restart
```

10. Check whether the installed services are available:

   a. Log on as a member of the local Administrators group.

   b. Check whether the following services are available:

   ○ The control program saphostexec

   ○ The SAP NetWeaver Management agent SAPHostControl (sapstartsrv in host mode)
Next Steps

For more information about the SAP Host Agent, see the following documentation:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>● SAP NetWeaver 7.3</td>
<td>Application Help › Function-Oriented View: English ›</td>
</tr>
<tr>
<td>● SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw731">http://help.sap.com/nw731</a></td>
<td></td>
</tr>
<tr>
<td>● SAP NetWeaver 7.4</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw74">http://help.sap.com/nw74</a></td>
<td></td>
</tr>
<tr>
<td>● SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td></td>
</tr>
</tbody>
</table>

10.8 Starting and Stopping the SAP System

You use this procedure to start and stop the SAP system or single instances after the installation with the SAP Microsoft Management Console (SAP MMC) or SAPControl.

⚠️ Caution

Note the following restrictions about starting and stopping the database instance with the SAP MMC or SAPControl:

- Only valid for 'High Availability': non-HA

  In a non-high-availability system, you can use the SAP MMC or SAPControl to start the database instance. To stop the database instance, however, you must use the relevant database administration tools.

- Only valid for 'High Availability': HA (Windows)

  In a high-availability system, you can neither start nor stop the database instance with the SAP MMC or SAPControl. For more information, see Starting and Stopping the SAP System in an HA Configuration [page 171].

Prerequisites

The user who wants to start and stop the SAP system with the SAP MMC, must be a member of the local administrators group.
Procedure

Starting and Stopping the SAP System with the SAP MMC

With the SAP MMC, you can start or stop installed SAP instances – except the database instance – locally on the host that you are logged on to. If the SAP MMC is configured for central system administration, you can start or stop the entire system from a single host.

i Note

- To stop the database instance you must use the relevant database administration tools.
- You can also start and stop a UNIX system with the SAP MMC.
- The SAP MMC is not available on Server Core for Windows Server 2012 (R2) and higher.

For more information about the SAP MMC, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3</td>
<td>Application Help</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw73">http://help.sap.com/nw73</a></td>
<td>Function-Oriented View: English</td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td>Solution Life Cycle Management</td>
</tr>
<tr>
<td>SAP NetWeaver 74</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw74">http://help.sap.com/nw74</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td></td>
</tr>
</tbody>
</table>

To start or stop the SAP system – except the database instance – with the SAP MMC, perform the following steps:

1. Start the SAP MMC on the SAP system host.
2. Right-click the SAP system node and choose Start or Stop.
   All SAP instances listed under the system node start or stop in the correct order.
3. To stop the database instance, use the relevant database administration tools.
4. If the SAP system is installed on multiple hosts, you have the following options to start or stop your system:
   - You start or stop the SAP instances – except the database instance – using the SAP MMC on each host.
   - You add the remote instances to the SAP MMC configuration to start or stop all instances from a single SAP MMC.
     To do so, do one of the following:
     - You configure the SAP MMC manually. For more information, see Changing the Configuration of the SAP MMC in the SAP MMC documentation.
     - You use the automatic LDAP registration. For more information, see Configuring SAP MMC for Active Directory Services in the SAP MMC documentation.

Starting and Stopping the SAP System with SAPControl
To start or stop the SAP system – except the database instance – with SAPControl (sapcontrol.exe), perform the following steps:

- To start or stop the complete SAP system with SAPControl, open a PowerShell in elevated mode, and enter the following command:
  ```
  sapcontrol -prot PIPE -nr <Instance_Number> -function StartSystem
  sapcontrol -prot PIPE -nr <Instance_Number> -function StopSystem
  ```

- To start or stop a single instance with SAPControl, open a PowerShell in elevated mode, and enter the following command:
  ```
  sapcontrol -prot PIPE -nr <Instance_Number> -function Start
  sapcontrol -prot PIPE -nr <Instance_Number> -function Stop
  ```

- To stop the database instance, use the relevant database administration tools.

### 10.9 Configuring the Windows Server Firewall on Windows Server 2008 (R2) and higher (Optional)

#### Use

As of Windows Server 2008 (R2), the firewall is configured to allow only a small set of Windows-specific inbound IP connections.

Therefore, we recommend that you do **not** turn on the Windows firewall after you have installed your SAP system. Instead, we recommend that you secure network access to your SAP system with the physical firewall or a router Access Control List (ACL) within your datacenter.

If, for some reason, you want to use the Windows Server firewall, you have to configure the Windows firewall and define a set of **Inbound Rules** for the TCP/IP port numbers that are used by your system. Otherwise, your SAP system might not operate.

For more information about the port numbers used, see the documentation **TCP/IP Ports of All SAP Products** at: [https://help.sap.com/viewer/ports](https://help.sap.com/viewer/ports).

Ports listed with the default value **Not active** in this document are not configured.
Prerequisites

You turn on the disabled firewall [page 59] as follows:

- Windows Server 2012 (R2) and higher:
  Open Windows PowerShell in elevated mode, and enter the following command:
  `Set-NetFirewallProfile "public","domain","private" -enabled true`

- Windows Server 2008 (R2):
  2. Right-click Windows Firewall with Advanced Security and choose Properties.
  3. Set the Firewall state to On.

Procedure

This procedure provides an example how to set Inbound Rules for the ports of an ABAP server that was installed with the following settings:

<table>
<thead>
<tr>
<th>Instance number</th>
<th>00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port type</td>
<td>TCP</td>
</tr>
<tr>
<td>Ports</td>
<td>3200, 3300, 4800, 8000, 3600, 50013, 1433, 1434</td>
</tr>
</tbody>
</table>

- Windows Server 2012 (R2) and higher:
  Open Windows PowerShell in elevated mode, and enter the following command:
  `New-NetFirewallRule -DisplayName "SAP ABAP Server 00" -Direction Inbound -Protocol TCP -LocalPort 3200,3300,4800,8000,3600,50013,1433,1434 -Action Allow`

- Windows Server 2008 (R2):
  3. For Rule Type, select Port and choose Next.
  4. For Protocol and Ports, select port type TCP or UDP depending on the port type used.
     Note that the final two digits of the port number correspond to the instance number.
  5. Choose Next.
  6. For Action, select Allow the connection, and choose Next.
7. For Profile, keep Domain, Private and Public selected, and choose Next. For more information, see the link Learn more about profiles on this screen.

8. Enter the Name, for example SAP ABAP Server 00, and Description for the new rule.

9. Choose Next.

10. Choose Finish to save the rule.

The new inbound rule appears in the Inbound Rules list. To modify the settings, right-click on the rule and choose Properties.

---

**10.10 Enabling SSL Encrypted Data Transfer**

Secure Sockets Layer (SSL) encrypted data transfer is available for SAP ASE 16.0 SP02 starting with PL6. For general limitations and prerequisites refer to SAP Note [2481596](https://support.sap.com/2481596) - SYB: Encrypted data transfer between SAP System and SAP ASE database.

The SAP installer offers the possibility to enable the SSL encrypted data transfer via a checkbox. The SSL certificates are generated by the SAP installer and enabled for the database server and the SAP application server.

There are no manual steps necessary to configure the usage of SSL for the purpose of encrypted data transfer.

---

**i Note**

If you want to use, for example, a different IP scope for port 50013, which is used by the connection SAP Start Service – SAP Management Console, you can restrict the IP access to a small number of SAP administrators. Then delete this port from the SAP ABAP Server 00 rule and create a new rule for port 50013 with a more restrictive scope.

---

**10.11 SAP System Security on Windows**

In a standard SAP system installation, the installer automatically performs all steps relevant for security. Although the installer makes sure that the system is protected against unauthorized access, you must still check that no security breaches can occur.

For central and straightforward administration of the SAP system, you have to install distributed SAP systems with multiple application servers in a Windows domain. This section describes the user accounts and groups that the installer creates during a domain installation and shows how these are related to the SAP directories.

**User Accounts**
The installer creates the following accounts for SAP system administration:

<table>
<thead>
<tr>
<th>User account</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;sapsid&gt;adm</td>
<td>This is the SAP system administrator account that enables interactive administration of the system.</td>
</tr>
<tr>
<td>sapadm</td>
<td>This is the user for the SAP Host Agent. By default it is a local user and not a member of the local Administrators group. You can change this user into a domain user on the Parameter Summary screen. For security reasons, however, SAP strongly recommends to create this user as a local user. The SAP Host Agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator.</td>
</tr>
</tbody>
</table>

### Domain and Local Groups

The only function of a domain group is to group users at the domain level so that they can be placed in the appropriate local groups.

Only local groups are created and maintained on each local host. A local group can only be given permissions and rights to the system where it is located. The system is part of a particular domain, and the local group can contain users and domain (global) groups from this domain.

During a domain installation, the installer creates the following domain and local groups:

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_&lt;SAPSID&gt;_GlobalAdmin</td>
<td>This domain (global) group is a domain-level SAP administration group for organizing SAP system administrators.</td>
</tr>
<tr>
<td>SAP_SAP_GlocalAdmin</td>
<td>This domain group for the SAP Host Agent is only created if you create the SAP Host Agent user sapadm as a domain user.</td>
</tr>
<tr>
<td>SAP_&lt;SAPSID&gt;_LocalAdmin</td>
<td>This local group is created on each host.</td>
</tr>
<tr>
<td>SAP_SAP_LocalAdmin</td>
<td>If you create the SAP Host Agent user as domain user, the group SAP_SAP_LocalAdmin is also created.</td>
</tr>
<tr>
<td>SAP_LocalAdmin</td>
<td>This local group is created on all hosts, but is particularly important for the transport host. Members of the group have full control over the transport directory (\usr\sap\trans) that allows transports to take place between systems.</td>
</tr>
</tbody>
</table>

### SAP Directories

The installer protects the SAP directories under \usr\sap\<SAPSID> by only granting the group SAP_<SAPSID>_LocalAdmin full control over these directories.

The following graphic illustrates the users and groups that are created by the installer for the <sapsid>adm and SAPService<SAPSID> users in a system infrastructure consisting of two SAP systems.
**User Groups and Accounts**

*Note*

An access control list (ACL) controls access to SAP system objects. For maximum security in the SAP system, only the following are members of all SAP system object ACLs:

- Local group `SAP_<SAPSID>_LocalAdmin`
- Group `Administrators`
- User `SYSTEM`

**More Information**

Automatic Creation of Accounts and Groups [page 198]

**10.12 Automatic Creation of Accounts and Groups**

The installer automatically creates the accounts and groups required for the secure operation of the SAP system with Windows during the installation, as described in SAP System Security on Windows [page 196].

**Features**

The following figures show the steps that the installer performs to create the users and groups and assign the required rights to SAP directories.
The first figure shows the users that are created during a domain installation, with the SAP Host Agent operating system users being local users.

**Creation of Accounts**

- **Domain users for SAP system**
  - **<capsid>:sap servicename**
- **Local user for SAP Host Agent**
  - **sapadmin**

**Creation and Modification of Domain Group in the Domain**

- Creation of domain group **SAP-CAPSID: GlobalAdmin**
- Addition of **<capsid>:sap servicename** to **SAP-CAPSID: GlobalAdmin**

**Creation and Modification of Local Groups and Users on Each Host**

- Creation of local groups **SAP-CAPSID: LocalAdmin**, **SAP_SAS: LocalAdmin**
- Creation of local group **SAP: GlobalAdmin**
- Addition of domain group **SAP-CAPSID: GlobalAdmin** to local group **SAP-CAPSID: LocalAdmin**
- Addition of **sapadmin** to **SAP_SAS: GlobalAdmin** and **SAP_SAS: LocalAdmin**
- Creation of local group **SAP: LocalAdmin**
- Addition of domain group **SAP-CAPSID: GlobalAdmin** to local group **SAP: LocalAdmin**
- Addition of **<capsid>:sap servicename** to local group **SAP LocalAdmin**
- Addition of SAP-CAPSID: GlobalAdmin group to local group **SAP: LocalAdmin** on the transport host

**Creating Users and Groups**

- **For Administrators and SAP: LocalAdmin groups**
  - Assignment of full control over:
    - **usr**:sap
    - **usr**:sap/trans
    - **usr**:sap/grfzclg

**Assigning Rights to SAP Directories**

- **For Administrators and SAP-CAPSID: LocalAdmin groups**
  - Assignment of full control over:
    - **usr**:sap/<capsid>
10.13 Deleting an SAP System or Single Instances

This section describes how to delete a complete SAP system or single SAP instances with the **Uninstall** option of the installer.

**Prerequisites**

- You have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on with a user account that has the required authorization to run the installer and the SAP system. For more information, see [Required User Authorization for Running the Installer](#) [page 61].

⚠️ **Caution**

Do not use the `<sapsid>adm` user to delete the SAP system.

- Make sure that the SAP system, or single instance, or standalone engine, or optional standalone unit to be deleted is down and that you are not logged on as one of the SAP system users. Also check that all SAP-related processes are stopped. If there is a lock on one of the SAP system objects, the uninstall fails.

ℹ️ **Note**

You do not have to stop the SAP Host Agent. The SAP Host Agent is stopped automatically during the uninstall process.

- When starting the uninstall, make sure that there are no SAP system user sessions still open.

**Context**

Note the following when deleting an SAP system or single instances:

- You cannot delete an SAP system remotely.
- During the uninstall process, all file systems and subdirectories of the selected SAP system or single instance are deleted. Before you start uninstalling, check that you have saved a copy of all files and directories that you want to keep to a secure location.
- The uninstall process is designed to remove as much as possible of the SAP system to be deleted. If an item cannot be removed, a message informs you that you have to remove this item manually. You can do this either at once or after the uninstall process has finished. As soon as you confirm the message, the uninstall process continues.
- If you uninstall an SAP instance and you plan to install another SAP instance with the same System ID, first reboot the Windows host to clear all user cached information. For more information, see SAP Note 2296310.
**Procedure**

1. Start the installer as described in Running the Installer [page 84].
2. On the **Welcome** screen, choose:
   - **Generic Installation Options** → `<Database>` → **Uninstall** → **Uninstall SAP Systems or Single Instances**
3. Follow the instructions on the installer screens to delete a complete SAP system or single instances.

   **Note**
   
   To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field, and choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.

The following table provides information about deleting a complete system or single instances with the installer.

<table>
<thead>
<tr>
<th>Deletion of</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard system</td>
<td>You can delete a standard system (where all instances reside on the same host) in one installer run.</td>
</tr>
<tr>
<td>Distributed or high-availability system</td>
<td>If you want to delete a distributed or high-availability system, you have to run the installer to delete the required instances <strong>locally</strong> on each of the hosts belonging to the SAP system in the following sequence:</td>
</tr>
<tr>
<td>1. Additional application server instances, if there are any</td>
<td></td>
</tr>
<tr>
<td>2. Primary application server instance</td>
<td>If the installer stops responding while trying to delete the primary application server instance, close the installer with <strong>Cancel</strong> and <strong>Exit</strong>. Log off and log on again. To complete the uninstall process of the primary application server instance, restart the installer.</td>
</tr>
<tr>
<td>3. Database instance</td>
<td>Since the installer only stops local instances automatically, make sure that before deleting the database instance of a distributed system, you stop all remaining instances. You must stop the instance with the message server only after having entered all installer parameters for the deletion of the database instance.</td>
</tr>
<tr>
<td>4. Central services instance (SCS)</td>
<td></td>
</tr>
</tbody>
</table>

**Caution**

Do not select checkbox **Uninstall all instances of the SAP system from this host** if you do not want to uninstall the complete SAP system or standalone engine. For example, do not select this checkbox if you only want to uninstall an additional application server instance of an existing SAP system distributed over several hosts. Otherwise the contents of mounted global directories under `/<sapmnt>/<SAPSID>/`, such as instance profiles and kernel executables, are also deleted.
Deletion of

<table>
<thead>
<tr>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Additional application server</strong> If you want to delete additional application server instances of an existing SAP system, you have to run the installer to delete them <strong>locally</strong> on each additional application server instance host.</td>
</tr>
<tr>
<td><strong>Standalone SAP Host Agent</strong> The SAP Host Agent is automatically uninstalled from a host together with the last remaining SAP system instance. If you want to uninstall a standalone SAP Host Agent, deselect <strong>Profiles Available</strong> and select <strong>Uninstall Standalone SAP Host Agent</strong> on the <strong>General SAP System Parameters</strong> screen.</td>
</tr>
</tbody>
</table>

4. When you have finished, delete the relevant directory structure on the global host.

5. Delete the local user group `SAP_<SAPSID>_LocalAdmin` manually as follows:
   - Windows Server 2012 (R2) and higher:
     Open a PowerShell in elevated mode and enter the following command:
     ```bash
     net localgroup SAP_<SAPSID>_LocalAdmin /delete
     ```
   - Windows Server 2008 (R2):
     1. Choose **Start** ➤ **Programs** ➤ **Administrative Tools** ➤ **Computer Management** ➤
     2. Choose **Local Users and Groups** ➤ **Groups**
     3. Right-click the local group `SAP_<SAPSID>_LocalAdmin` and choose **Delete**.

6. If required, you can delete the directory `\usr\sap\trans` and its contents manually.
   The installer does not delete `\usr\sap\trans` because it might be shared.

A  Appendix

A.1  Online Information from SAP

More information is available online as follows:

<table>
<thead>
<tr>
<th>Titel</th>
<th>Internet Address</th>
</tr>
</thead>
</table>

A.2  Using PowerShell

SAP uses Windows PowerShell to run and describe Windows commands.

For Windows Server 2012 (R2) and higher, SAP only uses Windows PowerShell to run and describe Windows commands.

Windows PowerShell is a powerful tool integrated in the Windows operating system. It uses object-oriented methodology, which allows fast and stable script development.

For more information about the Windows PowerShell, see:
There you can find links to the online help, online documentation, scripting repository, downloads, and blogs.

If you want to use the PowerShell feature, note the following:

- Windows Server 2016
  Windows Server 2016 contains PowerShell 5.0
  You can update to PowerShell 5.0 (search the internet for Windows Management Framework 5.0).
- Windows Server 2012 R2
  Windows Server 2012 R2 contains PowerShell 4.0.
- Windows Server 2012
  You can update to PowerShell 4.0 (search the internet for Windows Management Framework 4.0).
- Windows Server 2008 R2
  Windows Server 2008 R2 contains PowerShell 2.0.
  For more information about PowerShell 2.0, see http://support.microsoft.com/kb/968929.
  You can update to PowerShell 3.0 or 4.0 (search the internet for Windows Management Framework 3.0 or Windows Management Framework 4.0).
• Windows Server 2008
Windows Server 2008 contains PowerShell 1.0.
You have to activate the PowerShell feature with [Start] > [Administrative Tools] > [Server Manager] > [Features].

How to Start PowerShell

⚠️ Caution
Make sure that you start the PowerShell in administrator mode.

• Windows Server 2012 (R2) and higher
Open the command prompt and enter the command: `powershell.exe`

To start PowerShell on Windows Server 2008 (R2), you have the following options:

• From the command prompt, by entering the command: `powershell.exe`
• From the Start Menu:
  ○ PowerShell 1.0:
    Choose [Start] > [All Programs] > Windows PowerShell 1.0 > Windows PowerShell.
  ○ PowerShell 2.0:
    Choose [Start] > [All Programs] > Windows PowerShell > Windows PowerShell.

How to Work with PowerShell

Most commands that are used in `cmd.exe` are also available in the PowerShell (defined as aliases).

You can use well-known commands, such as `cd`, `type`, `copy`, `move`, `mkdir`, `delete`, `rmdir`. There is also online help available, which you can access by typing the command: `help` (or `help <command>`).

This is a list of differences between PowerShell and `cmd.exe`:

• Before you can run PowerShell scripts (text files with the file extension `.ps1` that contain PowerShell statements), you might have to change the default security setting to allow the execution of non-signed scripts as follows:
  `set-executionpolicy "unrestricted"

• By default, when double-clicking PowerShell scripts (.ps1 files) in the Windows explorer, this does not execute the script as is the default for .cmd files, but opens the script in an editor. If you want to activate automatic script execution after a double-click, you have to change the value `HKEY_CLASSES_ROOT \Microsoft.Powershellscript.1\Shell\Open\Command` from `notepad.exe` to the full path of the PowerShell executable.

• The output of PIPE commands is not just a stream of characters (strings) but a stream of objects. You can easily access the properties and methods for these objects (see the process list DLL example below).
● The current working directory is not part of the directory search path that the PowerShell looks at for scripts and programs. The PowerShell only searches directories listed in the environment variable path. Therefore, you might have to run a local program with `./sapcontrol.exe` or specify its full path.

● You can use the UNIX-like directory delimiters, such as `cd /usr/sap/C11`.

● You can have your current working directory in a UNC path (`cd \sapglobalhost\sapmnt`).

● The shell distinguishes between environment variables and shell variables:
  ○ Use of shell variables:
    Definition: `$x="hello"`
    Reference: `write-host $x`
  ○ Use of an environment variable:
    Definition: `$env:x="hello"`
    Reference: `write-host $env:x`

● The PowerShell has an interesting container concept called `ps-drives`. Within `ps-drives` you can navigate in other objects, such as the registry or shell internal lists in the same way as you typically navigate in a file system (`cd`, `dir`, `del`, and so on).
  `dir env:` to get a list of environment variables
  `dir variable:` to get the list of shell variables
  `dir HKLM:` to get a list of registry keys in HKEY_LOCAL_MACHINE
  `get-psdrive` to get a list of available `ps-drives`

● Windows PowerShell has full access to the .NET runtime. You can directly access missing functions in the PowerShell via .NET.

● With Windows PowerShell, you can create GUI-class user interfaces using Windows forms.

### PowerShell Commands

The following table lists some PowerShell commands that are available on Windows Server 2012 (R2) and higher:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>stop-service sap*</code></td>
<td>Stops all Windows services with service name starting with &quot;SAP&quot;</td>
</tr>
<tr>
<td><code>get-process</code></td>
<td>Lists currently started processes on your system</td>
</tr>
<tr>
<td>`get-process</td>
<td>sort startime</td>
</tr>
<tr>
<td>`get-process</td>
<td>sort startime</td>
</tr>
<tr>
<td>`get-process</td>
<td>sort startime</td>
</tr>
<tr>
<td>Command</td>
<td>Explanation</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>get-process</td>
<td>Lists all processes, and the executables and DLLs the processes loaded</td>
</tr>
<tr>
<td>$processes = (get-process</td>
<td>Defines a shell variable $processes, which contains an array of process objects</td>
</tr>
<tr>
<td>sort starttime)</td>
<td></td>
</tr>
<tr>
<td>$processes.length</td>
<td>The number of processes in the array (is equivalent to the number of processes on your computer)</td>
</tr>
<tr>
<td>$processes[$processes.length-1].kill()</td>
<td>Invokes the kill method (terminate process) of the last started process</td>
</tr>
<tr>
<td>(dir a.txt).set_attributes(&quot;readonly&quot;)</td>
<td>Sets the file a.txt to &quot;read-only&quot;</td>
</tr>
</tbody>
</table>
Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.

About the icons:

- Links with the icon : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your agreements with SAP) to this:
  - The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
  - SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any damages caused by the use of such content unless damages have been caused by SAP’s gross negligence or willful misconduct.

- Links with the icon : You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of example code unless damages have been caused by SAP’s gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.